IDENTIFYING CRITICAL SOURCE AREAS FOR BEST MANAGEMENT PRACTICE TARGETING IN IMPAIRED ZUMBRO RIVER WATERSHEDS USING DIGITAL TERRAIN ANALYSIS

A thesis
submitted to the faculty of the graduate school
of the University of Minnesota
by

Dylan Fredrick Timm

In partial fulfillment of the requirements
for the degree of
Master of Science

David Mulla

December 2016
ACKNOWLEDGEMENTS

My deepest appreciation goes to my advisor David Mulla. David saw potential in my application and took a chance on me and for that I am ever grateful; not only did he take me on as a University of Minnesota Water Resource Science graduate student, he also provided a full time research assistantship. David has always been supportive and very patient; providing guidance whenever needed. I’d also like to thank Jay Bell and Marvin Bauer for being supportive committee members.

I want to thank the Minnesota Department of Agriculture (MDA) for sponsoring the PMZ Impaired Watersheds project funded through the Clean Water Fund and for providing their full support and guidance throughout. I also want to thank the Minnesota Environment and Natural Resources Trust Fund as recommended by the Legislative-Citizen Commission of Minnesota Resources (LCCMR) for supporting the Zumbro River Watershed Targeted Sediment Reduction Project.

In addition to the my education from professors at UMN, I was also fortunate enough to become a MDA student employee in the summer of 2014 and gained immense knowledge on farm practices and runoff, sediment, and nutrient movements in small SE MN watersheds thanks to Kevin Kuehner and Ron Struss. I then became a permanent MDA employee in Mankato and met the love of my life, Bridgette, who distracted me in the best of ways and also pushed me to finish my paper.

I received immense support, assistance, and knowledge from Jacob Galzki, Joel Nelson, Kevin Kuehner, Bill VanRyswyk, Brent Dalzell, Adam Birr, and David Tollefson. My time as a graduate student wouldn’t have been nearly as enjoyable without them.

Lastly, I’d like to say a special thank you to Bonnie Anderson, as she first put me in contact with David Mulla, and for always being so kind and supportive to all WRS students.
ABSTRACT

The Zumbro River Watershed drains 1,421 sq. mi. (3,680 km², 910,337 ac.) of land in southeast Minnesota. Sedimentation within the watershed, particularly in Lake Zumbro and Lake Shady, has raised concerns over sediment-laden runoff entering waterways. Floods in 2010 filled the 190-acre Lake Shady with sediment, necessitating costly removal of its dam, and the 600-acre Lake Zumbro reservoir’s rising sediment levels has resulted in a planned $7 million dredging project. These issues have triggered public awareness campaigns in the watershed, including the “slow the flow” educational initiative designed to engage residents within the watershed to slow and reduce the amount of water running into the Zumbro River. Focus has also shifted upstream in order to reduce much of the sedimentation at the source – namely agricultural runoff – by pushing for conservation practice implementation. Currently, conservation practices in the watershed are implemented opportunistically, because a coordinated, watershed-wide approach for identifying critical sources of nonpoint source pollution, prioritizing sites, and planning implementation projects is absent. Critical source areas (CSAs) are small locations on a landscape that contribute a disproportionate amount of runoff to surface waters. Targeting CSAs can therefore give the best “bang for the buck” when optimizing best management practice cost/benefit ratios. The Zumbro watershed was therefore a prime candidate for CSA identification using a simple toolset that could be adopted by various agencies and conservationists throughout the state. Digital terrain analysis (DTA) – specifically the stream power index (SPI) – was chosen as the method to help locate CSAs based on its ease of application, simplicity, and documented success in similar studies. Three areas – each representing the main agroecoregions of the Zumbro River Watershed – were used to field validate the terrain analysis. Field accuracies associated with positively identifying surface erosional features using DTA methods ranged from 77-88%. DTA was 100% accurate when identifying features with the highest sediment delivery potentials (SDPs) for all three study areas.
# TABLE OF CONTENTS

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>TABLE OF CONTENTS</td>
<td>i</td>
</tr>
<tr>
<td>LIST OF TABLES</td>
<td>v</td>
</tr>
<tr>
<td>LIST OF FIGURES</td>
<td>vi</td>
</tr>
<tr>
<td>ABBREVIATIONS AND SYMBOLS</td>
<td>vii</td>
</tr>
<tr>
<td>LITERATURE REVIEW</td>
<td>1</td>
</tr>
<tr>
<td>INTRODUCTION</td>
<td>4</td>
</tr>
<tr>
<td>Critical Source Areas</td>
<td>5</td>
</tr>
<tr>
<td>Digital Terrain Analysis</td>
<td>7</td>
</tr>
<tr>
<td>Study Area</td>
<td>9</td>
</tr>
<tr>
<td>Physical description</td>
<td>9</td>
</tr>
<tr>
<td>Impaired waters</td>
<td>10</td>
</tr>
<tr>
<td>Geology &amp; geomorphology</td>
<td>10</td>
</tr>
<tr>
<td>Agroecoregions</td>
<td>11</td>
</tr>
<tr>
<td>Pre-settlement vegetation</td>
<td>13</td>
</tr>
<tr>
<td>Land use &amp; ownership</td>
<td>13</td>
</tr>
<tr>
<td>Existing conservation practices</td>
<td>14</td>
</tr>
<tr>
<td>Field Sites</td>
<td>14</td>
</tr>
<tr>
<td>Overview</td>
<td>14</td>
</tr>
<tr>
<td>Locations</td>
<td>15</td>
</tr>
<tr>
<td>Objectives</td>
<td>16</td>
</tr>
<tr>
<td>Figures</td>
<td>17</td>
</tr>
<tr>
<td>Tables</td>
<td>34</td>
</tr>
<tr>
<td>METHODS</td>
<td>38</td>
</tr>
<tr>
<td>Digital Terrain Analysis</td>
<td>38</td>
</tr>
<tr>
<td>Terrain analysis procedure overview</td>
<td>38</td>
</tr>
<tr>
<td>Data acquisition</td>
<td>40</td>
</tr>
<tr>
<td>DEM pre-processing</td>
<td>42</td>
</tr>
<tr>
<td>Terrain analysis attributes</td>
<td>47</td>
</tr>
<tr>
<td>SPI visualization</td>
<td>49</td>
</tr>
<tr>
<td>CSA identification methods</td>
<td>50</td>
</tr>
<tr>
<td>Percentile thresholds</td>
<td>50</td>
</tr>
<tr>
<td>Best fit percentile threshold determination</td>
<td>51</td>
</tr>
<tr>
<td>Field Validation</td>
<td>51</td>
</tr>
</tbody>
</table>
Analysis ................................................................. 55
Random point comparison ........................................ 55
Percentile analysis .................................................. 55
Validation analysis ................................................... 56
RESULTS ........................................................................ 58
Random Point Comparison ........................................ 58
Statistics ...................................................................... 55
Percentile Analysis .................................................... 59
Statistics ...................................................................... 65
Validation Results ...................................................... 66
A1 validation results .................................................. 66
A2 validation results .................................................. 67
B2 validation results .................................................. 68
Best Fit Thresholds ..................................................... 69
Conclusion .................................................................... 73
FIELD-SCALE CONSERVATION PRACTICE TARGETING AND REC--- .... 74
REFERENCES .................................................................. 77
APPENDIX A .................................................................... 83
2014 Digital terrain analysis technical manual .............. 83
APPENDIX B .................................................................... 230
Field GPS accuracies .................................................. 230
A1 Nov. 18th 2012 visit .............................................. 230
A2 Oct. 15th 2012 visit .............................................. 231
A2 Oct. 22nd 2012 visit .............................................. 232
B2 June 2013 visits ................................................... 233
Random point comparison statistical analysis results .... 234
A1 ................................................................. 234
A2 ................................................................. 234
B2 ................................................................. 235
Percentile analysis statistical results ......................... 236
A1 ................................................................. 236
A2 ................................................................. 238
B2 ................................................................. 240
LIST OF TABLES

Table 1. Stream flow data--. .................................................................34
Table 2. MPCA 2012 impaired waters list for the ZRW ........................................34
Table 3. Pre-settlement vegetation types and proportions in the ZRW ................35
Table 4. Land use summary of the ZRW ..........................................................35
Table 5. ZRW riparian land use/land cover-- ..................................................36
Table 6. Land ownership type in ZRW ............................................................36
Table 7. Ownership vs. 2006 land use type-- ..................................................37
Table 8. Upland field assessment template-- ...................................................54
Table 9. Percentile analysis for field site A1. ......................................................60
Table 10. Percentile analysis for field site A2. ..................................................61
Table 11. Percentile analysis for field site B2. ..................................................61
Table 12. Field site A1 validation results .........................................................66
Table 13. Field site A2 validation results .........................................................67
Table 14. Field site B2 validation results .........................................................68
Table 15. Best management practice suitability by agroecoregion-- ....................75
Table 16. Rapid watershed assessment-- .........................................................76
LIST OF FIGURES

Figure 1. Counties in southeast Minnesota that contain the ZRW ........................................17
Figure 2. Shaded relief map of Minnesota with Upper Mississippi--- ...................................18
Figure 3. Zumbro River Watershed with sub-watersheds ....................................................19
Figure 4. Year 2012 impaired waters listed in the Zumbro--- ...............................................20
Figure 5. ZRW with purple area showing extent of the non-glaciated--- ...............................21
Figure 6. ZRW spatial relationship to southeast Minnesota karst--- .....................................22
Figure 7. Agroecoregions.....................................................................................................23
Figure 8. ZRW map of pre-settlement vegetation .................................................................24
Figure 9. Year 2011 land cover map......................................................................................25
Figure 10. Image set of continuous corn acres--- .................................................................27
Figure 11. ZRW land ownership map--- .......................................................... ..................27
Figure 12. Soil and Water Conservation District inventory--- .............................................28
Figure 13. Environmental Benefits Index--- .........................................................................29
Figure 14. Field validation sites--- .......................................................................................30
Figure 15. A1 catchment with field verified CSAs.................................................................31
Figure 16. A2 catchment with field verified CSAs.................................................................32
Figure 17. B2 catchment with field verified CSAs.................................................................33
Figure 18. Method flow chart for terrain analysis processing..................................................39
Figure 19. An example of how water ponds (in blue) behind road crossings--- .................44
Figure 20. Culvert location placed for stream burning hydro-conditioning..........................45
Figure 21. SPI signatures calculated from a 3 meter DEM--- ...............................................46
Figure 22. SPI signature can be visualized--- .........................................................................49
Figure 23. Box plot showing SPI vs random points--- ...........................................................58
Figure 24. Cumulative distribution of all stream power index values--- ...............................62
Figure 25. Cumulative distribution of all stream power index values--- ...............................63
Figure 26. Cumulative distribution of all stream power index values--- ...............................64
Figure 27. Comparison of distribution between SPI values and SDP values--- ....................65
Figure 28. Rough method used to determine SPI thresholds--- .........................................71
Figure 29. Spring-time acquired leaf-off imagery--- .............................................................72
**ABBREVIATIONS AND SYMBOLS**

<table>
<thead>
<tr>
<th>Acronym</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>AOI</td>
<td>Area of Interest</td>
</tr>
<tr>
<td>BMP</td>
<td>Best Management Practice</td>
</tr>
<tr>
<td>cfs</td>
<td>Cubic Feet per Second, or cu. ft/sec</td>
</tr>
<tr>
<td>CPI</td>
<td>Crop Productivity Index</td>
</tr>
<tr>
<td>CSA</td>
<td>Critical Source Area</td>
</tr>
<tr>
<td>CTI</td>
<td>Compound Topographic Index</td>
</tr>
<tr>
<td>DEM</td>
<td>Digital Elevation Model</td>
</tr>
<tr>
<td>DTA</td>
<td>Digital Terrain Analysis</td>
</tr>
<tr>
<td>ESRI</td>
<td>Environmental Systems Research Institute</td>
</tr>
<tr>
<td>FA</td>
<td>Flow Accumulation</td>
</tr>
<tr>
<td>GIS</td>
<td>Geographic Information System</td>
</tr>
<tr>
<td>GPS</td>
<td>Global Positioning System</td>
</tr>
<tr>
<td>HUC</td>
<td>Hydrologic Unit Code</td>
</tr>
<tr>
<td>LiDAR</td>
<td>Light Detection and Ranging</td>
</tr>
<tr>
<td>MPCA</td>
<td>Minnesota Pollution Control Agency</td>
</tr>
<tr>
<td>MSL</td>
<td>Mean Sea Level</td>
</tr>
<tr>
<td>NPS</td>
<td>Non-Point Source (pollution)</td>
</tr>
<tr>
<td>NRCS</td>
<td>National Resource Conservation Service (USDA)</td>
</tr>
<tr>
<td>SCA</td>
<td>Specific Catchment Area</td>
</tr>
<tr>
<td>SDP</td>
<td>Sediment Delivery Potential</td>
</tr>
<tr>
<td>SPI</td>
<td>Stream Power Index</td>
</tr>
<tr>
<td>SSURGO</td>
<td>Soil Survey Geographic Database</td>
</tr>
<tr>
<td>TA</td>
<td>Terrain Analysis</td>
</tr>
<tr>
<td>TMDL</td>
<td>Total Maximum Daily Load</td>
</tr>
<tr>
<td>USDA</td>
<td>United States Department of Agriculture</td>
</tr>
<tr>
<td>USLE</td>
<td>Universal Soil Loss Equation</td>
</tr>
<tr>
<td>Z</td>
<td>Elevation</td>
</tr>
<tr>
<td>ZRW</td>
<td>Zumbro River Watershed</td>
</tr>
</tbody>
</table>
LITERATURE REVIEW

Multiple studies focusing both on predicting, identifying, modeling, and/or prioritizing critical source areas and the suitability and application of using terrain analysis have been published from several different countries around the world with the majority written over the last two decades. Several of those papers closely coincide with key aspects included in this thesis, and will be reviewed here.

The 2011 Galzki, et al. paper, titled *Identifying critical agricultural areas with three-meter LiDAR elevation data for precision conservation*, and its precursor Galzki, et al. 2008 paper *Targeting Best Management Practices (BMPs) to Critical Portions of the Landscape: Using Selected Terrain Analysis Attributes to Identify High-Contributing Areas Relative to Nonpoint Source Pollution* were major stepping stones for this thesis. The Galzki et al. (2008) paper helped pave the way for establishing the LiDAR derived SPI terrain attribute as a simple and accurate method for locating CSAs and its well-earned placement with other precision conservation tools. Precision conservation is a relatively new term coined by Berry et al. (2003), and is defined as targeting conservation practices to places on the landscape where they will be most effective. The Minnesota Department of Agriculture adds that “It's about getting the right practices in the right place, at the right scale” (MDA†). Previous to the Galzki et al. (2011) publication, few studies had used the SPI attribute as the primary GIS layer for CSA identification. The authors focused the agricultural study to two areas in the Minnesota River Basin – an area known for easily erodible soils and on-going bank and bluff stabilization concerns. Workers walked the entire length of streams and ditches in two watersheds at a combined 30,000 acre area. All erosional feature locations along the stream corridors were recorded with GPS equipment and later used to validate the SPI attribute within GIS. The SPI terrain analysis attribute was found to accurately locate 80% of field verified gullies in their study area. A secondary goal of the paper was to analyze costs involved with the field surveys without the aid of terrain analysis. The authors calculated the cost to be $413 per ditch mile in 2011. In comparison, one person working with terrain analysis could analyze a one mile segment of ditch or stream in a matter of seconds. While this thesis mirrors some of the methodologies used in the Galzki
et al. (2011) paper, it also expands on and introduces several new concepts. One primary goal of this thesis that expands on the principles introduced in the Galzki et al. (2011) paper is to create terrain analysis methods that can be easily replicated by conservationists with little to no GIS experience - it is of upmost importance to showcase the ease to which terrain analysis attributes are calculated so that potential users feel less intimidation typically associated with the steep learning curves and required inputs that accompany most physical-based environmental tools and models.

The concept of terrain analysis, along with topographic and compound indices such as the SPI, has been in use for over 30 years (Zevenbergen and Thorne, 1987). The Topographic Index, like the SPI, was and is still a commonly used method for locating CSAs (Anderson and Kneale, 1982; Stark and Redente, 1985; Burt and Butcher, 1985; Srinivasan et al. 2007, 2009; Rampi et al., 2014). The Topographic Index, also known as the Wetness Index or Compound Topographic Index (CTI), is a terrain analysis attribute complementary to SPI in that it represents the quotient of flow accumulation and slope to reflect areas of ponding on landscapes, whereas SPI represents areas of concentrated flow. Because these topographic indices contain slope and flow accumulation attributes, they are very useful tools for locating ephemeral gullies (Dogwiler and Hooks, 2012; Momm et al., 2013; Vendrusculo and Kaleita, 2013; Daggupati et al., 2014), which along with its ease of use, was a large appeal when considering tools for CSA identification. Momm et al. (2013) studied the CTI/gully relationship in their paper Effect of topographic characteristics on compound topographic index for identification of gully channel initiation locations and their results suggest that a normalized CTI could be used for the identification of areas with high potential for gully development. The CTI and SPI formulas made in this thesis are slightly modified from those established by Wilson and Gallant (2000) and used by Momm et al. (2013), among others, to include normalization of the data making for easier visualization and threshold calculations.

Perhaps one of the most quoted references used in modern terrain analysis-related papers is the 2000 text Terrain Analysis: Principals and Applications edited by Wilson and Gallant. With the introduction of new GIS personal computer desktop tools, such as ESRI’s debut of ArcGIS in 1999 with user friendly interfaces, new terrain analysis
functions became accessible and a new concept was born, called Digital Terrain Analysis (DTA). The Wilson and Gallant textbook detailed this DTA concept and introduced several of these new possibilities available through the emerging technology. Along with the recent advances in Digital Elevation Models (DEMs), specifically high resolution LiDAR DEMs, Wilson and Gallant’s book has led to a strong resurgence in terrain analysis among conservationists.

Late into the development of this thesis, it was discovered that a very similar study was competed using digital terrain analysis to identify critical source areas, and was also conducted in the Zumbro River Watershed. Ogren’s 2012 paper, titled Precision Conservation in the Zumbro River Watershed Using LiDAR and Digital Terrain Analysis to Identify Critical Areas Associated with Water Resource Impairment in Agricultural Landscapes also used similar concepts introduced in the Galzki et al. (2011) paper, but did not validate terrain outputs. Ogren (2012) studied the Bear Creek HUC12 catchment in the southeast corner of the Zumbro River Watershed, which is distant from the study areas chosen in this thesis, but still shares similar agroecoregions (Rochester Plateau and Undulating Plains). Ogren (2012) also used the SPI terrain analysis attribute to identify CSAs in the study area, including sinkholes. He then filtered and prioritized the potential CSAs using various overlays, such as CSA pointsheds, Crop Productivity Indices (CPI), and bound distances to streams. The study resulted in a prioritized list of the top 30 CSAs in the Bear Creek Watershed. Though Ogren’s (2012) paper and this thesis share several key concepts, this thesis used field verification to validate SPI accuracies in the study areas and presents more detail for overall CSA identification processes.
INTRODUCTION

Non-point source pollution originating from agriculture is negatively impacting soil and water quality causing an international environmental issue (Soil Science Society of America, 2000). How to tackle this problem is complicated by the fact that agricultural land’s contribution to non-point source pollution largely occurs on private land and varies by soil type, climate, topography, hydrology, land use/cover, and land management. This leads to diffuse, sporadic, poorly defined contaminant sources that degrade water quality in a way that makes their control difficult (Heathwaite et al., 2005). The state of Minnesota has made great efforts toward leading the way for pollution reduction and cleaner water with the Clean Water Land and Legacy Act, signed into law on June 2, 2006, which put Minnesota on track toward addressing its impaired waters. The act works in concert with the federal Clean Water Act of 1972, which defines and addresses priorities for identifying impaired waters. The Clean Water Act requires states to identify and restore water bodies that do not meet established water quality standards (USEPA4). The Minnesota Clean Water Legacy Act specifically states that the Pollution Control Agency, in accordance with federal Total Maximum Daily Load (TMDL) requirements, sets priorities for identifying impaired waters, giving consideration to:

(1) waters where impairments would pose the greatest potential risk to human or aquatic health; and

(2) waters where data developed through public agency or citizen monitoring or other means, provides scientific evidence that an impaired condition exists (114D.20 subd. 4).

The process of creating and administering TMDL and the encompassing Watershed Restoration and Protection Strategy (WRAPS) programs for impaired waters are time consuming processes. A complete WRAPS approach can take 4 to 5 years to complete – the first 3 steps involve monitoring and assessment reports, stressor identification reports, assessing data, and creating TMDLs to determine the maximum daily amount the water body in question can receive and still meet water quality standards (USEPA4). Unfortunately, the annual number of delisted impaired waters is often a fraction of the annual amount of newly listed impaired waters. Funding and
staffing limitations in natural resource fields throughout the state make it difficult to make progress toward not just identifying impaired waters, but planning and implementing corrective measures needed to address the majority of non-point sources (NPS) of pollution causing these impairments. Identifying critical source areas that contribute the majority of runoff in an area using terrain analysis methods is one way to help focus work on NPS pollution with the goal of reducing sedimentation and other pollutants to surface waters.

**Critical Source Areas**

The identification of Critical Source Areas (CSAs) is not only a central theme in this thesis but a common topic addressed in numerous recent studies (USDA\(^a\)). CSAs are defined as portions of the landscape that combine high pollutant loading with a high propensity to deliver runoff to surface waters, either by an overland flow path or by subsurface drainage. CSAs have a higher likelihood than other portions of the landscape of conveying pollutants such as sediment, nutrients and chemicals to surface waters (Galzki et al., 2011). Overland runoff entering waterbodies can decrease water quality and negatively impacting biodiversity (Piechnik, et. al., 2012). Much of the stormflow containing these pollutants comes from relatively small areas and over relatively short time periods during larger storm events (e.g. Dillon and Molot, 1997; Pionke et al., 2000). Field studies have shown that surface runoff is generated primarily from near-stream areas, typically within 30 meters or less from the channel for most storms (Gburek et al., 2000).

Agricultural overland runoff is often the greatest contributor of non-point source pollution and therefore often considered a potential CSA. Overland runoff is commonly generated when the rate of precipitation exceeds the infiltration capacity of the soil (Heathwaite et al., 2005). Two common mechanisms for overland runoff generation are the infiltration and saturation excess methods. Infiltration excess runoff occurs when precipitation rates exceed the infiltration capacity of the surface/soil, whereas saturation excess runoff occurs when the soil has reached a point of saturation to the surface and additional precipitation results in overland flow (Horton, 1933). Small portions of the landscape that are conducive to either type of overland flow and are also hydrologically
connected to surface waters are where CSAs are commonly located (Galzki et al., 2008). These areas are often associated with gullies, ravines, and other types of natural or man-made channelized flows. By incorporating CSA identification into watershed management practices, it is possible to concentrate efforts in key areas of the watershed that are the most sensitive (Qiu et al., 2007). Therefore it is advantageous to find methods of targeting CSAs in an accurate and economically feasible way.

When a toolset was needed to locate CSAs for this study, the first step taken was to compile a database containing all known water resource related tools, models, and indices. Each addition to the database was thoroughly reviewed and several details recorded, including authors, supporting bodies, inputs/outputs, spatial/temporal scales, stressors modeled, etc. The ultimate goal of the research was to develop or combine a set of tools from those currently available that could be used to identify CSAs on the landscape in a way that is accurate (low margin of error), cost effective, readily available, thorough in its scope (considers all manners of transport mechanisms, spatial, and temporal scales), and easy to use (low learning curve). Few tools exist that are capable of locating CSA locations directly, though several are capable of modeling watershed management practices that can identify generalized areas of non-point source pollution and/or their impacts on water resources.

Many researchers have employed distributed parameter water quality models to study CSA behavior – a few of the models with studies in parentheses and model information in brackets include: AGNPS/AnnAGNPS (Line and Spooner, 1995; Pradhanang, 2013); [Theurer et al, 1999]; CREAMS (Line and Spooner, 1995); [Knisel, 1980]; GWLF (Niraula, 2013); [Haith and Shoemaker, 1987]; and SWAT (Steenhuis, et al, 1995, Mosbah, et al, 2011; Niraula, 2013); [Srinivasan and Arnold, 1994]. These studies have shown that tools possess the ability to identify and model CSAs, though often tools are limited to certain regions and/or spatial scales. Other issues common to model use include steep learning curves, varied user interfaces and terminologies, limited support and lack of community resources, and both amount and detail of required inputs.
Digital Terrain Analysis

Terrain Analysis (TA) is the process of analyzing landscapes by relating terrain and elevation attributes to other natural and artificial components, and Digital Terrain Analysis (DTA) describes a set of techniques used to derive those terrain attributes from elevation data (Basso, 2005). TA and DTA will be used interchangeably in this thesis.

Terrain analysis traces its origins back to the creation of topographic maps that could be used to produce quantitative information of topography (e.g. slopes and gradients, curvatures, drainage areas, etc.) and produce morphometric maps with that information (Vakhtin, 1930, Florinsky, 2012). Technological advances in the remote sensing field led to methods of making accurate measurements from photography, called photogrammetry, and better terrain feature visualization through stereoscopy. The rise in availability of personal computers in the 1990s created a mass transition from conventional terrain analysis methods to using digital methods of terrain analysis (Florinsky, 2012). With this shift came the ability to produce digital datasets that contained elevation values over large spatial extents, called Digital Elevation Models (DEMs). A raster DEM contains one elevation value as measured above Mean Sea Level (MSL) in each pixel, or cell, of data. DEMs differ mostly in their spatial resolution as measured in cell size. The USGS National Elevation Dataset (NED) DEM derived from 1:24,000-scale cartographic contours in 30x30 meter resolution was one of the most common elevation model resolutions used over the past few decades due to its no-cost, nation-wide availability. This resolution proved to be insufficient for accurate identification of CSAs using DTA (Galzki et al. 2011; Daggupati, 2012).

Recent advances in technology allowed much higher resolution DEMs to become more cost effective and accessible to acquire (Galzki et al., 2011; Daggupati, 2012). In June of 2009, Minnesota appropriated $5.6 million to fund the acquisition of hi-resolution elevation data captured from LiDAR (Light Detection and Ranging) technology and complete coverage of the entire state became publically available at no cost in the fall of 2013.
Studies have shown that terrain analysis accuracy for predicting fine-scale CSA locations is dependent on DEM resolution, with higher resolutions fostering increased efficacy and analytical capabilities to define critical areas (Srinivasan et al., 2009; Daggupati, 2012; Momm et al., 2013). The availability of LiDAR derived DEMs have caused a renewed interest in DTA over the last few decades as seen by the increase in publications relating to the subject.

DTA is used in this thesis as an assessment and screening tool for conservation planning – its attributes are used to visualize hydrologic behavior at various scales across agricultural landscape topography. Unlike many physical-based models, terrain analysis attribute calculations do not require climatic, nutrient, soil, land cover, stream flow, storm event data, etc. Terrain attributes are derived solely from a DEM. Even the simplest methods used to predict runoff, such as the Curve Number (CN), requires rainfall, soil moisture, cover, and the hydrologic soil group for each location. Because DTA only requires elevation input to calculate attributes, and hi-resolution DEMs are becoming increasingly available, the method becomes appealing to conservationists who might not otherwise take advantage of available technology due to the steep learning curves and required inputs that accompany most physical-based environmental models.

GIS software is used to perform DTA, which employs a DEM to characterize the physical features of the landscape. DTA can be used to identify locations with a high potential for erosion and pollutant runoff. One specific output of DTA, the Stream Power Index (SPI), combines slope and flow accumulation as a way to visualize and quantify the erosive power of overland flow – based on the assumption that flow accumulation is proportional to discharge – leading to the ability to evaluate and identify source areas. Additional spatial analyses can also be incorporated, including source proximity to a water body and soil erosion risk factors. It should be noted that these terrain analyses and other spatial analyses do not eliminate the need for field assessments. However, they can reduce the amount of time spent in the field and enhance data collection efforts by enabling technicians to select potentially sensitive sites.
Ultimately, terrain analysis was chosen as the primary means to locate CSAs in this thesis due to its simplicity, minimum of required inputs and the availability of those inputs, and its success as a precision conservation and water resource management tool (Wilson and Gallant, 2000; Galzki et al., 2011; USDA\textsuperscript{a}). It is important to note that many of the sites identified as sensitive by TA will already have appropriate management practices to counteract potential environmental damages. Thus, these tools also provide an important opportunity to recognize producer accomplishments and track program progress necessary for supporting basin management and Total Maximum Daily Load efforts.

Study Area

Physical description

The Zumbro River Watershed (ZRW), located within six counties in southeast Minnesota (Figure 1), drains approximately 1,421 sq. mi. (3,680 km\textsuperscript{2}, 910,337 ac.) of land and ranges in elevation from approximately 1,380 ft above MSL in the southwest near Hayfield to 660 ft above MSL at the outlet near Kellogg. The watershed is designated with the 8-digit Hydrologic Unit Code (HUC) 07040004. It is part of the larger HUC4 Upper Mississippi Root-Black basin (Figure 2) and is comprised of 67 smaller HUC12 and 100 HUC14 catchments (Figure 3).

The Zumbro River consists of three major branches designated the North, Middle, and South Forks. The branches and main trunk form 302 total river miles with a 2013 year total average discharge of 360 cfs (USGS\textsuperscript{a}) (Table 1). The Middle Fork is further separated into a North and South Branch. The North Fork begins near Walcott and flows east, connecting to the main branch between Mazeppa and Zumbro Falls. The Middle Fork and its branches begin near the Dodge-Steele County boundary and flow east to join the South Fork north of Rochester. The South Fork of the Zumbro River is the longest flow path in the watershed; flowing 122 river miles near Hayfield to the ZRW outlet. The South Fork’s course through Rochester has been channelized for flood control and is dammed in Wabasha County by the Rochester Public Works (RPU) Lake Zumbro Hydroelectric Generating Plant, forming Lake Zumbro.
Impaired waters

The Minnesota Pollution Control Agency (MPCA), as of 2012, lists a total of 33 stream reaches totaling 394 river miles as impaired along with three lakes/reservoirs in the ZRW (Figure 4). Twenty-two of the streams are listed as having turbidity impairments, and 26 have an approved TMDL plan as well as three lakes. Thirteen named and unnamed streams are included in that list, and all Zumbro branches and forks are counted as one stream (Table 2).

Geology & geomorphology

Much of the ZRW roughly east of Minnesota State Highway 56 was spared from glacial activity during the Laurentide Ice Sheet’s full extent approximately 20,000 years ago. This region (Figure 5) is generally characterized by the following (NRCSa):

- Deeply dissected river valleys
- Well to moderately well drained silty loessial soils over bedrock residuum
- Crop and grazing land on ridge tops and valley bottoms with a mix of dairy, beef and cash grain agriculture
- Karst topography
- Deciduous forest on steep side slopes
- Primary resource concerns are cropland soil erosion, surface water quality, grazing land and forestland productivity, stream bank erosion, and erosion during timber harvest

The glaciated section of the watershed is part of the western corn-belt plains. NRCS classifies it as the silty and loamy mantled – firm till plain common resource area. It was largely converted from prairie to cropland throughout the 19th and 20th centuries and shares many of the same resource concerns common to the non-glaciated portion of the watershed. The area is comprised of gently sloping till plain topography with soils that are predominantly well drained and formed in thin silty material over loamy till, underlain by sedimentary bedrock (NRCSa). The glaciated region generally has the largest depth to bedrock at approximately 300 ft and tapers off to shallower depths.
moving east towards the Mississippi River\(^1\). The glaciated region of the watershed contains many first order streams, several of which are the origins of the Zumbro River. Most of the Zumbro River headwaters have been straightened into drainage ditches with artificial drainage networks installed to remove excess soil water and increase productivity (ZWP\(^a\)). There is little to no cropland irrigation in the ZRW (NRCS\(^a\)).

The karst topography in southeast Minnesota provides a unique interaction between surface and groundwater systems. Water slowly dissolves the carbonate-rich bedrock and produces karst features, particularly sinkholes and springs. Because of this interaction, groundwater is more prone to contamination in karst regions, and much of the population in the watershed obtains their drinking water from groundwater sources in limestone and dolostone aquifers (Olcott, 1992). There are several small concentrations of sinkholes and springs in the ZRW, all of which are contained within the un-glaciated area. Springs are found primarily where the Cummingsville Formation is the first encountered bedrock layer (Olmsted Co.\(^a\), 2013). The ZRW contains approximately 8% of all the karst features inventoried in the state\(^2\), with the largest concentrations located in the Root River Watershed/Fillmore County, just outside the ZWP’s southeast boundary (Figure 6).

The ZRW receives 29 to 33 inches of average annual precipitation (MNDNR\(^a\)).

**Agroecoregions**

The concept of agroecoregions was created to define regions with relatively homogenous physical characteristics in agriculturally impaired Minnesota watersheds. There are seven distinct agroecoregions located within the ZRW (Figure 7):

- Rochester Plateau – Composed of well-drained, fine-textured loessial soils developed on moderate to steep slopes in karst, with a high density of intermittent streams and sinkholes, and a mixture of row crop, livestock operations, and dairy

---

1 Geologic Map of Minnesota: Bedrock Geology, from MGS State Map Series S-20 2000 (3rd edition)
2 DNR Karst Feature Inventory Points shapefile consisting of springs, sinkholes, stream sink/sieves, surface tile inlets, and tile drain outlets. Acquired 12 Feb. 2012
production systems. Water erosion potentials are extreme, while wind erosion potentials are low (Olmsted Co.).

- **Blufflands** – Composed of well drained, fine-textured soils on very steep to extremely steep slopes in karst topography with a very high density of intermittent streams and a moderate density of forested perennial stream networks.

- **Undulating Plains** – Consists of fine-textured soils, located mostly on moderately steep slopes, with one-fourth of the slopes being flat. Two-thirds of the soils are well drained, with one-third being poorly drained. A very high density of intermittent streams exists (MPCA).

- **Level Plains** – Composed of fine-textured, mostly poorly drained to well drained soils near the Middle Fork-S. Branch on the Zumbro River, with row crop production on relatively flat to moderately steep topography without sinkholes.

- **Rolling Moraine** – Composed of mostly well drained, fine textured silty to silty clay loam till soils on mostly flat to shallow slopes with a sparse drainage network consisting of mostly straightened ditch headwaters.

- **Steeper Alluvium** – Consists of both moderately well drained loess and loamy sediments over loamy till soils and well drained silty sediments over sandy and gravelly outwash in river channels with moderate to steep sloped banks.

- **Alluvium & Outwash** – Consists of either fine-textured alluvium or coarse-textured outwash. Soils are generally well drained, and located on flat to moderately steep slopes.

Agroecoregions are landscape units that share relatively uniform crop productivity, climate, geologic parent material, soil drainage, and slope steepness. Hatch et al. (2001) found that the variance in soil erosion, stream biotic habitat, stream water quality, lake water quality, and ground water quality was smaller within agroecoregion boundaries than within watershed boundaries, and that through linked biophysical and economic modeling, the economic costs of reducing phosphorus loads to streams were lower when best management practices (BMPs) were targeted to specific agroecoregions compared with an untargeted strategy involving entire watersheds. See APPENDIX A, Case Studies section for continued discussion on agroecoregions.
Pre-settlement vegetation

Before much of the watershed was converted to agriculture throughout the 19th century, pre-settlement vegetation in the ZRW consisted of mostly prairie (46%) in the upland and headwater regions, and oak openings and barrens (31%) adjacent to the larger rivers along with river forest and hardwoods.

---

3 Pre-settlement vegetation derived from Francis J. Marchner’s interpretation of notes and maps from General Land Office surveys conducted in Minnesota (1847-1895). Map was digitized by the MN DNR.
Table 3). Much of the prairie lands existed in the western half and oak openings and barrens in the eastern half of the watershed (Figure 8).

**Land use & ownership**

The majority of the land use within the watershed is agricultural. In 2011, cultivated crop lands made up 55% of land use in the ZRW, followed by grassland (12%) and pasture (11%)\(^4\). Urban land use makes up 9% of the watershed (Table 4 and Figure 9). Cultivated crops also make up the largest percent land use-type within a 100 ft buffer of the major rivers (\(^4\) Land use figures calculated from 2011 National Land Cover Database (NLCD))
Table 5). Corn and soybean are the main commodity crops grown in the watershed, with 240,630 acres of corn and 172,789 acres of soybeans planted in 2013\textsuperscript{5}. Crop rotations are common throughout the ZRW – the glaciated region sees mostly corn/soybean rotations and conventional tillage with some multi-year corn with soybean rotations being the common practice among producers. Crop rotations with hay and contour strip cropping are more common in the non-glaciated region, especially near steep bluffs. Figure 10 shows corn on corn cropland parcels and acreage taken from June 2006 to June 2013 as an example of fields managed without crop rotations within the watershed.

The population in the ZRW was estimated at 149,946 in 2007\textsuperscript{6} (NRCS\textsuperscript{a}). Approximately 98\% of the 909,363 acres in ZRW are privately owned\textsuperscript{7}. The remaining acres are state, county, federal, conservancy land, or covered by open water (NRCS\textsuperscript{a})(Figure 11, Table 6 and

\textsuperscript{5} Cropland figures taken from USDA-NASS Cropland Data Layer. Field observations collected during the annual NASS June Agricultural Survey
\textsuperscript{6} Estimated from U.S. Census Bureau TIGER census tract data
\textsuperscript{7} Ownership totals derived from MNDNR 2007 GAP Stewardship data
 Assessment estimates indicate 2,730 farms in the watershed as of 2007. Approximately 42% of the operations are less than 180 acres in size, 50% are from 180 to 1,000 acres in size, and the remaining farms are greater than 1,000 acres. Of the 2,820 operators in the basin, 61% are full time producers not reliant on off-farm income (NRCSa).

**Existing conservation practices**

An attempt was made to compile existing conservation practice (CP) information within the ZRW. Each SWCD office provided their existing CP data which included only pond, sediment basin and terrace locations. Figure 12 displays the information provided, though it can be seen that some counties maintain a better database of existing practices than others. For example, there are many terraces throughout Olmsted County, but none were included in the list. There are also inconsistencies associated with grade stabilization structures (NRCS 410) and water and sediment control basins (NRCS 638), with nomenclature being interchanged throughout the counties. Unfortunately little work has been done throughout the state to archive current and historic CP information, including type, design specifications, installation date, condition, maintenance, etc., as this information would be valuable when identifying CSAs.

**Field Sites**

**Overview**

The field site selection process was one of the first steps of the study. This approach ensured that the terrain analysis would be confined to a manageable area of interest. One field site was located in each of the three main agroecoregions within the ZRW: rolling moraine/level plains located in the glaciated region and both Rochester plateau and blufflands in the non-glaciated area. The exact sites chosen were based primarily on agroecoregions and proximity to impaired streams. Other criteria included landowner relationships with SWCD staff, and mean Environmental Benefits Index (EBI) values by HUC14 watershed (Figure 13). The EBI integrates soil erosion risk, water quality risk and habitat quality factors to determine the relative conservation value of a 30x30 meter parcel of land.
DTA was first used to predict CSA locations within HUC14 sized catchments, then land owners were contacted by their SWCD office first by mail then by a follow-up phone call to see if they would be interested in allowing researchers onto their land for field validation. The exact land locations that were field validated for this thesis required landowner permission along riparian corridors. The overall HUC14 site selection used for field work was subjective, though the smaller sub-catchments later visited had a random nature due to the spottiness of where landowner access was granted. This helped to minimize bias in the field validation selection process.

**Locations**

Three sub watersheds were field validated for this thesis and together cover the three largest agroecoregions in the ZRW. Each site was given a unique identifier (shown in Figure 14).

The first of the three areas – hereafter called A1 – is a small agricultural sub-HUC14 watershed that contains the headwaters of the Middle Branch of the Middle Fork of the Zumbro River with an upstream catchment area of 2,556 ha. (6,315 ac.) (Figure 15). Approximately 1.25 linear miles of stream corridor were assessed for erosional features. The A1 catchment is located near West Concord, Dodge Co., MN in the rolling moraine/level plains agroecoregion of the ZRW that was covered by glaciers during the last glacial period. The watershed topography is very flat with low relief and is heavily tile drained. The average slope is 1.94%. Cultivated crop production is the only land-use in the fields surrounding the riparian corridor assessed – specifically conventionally tilled corn/soybean rotation plantings being the norm, with some two year corn followed by soybeans, and continuous corn (6+ years).

The second set of subwatersheds studied – hereafter called A2 – are located around Berne, Dodge Co., MN in the Rochester plateau agroecoregion of the ZRW (Figure 16). The western edge of the Rochester plateau agroecoregion in the ZRW follows the approximate glacial extent with the region to the west being glaciated during the last ice age but not to the east. Unlike the other two field sites (A1 and B2), A2 is not contained within one catchment, but rather three, which are split between two HUC14
sized watersheds. The three catchments are located along Harkcom Creek and two unnamed creeks, all of which are tributaries to the Middle Branch of the Middle Fork of the Zumbro River. Their total upstream catchment area is 1,105 ha. (2,730 ac.)\(^8\).

Average slope of A2 is 6.63\%. Approximately 4.5 linear miles of stream corridor were assessed. Several 300+ head cattle operations exist near A2, making pasture, hay and corn land uses common. Corn is grown for both grain and silage, where the latter will more likely have fall manure applied. Some growers in the region are starting to plant tillage radish or rye cover crops after corn silage harvest and any manure application.

The third and final sub-watershed studied – hereafter called B2 – is along Cold Spring Brook, a tributary that discharges to the main Zumbro River trunk, with an upstream catchment area of 11,546 ha. (28,530 ac.) (Figure 17). Approximately 5.8 linear miles of stream corridor were assessed. The B2 area is located just north of Zumbro Falls, Wabasha Co., MN in the blufflands agroecoregion. This site is the steepest field site of the three, with an average slope of 7.28\%. Cropland practices in the Cold Creek watershed tend to include conservation rotations of corn and hay in contour strips along bluffs and steeper fields and some soybeans grown in flatter fields. When soybeans are in a rotation, those fields tend to be continuous corn with beans grown every three to five years. Pasture lands are also common where livestock operations exist, along with forested areas along bluffs, riparian areas and ravines.

**Objectives**

The overall goal of this thesis was to determine the suitability and accuracy of identifying critical source areas in the ZRW to inform field assessments for BMP implementation using digital terrain analysis techniques. Several objectives used to accomplish this goal were as follows:

- Describe study area and field sites and provide detail on landscape features and hydrology.

---

\(^8\) The total area listed is from the upstream catchment area for two of the sites, and the upland catchment area for the third site. The third site is a small forested hillslope along Harkcom Creek.
- Identify CSAs using DTA spatial data within a GIS environment and field validate the areas identified.
- Determine accuracies of DTA methods for identifying CSAs using statistical analyses.
- Develop method to easily determine best fit threshold values for Stream Power Index (SPI) raster datasets
- Determine BMP suitability for the main agroecoregions in the ZRW
- Create a detailed manual containing GIS based terrain analysis methods used to identify CSAs which can be easily followed by users with little to no GIS experience

**Figures**

![Map of Counties in southeast Minnesota that contain the Zumbro River Watershed.](image)
Figure 2. Shaded relief map of Minnesota with Upper Mississippi Root-Black HUC4 watershed in orange divided into its five HUC8 watersheds.
Figure 3. Zumbro River Watershed with HUC12 sub-watersheds.
Figure 4. Year 2012 impaired waters listed in the Zumbro River Watershed.
Figure 5. Zumbro River Watershed with purple area showing extent of the non-glaciated region.
Figure 6. Zumbro River Watershed’s spatial relationship to southeast Minnesota karst features.
Figure 7. Agroecoregions within the Zumbro River Watershed.
Figure 8. Zumbro River Watershed map of pre-settlement vegetation.
Figure 9. Year 2011 land cover map of the Zumbro River Watershed.
Figure 10. Image set of continuous corn acres from June 2006 to June 2013. Yellow cells represent corn acres in continuous production through the indicated years.

Figure 11. Zumbro River Watershed land ownership map. Year 2008 GAP stewardship data.
Figure 12. Soil and Water Conservation District inventory of existing structural conservation practices in the ZRW.
Figure 13. Top: Environmental Benefits Index values in the Zumbro River Watershed and bottom: averaged on a HUC14 scale.
Figure 14. Field validation sites in the Zumbro River Watershed. Points represent validated features and colored polygons represent contributing areas for the furthest downstream point.
Figure 15. A1 catchment with field verified CSAs.
Figure 16. A2 catchment with field verified CSAs.
Figure 17. B2 catchment with field verified CSAs.
Tables

Table 1. Stream flow data from Rochester, MN South Fork Zumbro River reporting station.

<table>
<thead>
<tr>
<th>Monitoring Station</th>
<th>Period</th>
<th>Discharge (cu. ft/sec)</th>
</tr>
</thead>
<tbody>
<tr>
<td>USGS 05372995 SOUTH FORK ZUMBRO RIVER AT ROCHESTER, MN</td>
<td>2013 total avg</td>
<td>360</td>
</tr>
<tr>
<td></td>
<td>May-Sep 2007 avg</td>
<td>528</td>
</tr>
</tbody>
</table>

Table 2. MPCA 2012 impaired waters list for the ZRW.

<table>
<thead>
<tr>
<th>Listed Stream</th>
<th>Reach Location</th>
<th>Impairment</th>
<th>Affected Use</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bear Creek</td>
<td>Willow Cr to S Fk Zumbro R</td>
<td>Turbidity</td>
<td>Aquatic life</td>
</tr>
<tr>
<td>Bear Creek</td>
<td>Headwaters to Willow Cr</td>
<td>Turbidity</td>
<td>Aquatic life</td>
</tr>
<tr>
<td>Cascade Creek</td>
<td>Headwaters to Unnamed cr</td>
<td>Turbidity</td>
<td>Aquatic life</td>
</tr>
<tr>
<td>Cascade Creek</td>
<td>Unnamed cr to S Fk Zumbro R</td>
<td>Turbidity</td>
<td>Aquatic life</td>
</tr>
<tr>
<td>Dodge Center Creek</td>
<td>JD 1 to S Br M Fk Zumbro R</td>
<td>Turbidity</td>
<td>Aquatic life</td>
</tr>
<tr>
<td>Milliken Creek</td>
<td>Unnamed cr to M Fk Zumbro R</td>
<td>Turbidity</td>
<td>Aquatic life</td>
</tr>
<tr>
<td>Milliken Creek</td>
<td>Unnamed cr to Unnamed cr</td>
<td>Turbidity</td>
<td>Aquatic life</td>
</tr>
<tr>
<td>Salem Creek</td>
<td>T106 R16W S30, w line-S Fk Zumbro R</td>
<td>Fecal Coliform</td>
<td>Aquatic recreation</td>
</tr>
<tr>
<td>Silver Creek</td>
<td>Unnamed cr to Silver Lk (S Fk Zumbro R)</td>
<td>Turbidity</td>
<td>Aquatic life</td>
</tr>
<tr>
<td>Silver Creek</td>
<td>Unnamed cr to Unnamed cr</td>
<td>Turbidity</td>
<td>Aquatic life</td>
</tr>
<tr>
<td>Unnamed creek</td>
<td>Unnamed cr to Unnamed cr</td>
<td>Turbidity</td>
<td>Aquatic life</td>
</tr>
<tr>
<td>Unnamed creek</td>
<td>Unnamed cr to Salem Cr</td>
<td>Fecal Coliform</td>
<td>Aquatic recreation</td>
</tr>
<tr>
<td>Unnamed creek</td>
<td>Unnamed cr to Unnamed cr</td>
<td>Turbidity</td>
<td>Aquatic life</td>
</tr>
<tr>
<td>Unnamed creek</td>
<td>Unnamed cr to Unnamed cr</td>
<td>Fecal Coliform</td>
<td>Aquatic recreation</td>
</tr>
<tr>
<td>West Indian Creek</td>
<td>T110 R11W S31, south line to Zumbro R</td>
<td>Mercury (Hg)</td>
<td>Aquatic consumption</td>
</tr>
<tr>
<td>West Indian Creek</td>
<td>T109R11WS21 S line-T109R11WS6 N line</td>
<td>Mercury</td>
<td>Aquatic consumption</td>
</tr>
<tr>
<td>West Indian Creek</td>
<td>Headwaters to T109 R11W S28, north line</td>
<td>Mercury</td>
<td>Aquatic consumption</td>
</tr>
<tr>
<td>Willow Creek</td>
<td>Headwaters to Bear Cr</td>
<td>Turbidity</td>
<td>Aquatic life</td>
</tr>
<tr>
<td>Zumbro River</td>
<td>N Fk Zumbro R to Cold Cr</td>
<td>PCB, Mercury</td>
<td>Aquatic consumption</td>
</tr>
<tr>
<td>Zumbro River</td>
<td>Cold Cr to West Indian Cr</td>
<td>PCB, F. Coli., Mercury</td>
<td>Aq. consumption, rec.</td>
</tr>
<tr>
<td>Zumbro River</td>
<td>Zumbro Lk to N Fk Zumbro R</td>
<td>PCB, Mercury</td>
<td>Aquatic consumption</td>
</tr>
<tr>
<td>Zumbro River</td>
<td>West Indian Cr to Mississippi R</td>
<td>PCB, Turb., F. Coli., Hg</td>
<td>Aq. consump., rec., life</td>
</tr>
<tr>
<td>Zumbro River, M Fk</td>
<td>Shady Lk to Zumbro Lk</td>
<td>Turbidity</td>
<td>Aquatic life</td>
</tr>
<tr>
<td>Zumbro River, M Fk</td>
<td>Headwaters to N Br M Fk Zumbro R</td>
<td>Turbidity</td>
<td>Aquatic life</td>
</tr>
<tr>
<td>Zumbro R, M Fk, N Br</td>
<td>Headwaters to M Fk Zumbro R</td>
<td>Turbidity</td>
<td>Aquatic life</td>
</tr>
<tr>
<td>Zumbro R, M Fk, S Br</td>
<td>Headwaters to Dodge Center Cr</td>
<td>Turbidity</td>
<td>Aquatic life</td>
</tr>
<tr>
<td>Zumbro R, M Fk, S Br</td>
<td>Dodge Center Cr to M Fk Zumbro R</td>
<td>Turbidity</td>
<td>Aquatic life</td>
</tr>
<tr>
<td>Zumbro River, N Fk</td>
<td>Headwaters to Trout Bk</td>
<td>Turbidity</td>
<td>Aquatic life</td>
</tr>
<tr>
<td>Zumbro River, S Fk</td>
<td>Salem Cr to Bear Cr</td>
<td>Turbidity, F. Coliform</td>
<td>Aquatic rec., life</td>
</tr>
<tr>
<td>Zumbro River, S Fk</td>
<td>Silver Lk Dam to Cascade Cr</td>
<td>Fecal Coliform</td>
<td>Aquatic recreation</td>
</tr>
<tr>
<td>Zumbro River, S Fk</td>
<td>Cascade Cr to Zumbro Lk</td>
<td>Turbidity, F. Coliform</td>
<td>Aquatic rec., life</td>
</tr>
<tr>
<td>Zumbro River, S Fk</td>
<td>Bear Cr to old Oakwood Dam location</td>
<td>Fecal Coliform</td>
<td>Aquatic recreation</td>
</tr>
<tr>
<td>Zumbro River, S Fk</td>
<td>Old Oakwood Dam to Silver Lk Dam</td>
<td>Turbidity</td>
<td>Aquatic life</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Listed Lake</th>
<th>Reach Location</th>
<th>Impairment</th>
<th>Affected Use</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lake Zumbro</td>
<td>Olmsted Co., 2 miles ne of Oronoco</td>
<td>Nutrients, Mercury</td>
<td>Aq. Consump., rec.</td>
</tr>
<tr>
<td>Silver Lake</td>
<td>Olmsted County, in Rochester</td>
<td>Mercury</td>
<td>Aquatic consumption</td>
</tr>
<tr>
<td>Willow Creek Res.</td>
<td>Olmsted Co., 1.5 miles sw of Rochester</td>
<td>Mercury</td>
<td>Aquatic consumption</td>
</tr>
</tbody>
</table>
### Table 3. Pre-settlement vegetation types and proportions in the ZRW.

<table>
<thead>
<tr>
<th>Vegetation Class</th>
<th>Area in acres</th>
<th>Percent of watershed (%)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Prairie</td>
<td>416,141</td>
<td>45.8</td>
</tr>
<tr>
<td>Oak openings and barrens</td>
<td>284,986</td>
<td>31.3</td>
</tr>
<tr>
<td>Brush Prairie</td>
<td>89,965</td>
<td>9.9</td>
</tr>
<tr>
<td>Aspen-Oak Land</td>
<td>49,688</td>
<td>5.5</td>
</tr>
<tr>
<td>Big Woods - Hardwoods</td>
<td>31,682</td>
<td>3.5</td>
</tr>
<tr>
<td>River Bottom Forest</td>
<td>22,830</td>
<td>2.5</td>
</tr>
<tr>
<td>Wet Prairie</td>
<td>12,715</td>
<td>1.4</td>
</tr>
<tr>
<td>Lakes (open water)</td>
<td>1,355</td>
<td>0.1</td>
</tr>
<tr>
<td><strong>Total</strong></td>
<td><strong>909,363</strong></td>
<td><strong>100</strong></td>
</tr>
</tbody>
</table>

### Table 4. Land use summary of the Zumbro River Watershed.

<table>
<thead>
<tr>
<th>Land Cover</th>
<th>Area in acres</th>
<th>Percent of watershed (%)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cultivated Crops</td>
<td>507,355</td>
<td>55.7</td>
</tr>
<tr>
<td>Grassland/Herbaceous</td>
<td>110,984</td>
<td>12.2</td>
</tr>
<tr>
<td>Pasture/Hay</td>
<td>104,126</td>
<td>11.4</td>
</tr>
<tr>
<td>Deciduous Forest</td>
<td>87,075</td>
<td>9.6</td>
</tr>
<tr>
<td>Urban-All</td>
<td>81,479</td>
<td>9.0</td>
</tr>
<tr>
<td>Wetland-All</td>
<td>13,534</td>
<td>1.5</td>
</tr>
<tr>
<td>Open Water</td>
<td>3,895</td>
<td>0.4</td>
</tr>
<tr>
<td>Other</td>
<td>1,622</td>
<td>0.2</td>
</tr>
<tr>
<td><strong>TOTAL</strong></td>
<td><strong>910,337</strong></td>
<td><strong>100.0</strong></td>
</tr>
</tbody>
</table>
Table 5. Zumbro River Watershed riparian land use/land cover based on a 100ft buffer on both sides of waterway.

<table>
<thead>
<tr>
<th>Riparian Land Cover*</th>
<th>Area in acres</th>
<th>Percent of watershed (%)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Row Crops</td>
<td>18,756</td>
<td>57.7</td>
</tr>
<tr>
<td>Grass, etc.</td>
<td>14,548</td>
<td>44.8</td>
</tr>
<tr>
<td>Forest</td>
<td>9,291</td>
<td>28.6</td>
</tr>
<tr>
<td>Wetlands</td>
<td>3,977</td>
<td>12.2</td>
</tr>
<tr>
<td>Urban</td>
<td>3,311</td>
<td>10.2</td>
</tr>
<tr>
<td>Open Water</td>
<td>1,355</td>
<td>4.2</td>
</tr>
<tr>
<td>Shrub, etc</td>
<td>13</td>
<td>0.0</td>
</tr>
<tr>
<td>Grain Crops</td>
<td>0</td>
<td>0.0</td>
</tr>
<tr>
<td>Orchards</td>
<td>0</td>
<td>0.0</td>
</tr>
<tr>
<td><strong>TOTAL</strong></td>
<td><strong>32,495</strong></td>
<td><strong>100</strong></td>
</tr>
</tbody>
</table>

*Based on a 100ft buffer on 100k Hydro GIS layer

Table 6. Land ownership type in ZRW. 2008 GAP Stewardship data.

<table>
<thead>
<tr>
<th>Ownership Type</th>
<th>Area in acres</th>
<th>Percent of watershed (%)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Private</td>
<td>897,802</td>
<td>98.61</td>
</tr>
<tr>
<td>State</td>
<td>4,984</td>
<td>0.55</td>
</tr>
<tr>
<td>Federal</td>
<td>3,978</td>
<td>0.44</td>
</tr>
<tr>
<td>Private Non-Industrial</td>
<td>2,998</td>
<td>0.33</td>
</tr>
<tr>
<td>County</td>
<td>662</td>
<td>0.07</td>
</tr>
<tr>
<td>Other Public</td>
<td>28</td>
<td>0.00</td>
</tr>
<tr>
<td>Private Conservancy</td>
<td>16</td>
<td>0.00</td>
</tr>
<tr>
<td><strong>Total</strong></td>
<td><strong>910,468</strong></td>
<td><strong>100</strong></td>
</tr>
</tbody>
</table>
Table 7. Ownership vs. 2006 land use type in the Zumbro River Watershed.

<table>
<thead>
<tr>
<th>Land cover/Use</th>
<th>Public Acres</th>
<th>Public %</th>
<th>Private Acres</th>
<th>Private %</th>
<th>Total Acres</th>
<th>Percent</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cultivated Crops</td>
<td>970</td>
<td>8.10%</td>
<td>506,386</td>
<td>56.40%</td>
<td>507,355</td>
<td>55.70%</td>
</tr>
<tr>
<td>Grassland/Herbaceous</td>
<td>1,849</td>
<td>15.40%</td>
<td>109,135</td>
<td>12.20%</td>
<td>110,984</td>
<td>12.20%</td>
</tr>
<tr>
<td>Pasture/Hay</td>
<td>472</td>
<td>3.90%</td>
<td>103,655</td>
<td>11.50%</td>
<td>104,128</td>
<td>11.40%</td>
</tr>
<tr>
<td>Deciduous Forest</td>
<td>6,182</td>
<td>51.70%</td>
<td>80,894</td>
<td>9.00%</td>
<td>87,075</td>
<td>9.60%</td>
</tr>
<tr>
<td>Evergreen Forest</td>
<td>135</td>
<td>1.10%</td>
<td>853</td>
<td>0.10%</td>
<td>989</td>
<td>0.10%</td>
</tr>
<tr>
<td>Urban-All</td>
<td>411</td>
<td>3.40%</td>
<td>81,068</td>
<td>9.00%</td>
<td>81,479</td>
<td>9.00%</td>
</tr>
<tr>
<td>Wetland-All</td>
<td>1,493</td>
<td>12.50%</td>
<td>12,041</td>
<td>1.30%</td>
<td>13,534</td>
<td>1.50%</td>
</tr>
<tr>
<td>Open Water</td>
<td>415</td>
<td>3.50%</td>
<td>3,480</td>
<td>0.40%</td>
<td>3,895</td>
<td>0.40%</td>
</tr>
<tr>
<td>Other</td>
<td>40</td>
<td>0.30%</td>
<td>594</td>
<td>0.10%</td>
<td>634</td>
<td>0.10%</td>
</tr>
<tr>
<td><strong>Watershed Totals</strong></td>
<td><strong>11,967</strong></td>
<td><strong>100%</strong></td>
<td><strong>898,106</strong></td>
<td><strong>100%</strong></td>
<td><strong>910,073</strong></td>
<td><strong>100%</strong></td>
</tr>
</tbody>
</table>

* includes private-non-industrial
METHODS

Digital Terrain Analysis

Terrain analysis procedure overview

The Digital Terrain Analysis (DTA) used in this paper followed strict methodological procedures, as highlighted in the Figure 18 flow chart, to ensure consistency among the various dataset inputs. The analysis began with a planning process where project goals were established and appropriate scales for assessment were defined. The spatial scale determined the amount of data acquisition necessary to address the paper’s objectives. The attributes are either primary or secondary in nature, depending on whether they derive directly from elevation data or a secondary product. These attributes, when combined with relevant ancillary data, provided enough information to locate and prioritize potential CSAs. Ground truthing was an important step necessary to relate mapping to planned goals. The objective of ground truthing was to determine best-fit threshold values for a given Area of Interest (AOI) by comparing digital terrain attributes to real-world conditions. When thresholds were established, CSAs could then be located and prioritized using a combination of primary attributes, secondary attributes, and ancillary data. CSA validation was used to determine accuracy of predictions and reveal the existence of commission and omission errors. This step was fundamental to the learning process since locating potential CSAs digitally is an adaptive process and validation provides opportunities to improve visualization and prediction techniques. Evaluation of site conditions accompanied the field validation. The final phase for conservationists using this methodology would be to establish BMPs for each field-verified CSA. Planners would make decisions regarding how to address each CSA. This could involve working with land owners and growers, determining which BMPs are most suited for the agroecoregion(s), and/or securing conservation practice funds for BMP implementation, among others. This BMP implementation phase was outside the scope of this thesis paper and was therefore not initiated.
Digital terrain analysis was performed first followed by field work, as shown in Figure 18. By not visiting sites first, possible bias was eliminated that could have resulted from knowing where erosion was which could have influenced CSA identification by reducing errors. DTA was also performed before field work to avoid having local knowledge and prior to knowing landowners or having permission to access fields by landowners. It was easier to progress with the project by running DTA at the HUC14 level for several watersheds first and then requesting landowner permission to validate outputs after the DTA was performed. A randomized nature to the selection process was also introduced when identified potential CSA points along riparian areas were given to SWCD staff members who then contacted landowners with CSAs on their property. Of the owners contacted, over 90% responded favorably and granted access permission.

Figure 18. Method flow chart for terrain analysis processing.
Data acquisition
For the primary attribute calculations that define terrain analysis, only a raster DEM is required, though ancillary data is necessary to create informed CSA predictions – all of which was acquired from the Minnesota ‘data deli’ website: http://deli.dnr.state.mn.us/ unless otherwise noted. Data used in this thesis include:

- Digital Elevation Model (DEM) – A Digital Elevation Model contains one elevation value as measured above MSL in each pixel, or cell, of data. LiDAR elevation data was used for its very high spatial and vertical resolutions and accuracy characteristics. LiDAR data was downloaded at the county level from the Minnesota Department of Natural Resources (DNR) LiDAR ftp site: ftp://lidar.dnr.state.mn.us/

  LiDAR data was captured throughout the ZRW in November, 2008. The LiDAR data from the above source provide DEMs in both 1 and 3 meter resolutions. Digital terrain analyses are best processed using a 3 meter DEM to minimize processing times and file sizes while maintaining a high level of elevation detail (Galzki, et al., 2011, Dogwiler and Hooks, 2012). Terrain attributes derived from very high resolution DEMs will often lack clarity because micro topography features, such as fence lines, tire ruts, and inherent noise from aerial LiDAR collection give attributes poorly connected, over-complex flow networks. Attributes created from 1m DEMs were only found suitable at very small scales, such as hillslope, and/or in steeper terrain (Dogwiler and Hooks, 2012).

- Surface waters – DNR 24k stream data containing both perennial and intermittent networks along with lake/wetland layers was used to determine hydrologic connection to secondary attributes.

- Watershed catchments – DNR watershed boundary data at various Hydrologic Unit Code (HUC) levels were used for both geoprocessing tasks and visualizing catchments at varied spatial extents. The number of digits in the HUC code determines the spatial scale of the catchment – from 2 digits representing regional basins to 12 or more digits representing sub-watersheds.
• Cities and political boundaries – Political boundary and populated area data used for spatial orientation, locating areas of interest, and improving map presentations.

• Land cover/land use – 2009 and 2012 National Land Cover Database (NLCD) raster datasets were used for general land cover identification, and 2006-2013 USDA-NASS Cropland Data used for cropland type change detection. Downloaded from the USDA Geospatial Data Gateway: http://datagateway.nrcs.usda.gov/

• Environmental Benefits Index – The EBI layer integrates soil erosion risk, water quality risk and habitat quality factors to determine the relative conservation value of a parcel of land. The EBI was used for locating regions with elevated conservation benefit potential. The Soil Erosion Risk portion of the EBI, derived from the Universal Soil Loss Equation (USLE), was also be used alone to aid with CSA placement. The EBI and its individual layers were acquired from the Minnesota Board of Water and Soil Resources (BWSR) website at 30x30m cell resolution.

• NRCS GIS Engineering tools –The NRCS package contains multiple conservation planning python-based script toolsets. The tools used for this paper include the hydro-conditioning and watershed delineation scripts. Direct download link: ftp://ftp.lmic.state.mn.us/pub/data/elevation/lidar/tools/NRCS_engineering/NRCS_GIS_ENGINEERING_TOOLS_ver1.1.7.zip

• High resolution aerial orthophotos – Orthorectified and georeferenced photos were used to ensure correct alignment with surface features. FSA National Aerial Imagery Program (NAIP) leaf-off color and color infrared (CIR) photos at or below 1 meter resolution were used for this thesis and were acquired from the Minnesota Geospatial Information Office (MNGeo) web map service (WMS).

• Soils Data – Soil Survey Geographic Database (SSURGO) combined with the USDA ArcGIS Soil Viewer extension provided various soil related information.
• Other – Other miscellaneous regional data used include feedlot location and livestock density data, county culvert locations, ASCS historic aerial imagery, and existing conservation practice types and locations.

**DEM pre-processing**

DEMs can benefit from pre-processing before terrain analysis is conducted, though the amount of pre-processing required depends on the user’s local knowledge of their Area of Interest (AOI) and its characteristics, and the resolution and quality of the original DEM. Several pre-processing methods exist for manipulating DEMs, though only sink filling and hydrologic conditioning were considered here.

Sink filling, also known as pit filling, which fills depressions with hypothetical water flow and forces drainage to the lowest possible outlet, has a significant effect on terrain attributes and was therefore important to considering when pre-processing. Generally, these small DEM depressions are filled for watershed analyses as they hinder flow-path determination and, therefore, derivation of other hydrologic parameters (Daggupati, 2012). The sinks filled can vary considerably in scale from an isolated single cell to hundreds of contiguous cells covering well over 50 acres. The pit-filling process may not be appropriate for all areas, especially where water is held and evaporated in depressions, where extensive tile drainage exists, or where natural depressions important for surface erosional feature formation exist (see APPENDIX A, Case Studies section for additional information). It is, however, a more conservative approach than using a non-filled DEM because it tends to err on the side of overestimating flows (Galzki, et al., 2011), as SPI signatures created from pit filled DEMs are more analogous to saturation excess runoff flow paths produced from larger storm events. SPI signatures from unfilled pits are often short and segmented, whereas a pit filled SPI might have more contiguous SPI signatures. For SPI creation, completely filling pits was generally found to be more suitable for steeply sloping landscapes and less suitable for low relief areas, though for partial filling, the best way to determine suitability was to verify actual field conditions and compare them to various vertical fill limits. Because this isn’t always possible or practical, typically a higher vertical fill limit (Z limit) is used for steeper terrain than for flat terrain. For example, a z limit of 1 meter would work well for an area with average
slope of 5 to 10\%, whereas a z limit of 0.1 to 0.2 meters would be best for an area with a 2\% average slope or less. Having open intakes in fields further complicates pit filling, since a pit with an intake isn’t likely to fill up and spill out in most situations. Ultimately for this study, DEMs were not pit filled to ensure consistency among the extensive spatial extents covering the multiple study areas in the ZRW and so results could be more easily duplicated, though pit filling was used to compare many of the SPI results. Several recent papers studying gullies using GIS methods also did not fill DEM sinks (Kim, 2007; Bussen, 2009; Daggupati, 2012 and 2014).

Hydrologic conditioning (HC) is the process of modifying a DEM to change flow routing and drainage. The most common practice of HC is to remove “digital dams” that block the hypothetical flow of water typically associated with road crossings and other obstructions (Figure 19). One method of removing digital dams is to ‘burn’ the stream through the obstruction to force flow downstream, which was the method employed for testing HC in this thesis (Figure 19). HC can be a time consuming process, thus it was important to consider whether project goals would benefit from the operation, and if so, how much correction would be needed and at what scale, especially since HC only has an influence on terrain analysis attributes in close proximity to digital dams removed. HC was found to be most useful when combined with pit filling – when pit filling was not necessary or suitable in the AOI, HC tests provided minimal terrain analysis benefits. However, when pit filling was used, hydro-conditioned DEMs tended to produce more accurate terrain attributes within filled depressions. For instance, when all sinks were filled in a DEM, HC improved flow routing by unblocking large depression areas downstream that would otherwise need to fill with hypothetical water to force flow over obstructions. The SPI signatures in those unblocked depressions were more representative of actual overland flow when sinks had been filled – when unfilled, the signatures can often be erroneous straight lines (Figure 20). Therefore, when filling all pits, HC is recommended. For this study, HC was confined to only correcting DEM flow paths through known or visible culvert locations that would otherwise influence many upstream SPI values if filled.
Several SPI layers were calculated in one study area to show how both pit filling and hydro-conditioning affect SPI signatures (Figure 21). The site shown in **Error! Reference source not found.** was chosen for the presence of a large culvert road crossing with a high concentration of flow. Sites with those two characteristics tend to produce erroneous SPI signatures when pit filling without hydro-conditioning is used (Figure 21 3A). Note the signature that parallels the buffer just north of the stream which doesn’t exist in the non-pit filled images. Also note the signature that starts at the top of images and either terminates at buffer (non-pit filled) or stream (pit-filled).

![Figure 19. An example of how water ponds (in blue) behind road crossings when using a non-conditioned DEM. There are culverts present at both crossings (circled in yellow), though the DEM does not recognize culverts and sees the road as an obstruction – known as a digital dam.](image)
Figure 20. [Top] Culvert location placed for stream burning hydro-conditioning and [Bottom] example of SPI signatures in flat terrain from a DEM that had all pits filled.
Figure 21. The above images show SPI signatures calculated from a 3 meter DEM with varying degrees of pre-processing performed. All SPI signatures are from the 97.5th percentile within the extent shown (~136 acres). Figures in the left column were not hydro-conditioned, while figures in right column were – the DEM was hydro-conditioned by burning the stream (blue line) through the north-south oriented road crossing culvert in the top-right of image. Note: The stream shown is same throughout all images.

1A and 1B – Not pit filled. The results are essentially identical.

2A and 2B – Pit filled using a 1 meter z-limit. The displays are nearly identical with only slight color gradient variation between the two. Note the new signatures near the buffer just north of stream that didn’t exist in 1A and 1B. These additions can influence CSA predictions.

3A and 3B – Pit filled with no maximum z-limit, meaning all pits were filled. In this example, 2B and 3B are nearly identical. This is not always the case [see APPENDIX A, case study #5 – Steep Dryer Moraine]. Note the straight signature somewhat paralleling the stream in 3A. This can be used to estimate where main channel flow will exist during flooding or culvert blockage. Caution should be used when identifying potential CSAs from those seemingly “erroneous” signatures.
Terrain analysis attributes

DTA involves combining primary attributes to form secondary attributes. Primary terrain attributes are derived solely from a DEM. The core primary attributes used for this terrain analysis include flow direction, flow accumulation, and slope.

The ArcGIS Flow Direction tool uses a calculation method called the ‘D8’ algorithm. This method is well suited to the identification of individual channels, channel networks and basin boundaries making it suitable for terrain analysis CSA identification. However, it is based on two simplifying assumptions that do not capture the geometry of divergent flow over hillslopes. The two simplifications are the use of 8 discrete flow angles, and each pixel has a single flow direction (Rivix, 2008). Due to these factors, the ‘D-Infinite’ algorithm was created to overcome D8 limitations and therefore provide an increased potential to improve terrain analysis results. Several software programs exist with dedicated DEM processing offering both D8 and D-Infinite calculations (e.g. TauDEM, RichDEM, RiverTools). The D8 method imbedded in the Flow Direction ArcTool was used in this thesis as it is the more commonly used and readily available method – therefore likely to be used by the average GIS user.

Other primary attributes used were for visualization purposes, including hillshade and plan/profile curvature layers. The plan and profile curvature terrain attributes were also used primarily to identify upland sinkhole locations, and to aid in ravine identification.

Secondary attributes include Stream Power Index (SPI) and Compound Topographic Index (CTI). SPI is calculated as the product of the natural log of both slope and flow accumulation using the following equation:

\[ SPI = \ln(A \times \tan\beta) \]

Where \( A \) = flow accumulation and \( \beta \) = percent slope. SPI was calculated using the Raster Calculator and 0.001 was added to both the Flow Accumulation (FA) and Slope to avoid calculating a natural log of 0. Traditionally, the SPI calculation calls for use of the Specific Catchment Area (SCA) in lieu of FA. Calculation of SCA, defined as the area of
land upslope of a width of contour, divided by the contour width (Wilson and Gallant, 2000), within the ArcGIS environment requires additional tools, such as TauDEM, making it difficult for basic-level users to create. FA was therefore used in its place as a simpler alternative. Outputs are similar between the two; the most notable difference is the common addition of a smaller histogram to the left of the larger one when using FA in SPI calculations, though this result does not always appear. Because Flow Accumulation rasters have a significant number of zero values where ridges and peaks exist, calculating SPI’s without correcting these values will introduce undesirable NoData cells in their place. The tangent of slope is used to enhance visualization of erosion in areas of profile convexity and deposition in areas of profile concavity (decreasing flow velocity). The difference of using a slope without the tangent factor in SPI calculations is negligible unless pronounced concave and convex slopes are present in the AOI. The natural log is used to normalize the SPI with a logarithmic scale making for easier analysis along with a bell-shaped histogram. Otherwise, the linear scaled histogram would be heavily right-tail skewed. Slope was also divided by 100 (before calculating its tangent) for the simple reason of having the units match so that the histogram is centered at approximately 0. High SPI values displayed in GIS represent areas on the landscape where high slopes and flow accumulations exist and thus areas where flows can concentrate with erosive potential. For this reason, SPI is very useful for determining potential CSA locations.

CTI is the quotient of both slope and flow accumulation and calculated using the following equation:

\[
CTI = \ln(A / \tan\beta)
\]

Like SPI, CTI is also calculated using the Raster Calculator and 0.001 was again added to both the Flow Accumulation and Percent Slope/100 to avoid dividing by zero values. CTI can show areas on a landscape that pond and store water, and is therefore useful for locating potential wetland locations. Because surface erosion was the focus of this thesis, CTI was only used as a means to create ancillary supporting data. This method to calculate CTI produces results that could be considered noisy since ponded areas were
not isolated from background flow accumulation values. Simple multi low-pass filtering can greatly aid in CTI visualization.

**SPI visualization**

SPI signatures can represent surface overland runoff flow paths and be further visually enhanced with colored symbology to display erosion risk gradients (Figure 22), though before that can occur, SPI layers need to be individually customized. These raster layers are most useful when displayed at a certain percentage of values above a threshold. Achieving this entails removing the majority of cells from being displayed that have low erosion risk. The threshold depends mainly on spatial extent, local topography and overall slopes – there is often a range of percentile values that will represent surface features sufficiently. Common thresholds are typically between the top 15% of values to as high as the top 1% of values. Typically an increasingly higher percentile threshold value is used as the spatial extent that the SPI layer is calculated over becomes smaller, and vice versa, but will vary by location.

Calculating thresholds can become time consuming when processing several SPI layers, so histograms were first used to estimate a rough threshold for removing unwanted values (see APPENDIX A, Visualizing terrain attributes section for specifics). This method has the added benefit of allowing for quick display changes.

![Figure 22. The above images depict how an SPI signature can be visualized as a flow path. The arrows represent flow direction.](image)
CSA identification methods
A certain set of metrics were used to identify and weight CSAs. These concepts are expanded upon in the APPENDIX A, Locate and prioritize potential CSAs section:

1. Hydrologic connection to surface water – reducing sediment in the watershed, especially being delivered into Lake Zumbro was a main driving factor for this research. Without hydrologic connections there is reduced risk of sediment transport to surface water.

2. Signature length and land use – e.g. if a long signature is confined to a forest land class, it would be a lower priority than one of similar length that is located in and agricultural upland field.

3. Upstream catchments were constructed for each potential pour point and average SPI and USLE values were calculated inside each catchment, which allowed sorting based on high to low values.

Depending on prioritization goals, users could then factor in ancillary data, such as feedlots or golf courses, and calculate their distance to each catchment weighted by size of operation or other specifics.

Percentile thresholds
In order to perform statistical percentile analyses, several SPI percentile thresholds were calculated using each SPI study area dataset. These percentile analyses aid in determining the effectiveness of the DTA methods used in this thesis. The SPI visualization in the previous section was taken further by calculating several percentile values using CRAN R statistical software package (CRAN, http://www.r-project.org/). Calculated values ranged from the 80\textsuperscript{th} to 99\textsuperscript{th} percentiles. This range was based primarily on the SPI visualization previously performed. Determining percentiles also has the added benefit of ensuring consistency among study areas for statistical purposes.

Calculating percentile values from large datasets can be intensive work for modern computer processing units; the largest SPI dataset processed for this study had over 10 million cells – each containing floating point values. Dedicated statistical
software will typically allow calculations to be made directly from those large datasets, though programs like Excel have a limit on the amount of records it can load in a single spreadsheet (slightly over 1 million for Excel 2007). APPENDIX A, Determining thresholds section contains step-by-step methods that circumvent these limitations along with other methods to determine percentiles from large datasets, though R was used for this thesis.

**Best fit percentile threshold determination**

During the CSA identification process, it became apparent that terrain analysis users could benefit from a quick and easy threshold determination guide that ensured consistent results for both individual and multiple users. In order to make the threshold determination easy for novice GIS users, the ‘best-fit’ threshold was chosen to be either a simple calculation made using slope and flow accumulation or by using a quick visual process. The latter was selected for its ease of use and suitability for diverse landscapes. This process is described in the results section.

**Field Validation**

Field validation was conducted in the A1 field site on November 18, 2012; A2 on October 15 and 22, 2012; and B2 on June 3, 4 and 16, 2013. The work was conducted with the main goal of recording details of surface erosion features that had a hydrologic connection to surface waters and thus to validate DTA outputs. Another reason for site visits was to familiarize workers with the study area landscape. The top-down map perspective common to GIS users can hold back understanding of the complex details occurring on the ground and it is therefore of particular importance to visit target areas.

Field validation work was accomplished with a Trimble GeoXH GPS unit loaded with TerraSync software⁹; Trimble Tornado antenna attached to a backpack; digital camera; maps with CSA predictions; and tape measure. Field technicians walked along stream corridors where landowner permission was granted and created a point feature in the GPS for each erosional site found. It was also noted when the terrain analysis did not correctly predict CSAs and/or when conservation practices were in place at predicted sites. Feature attributes and comments were entered directly into the Trimble unit based
off the upland assessment template shown in Table 8. This includes the Sediment 
Delivery Potential (SDP) rating created by Kevin Kuehner, a soil scientist with the 
Minnesota Department of Agriculture, as a way for field technicians to numerically 
quantify the condition of erosional features (BNCWQB, 2001). SDP is a subjective score 
ranging from 1 (lowest risk) to 3 (highest risk).

Factors influencing scores include:

- Size and location of the feature in landscape.
- Evidence of active erosion including scouring, head cutting, deposition, and field 
debris.
- Upland land use, condition and contributing area.

The GPS data was post-processed using Pathfinder Office software\(^9\) which 
corrected the points down to sub-meter accuracy (see APPENDIX B for specific 
accuracies).

Only four types\(^10\) of surface erosion were recorded during field validation. 
Identified types included gullies, ravines, side inlets and bank erosion. The definitions 
for gullies and ravines are often similar, so for consistency field technicians identified 
gullies as channels formed from intermittent flow that grow by head cutting action and 
are traversable by tillage equipment, whereas ravines form by similar processes but are 
smaller than a valley/larger than a gully and are not traversable by tillage or farm 
equipment. Side inlets are a form of artificial drainage common along low relief 
agricultural fields that border a drainage ditch. A berm parallel to the ditch is often 
created from ditch cleanings at the edge of field, forming a natural dam where an 
otherwise natural flow path would have existed entering the ditch. A culvert is then 
installed to move that natural overland flow directly off the field. The fourth and final 
feature type identified was bank erosion and slumping. These sites can often show 
evidence of heavy animal use, making them a prime example of a localized CSA because

\(^9\) Trimble Navigation Limited© proprietary software

\(^{10}\) Several are listed in the ‘Feature’ column in Table 8
the increased cattle dung in combination with reduced vegetation cover and increased soil compaction can lead to increased nutrient and sediment runoff (Piechnik, et. al., 2012). It should be noted that several instances of bank erosion and slumping were witnessed by field technicians, though because SPI does not directly identify bank erosion, their details were recorded but not analyzed in the results.
Table 8. Upland field assessment template used to populate the GPS unit’s point attributes.

<table>
<thead>
<tr>
<th>Site ID#</th>
<th>Streambank Location</th>
<th>Discharges to...</th>
<th>Feature</th>
<th>Flow Orientation</th>
<th>Photo #</th>
<th>Land Cover</th>
<th>Tillage Direction</th>
<th>Tile Style</th>
<th>% Crop Residue</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Left bank</td>
<td>Perennial stream</td>
<td>Culvert</td>
<td>N</td>
<td>#</td>
<td>Corn grain</td>
<td>N</td>
<td>Clay</td>
<td>0-15%</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Intermittent stream</td>
<td>Drop structure</td>
<td>NE</td>
<td></td>
<td>Corn silage</td>
<td>NE</td>
<td>Corrugated metal pipe</td>
<td>15-30%</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Grassed waterway</td>
<td>Exposed tile</td>
<td>E</td>
<td></td>
<td>Alfalfa</td>
<td>E</td>
<td>Plastic</td>
<td>&gt;30%</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Other:</td>
<td>Grassed waterway</td>
<td>SE</td>
<td></td>
<td>Wheat</td>
<td>S</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Gully</td>
<td>SW</td>
<td></td>
<td>Pasture</td>
<td>NW</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Open intake</td>
<td>W</td>
<td></td>
<td>Forest</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Ravine</td>
<td>NW</td>
<td></td>
<td>Other:</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Date</td>
<td>Note: while looking downstream</td>
<td></td>
<td>Side inlet</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>(xx/xx/xxxx)</td>
<td></td>
<td></td>
<td>Sinkhole</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Other:</td>
<td>Slumping</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Vegetative Buffer</td>
<td>Buffer Condition</td>
<td>Buffer Width (ft)</td>
<td>Sediment Delivery Potential (1-3)</td>
<td>Feature Width (ft)</td>
<td>Feature Depth (ft)</td>
<td>Feature Length (ft)</td>
<td>Intake Distance (ft)</td>
<td>Intake Size (in)</td>
<td>Tile Size (in)</td>
</tr>
<tr>
<td>Yes</td>
<td>0</td>
<td>1</td>
<td>2</td>
<td>3</td>
<td>4</td>
<td>5</td>
<td>6</td>
<td>7</td>
<td>8</td>
</tr>
<tr>
<td></td>
<td></td>
<td>1</td>
<td>2</td>
<td>3</td>
<td>4</td>
<td>5</td>
<td>6</td>
<td>7</td>
<td>8</td>
</tr>
<tr>
<td>No</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Manure App Evidence</td>
<td>BMP Recommendations</td>
<td>Comments:</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Analysis

Random point comparison
The erosional features identified during field surveys were matched with an equal number of random points in each study area to determine the effectiveness of CSA predictions using digital terrain analysis methods. The placement of random points into stream corridors was made consistent between each study area by means of segmenting stream reaches and using buffers to limit their spatial distribution. The first step was creating a stream polyline for each study area as accurate as possible from available aerial photos and LiDAR DEM layers. These stream lines were then divided into an equal number of parts matching the number of erosional features identified in each respective study area. A buffer was then placed around each stream segment, with the width being determined by the most distant field surveyed point. This ensured that all field points would be included in the buffer and each random point would have the same hydrologic connection proximity as field verified points. Random points were then created using the ‘Create Random Points’ tool in ArcGIS. One random point was placed in each buffer segment. SPI values were then extracted from an SPI layer to each point and compared to field verified point SPI values.

Statistics
The student two sample t-test for independent samples, specifically the Welch two sample (unequal variances) t-test, tests whether two populations have equal means and was used to determine if two sets of independent data, specifically the field verified point SPI values and the random point SPI values, are significantly different from each other. A p-value of 0.05 or less would show with 95% confidence that there are significant differences between the field and random means, and therefore would show that the SPI values of points with erosional features that have been field verified are significantly different than the SPI values of points placed at random. In other words it would show that high SPI values associate with erosional features in the field and are not high by chance.
The Wilcoxon rank sum test was also used alongside the student t-test as a non-parametric equivalent alternative to test whether the population mean ranks differ when given a more conservative evaluation by not assuming the populations are normally distributed. The test is the non-parametric equivalent of the student t-test. As a non-parametric test, it does not make assumptions about the probability distributions of the variables being assessed, unlike the student t-test, making it a more conservative method of testing variance.

**Percentile analysis**
Percentile analyses were conducted for each study area to determine if correlation existed between SPI and SDP values, and to assist in determining best fit thresholds. Average rank percentiles were calculated for each study area by importing both the dBase file associated with the SPI rasters and the field point output files from the *Extract Values to Points* ArcGIS tool into R statistics software (CRAN). Interpolation was used by the *Extract Values to Points* tool, which calculates SPI cell values from adjacent cells using bilinear interpolation.

**Statistics**
The one-way analysis of variance model (ANOVA) was used to analyze SPI and SDP values in order to test whether the SPI values in each SDP group were significantly different from each other. Specifically, the variation of the mean SPI value of field points in each SDP group was compared among and between the three SDP groups. A p-value of 0.05 or less would show with 95% confidence that there was significant difference in the variance of means between the three groups. A piecewise comparison of means was also used to help identify which, if any, group or groups were significantly different by using Tukey’s test.

The Kruskal-Wallis rank sum test was also used, which tests for whether samples originate from the same distribution. It is used for comparing two or more independent samples of equal or different sample sizes and is the non-parametric equivalent of the ANOVA test. As a non-parametric test, it does not make assumptions about the
probability distributions of the variables being assessed, unlike the ANOVA test, making it a more conservative method of testing variance.

**Validation analysis**

A validation analysis was conducted to assess the validity of the field work by presenting the existence of both commission and omission errors. DTA CSA predictions are typically incorrect for the following reasons:

- Omission errors (found erosion but no predicted CSA) are usually due to using a percentile threshold that is too high, but could also be due to changes occurring between LiDAR acquisition and ground truthing.
- Commission errors (predicted CSA point but no erosion) are usually a result of using a percentile threshold that is too low, but could also be due to changes occurring between LiDAR acquisition and ground truthing, or because site visit occurred after feature was tilled or covered up. Conservation practices existing where a CSA prediction was made should be noted as such to avoid classifying them as commission errors.

As commission errors increase, omission errors decrease, and vice versa. Commission errors are due to placing too many predicted CSA points which will result in fewer omission errors. Though seemingly beneficial, this will increase time validating points in field and/or filtering down predicted points to better align with project limitations.
RESULTS

Random Point Comparison

A random point comparison was made for the three study areas by comparing the SPI values of field verified erosional features to SPI values at randomly generated points within stream corridors. Mean values were found to be significantly different between the field and random points for each individual study area\textsuperscript{11} at a 0.95 significance level (Figure 23). See Appendix B for random point comparison statistical output results.

---

\textsuperscript{11} See Statistics section.

---

Figure 23. Box plot showing stream power index value comparison between random and field verified points. A1 headwaters site, A2 Rochester plateau region, and B2 blufflands. The color coordinated points represent outliers in the data.
Statistics

Each p-value generated from the Welch two sample t-test and Wilcoxon rank sum test were all considerably smaller than .05, leading to rejection of the null hypotheses that there is not a significant difference between field and random SPI values. Therefore, there is a strong correlation between high SPI values and erosional features identified in the field, making SPI signatures a good means of locating erosional features. See APPENDIX B for continued discussion and statistical software outputs.

Percentile Analysis

Percentile analysis results show that mean SPI values tend to increase as the SDP increases and their relationship is considerably variable both within and among the three study areas. Minimum SPI values for a given SDP class are lowest with SDP 1 features, medium for SDP 2 features and highest for SDP 3 features.

Results show that SDP field assessments were less accurate in differentiating between SDP 1 and 2 features in B2, likely due to increased relief topography with numerous ravines and side channels.

Field-surveyed erosional features in the combined three study areas had an average SPI value equal to the 97th percentile. The data show an increasing trend but not a significant correlation between SPI and SDP values12; therefore SDPs cannot be predicted based solely on SPI values in these study areas. The influence of small SDP 1 features likely create considerable variance in the data, as they can occur throughout the range of SPI values. Also, the inherent variation involved in evaluating SDP values in the field complicates the results. For instance, SDP values in areas with ravines versus areas without, or gullies in blufflands versus flat artificially drained areas; these differences in erosional feature magnitude tend to add certain variability.

---

12 See fit of analysis of variance test results in Statistics section.
**A1 percentile analysis**

Study area A1 has a mean slope of 1.94%\textsuperscript{13}, this includes ditch and road banks, which had the steepest slopes from 40-60% rise (ditches).

Average 3m SPI value percentile for 27 erosional features in the A1 watershed is 99.4% (Table 9). The weighted mean factors in number of features to the calculation. Figure 24 shows the cumulative distribution for all the 3x3 meter SPI values in the A1 field site catchment along with mean percentiles for each SDP value grouping and their individual locations along the cumulative plot. When SDP 1 sites are removed, there is a clear association between SPI and SDP magnitudes, with SDP magnitude increasing with SPI value.

<table>
<thead>
<tr>
<th>SDP value of erosional features</th>
<th>Percentile values</th>
<th>Number of features</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Minimum</td>
<td>Maximum</td>
</tr>
<tr>
<td>1 (Low)</td>
<td>42.34</td>
<td>100</td>
</tr>
<tr>
<td>2 (Medium)</td>
<td>66.03</td>
<td>100</td>
</tr>
<tr>
<td>3 (High)</td>
<td>99.85</td>
<td>100</td>
</tr>
<tr>
<td>Mean</td>
<td>69.4</td>
<td>100</td>
</tr>
<tr>
<td>Weighted Mean</td>
<td>61.9</td>
<td>100</td>
</tr>
</tbody>
</table>

**A2 percentile analysis**

Study area A2 has a mean slope of 6.63% with slopes ranging from 0-76% rise.

Average rank percentile of 3m stream power index (SPI) for 58 erosional features in the A2 watershed is 94.1% (Table 10). The weighted mean factors in number of features to the calculation. Figure 25 shows the cumulative distribution for all the 3x3 meter SPI values in the A1 field site catchment along with mean percentiles for each SDP value grouping and their individual locations along the cumulative plot.

\textsuperscript{13} Due to field site lying over two different counties, two different slopes were calculated from each LiDAR data set. The results were: 1.92% LiDAR Dodge Co. side; 1.97% LiDAR Steele Co. side.
Table 10. Percentile analysis for field site A2.

<table>
<thead>
<tr>
<th>SDP value of erosional features</th>
<th>Percentile values</th>
<th>Number of features</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Minimum</td>
<td>Maximum</td>
</tr>
<tr>
<td>1 (Low)</td>
<td>8.63</td>
<td>99.32</td>
</tr>
<tr>
<td>2 (Medium)</td>
<td>64.21</td>
<td>98.4</td>
</tr>
<tr>
<td>3 (High)</td>
<td>90.82</td>
<td>98.2</td>
</tr>
<tr>
<td>Mean</td>
<td>54.6</td>
<td>98.6</td>
</tr>
<tr>
<td>Weighted Mean</td>
<td>29.6</td>
<td>99.0</td>
</tr>
</tbody>
</table>

B2 percentile analysis

Study area B2’s mean slope is 7.28%, with slopes ranging from 0-451% rise. The slope percents from 200 on up were confined to a small gravel pit.

Average rank percentile of 3m stream power index (SPI) for 34 erosional features in the B2 watershed is 98.2% (Table 11). The weighted mean factors in number of features to the calculation. The mean percentile values break with trends of previous field sites and what would be expected which is for the value to increase with increasing SDP value. Figure 26 shows the cumulative distribution for all the 3x3 meter SPI values in the A1 field site catchment along with mean percentiles for each SDP value grouping and their individual locations along the cumulative plot. Three prominent erosional features classified in field as SDP2s are shown to have low SPI values in the figure, potentially showing ranking errors by field technicians.

Table 11. Percentile analysis for field site B2.

<table>
<thead>
<tr>
<th>SDP value of erosional features</th>
<th>Percentile values</th>
<th>Number of features</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Minimum</td>
<td>Maximum</td>
</tr>
<tr>
<td>1 (Low)</td>
<td>81.91</td>
<td>99.94</td>
</tr>
<tr>
<td>2 (Medium)</td>
<td>18.00</td>
<td>99.79</td>
</tr>
<tr>
<td>3 (High)</td>
<td>98.36</td>
<td>99.97</td>
</tr>
<tr>
<td>Mean</td>
<td>66.1</td>
<td>99.9</td>
</tr>
<tr>
<td>Weighted Mean</td>
<td>49.5</td>
<td>99.9</td>
</tr>
</tbody>
</table>
Figure 24. Cumulative distribution of all stream power index values with field verified points for field site A1.
Figure 25. Cumulative distribution of all stream power index values with field verified points for field site A2.
Figure 26. Cumulative distribution of all stream power index values with field verified points for field site B2.
Statistics

Each p-value generated from the ANOVA and Kruskal-Wallis rank sum tests was larger than .05, leading to acceptance of the null hypotheses that there was not a significant difference between SPI and SDP values, therefore it cannot be said that identifying erosion features with the highest SPI values will correspond to having the highest SDP values, and vice versa. There was no correlation between SPI and SDP values beyond an increasing trend. Figure 27 illustrates the increasing trends visually using boxplots and APPENDIX B expands on this discussion with statistical output results.

![Figure 27. Comparison of distribution between SPI values and SDP values at field verified points.](image-url)
Validation Results

**A1 validation results**

Study area A1 had a total of 35 erosional features that were identified in the field.

Eight of 35 (23%) field surveyed points were not closely related to an SPI signature (errors of omission). Four of these points had SDPs of 1 (lowest risk) and four had SDPs of 2 (medium risk). All features with SDP values of 3 (highest risk) were identified using DTA.

Nine out of the 36 (25%) total CSA prediction points in the study area were not closely related to an erosional feature during the field survey; known as commission errors or false positives. The commission errors are predicted CSA that were not closely associated with a field surveyed erosional feature.

The ‘Total’ row in Table 12 shows that of the 35 features identified, 27 (77%) were closely associated with an SPI signature from GIS terrain analysis, and 8 were not (omission errors).

<table>
<thead>
<tr>
<th>SDP value</th>
<th>Correctly predicted</th>
<th>Incorrectly predicted</th>
<th>Total identified</th>
<th>Accuracy (%)</th>
<th>Commission errors</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 (Low)</td>
<td>9</td>
<td>4</td>
<td>13</td>
<td>69%</td>
<td>N/A</td>
</tr>
<tr>
<td>2 (Medium)</td>
<td>15</td>
<td>4</td>
<td>19</td>
<td>79%</td>
<td>N/A</td>
</tr>
<tr>
<td>3 (High)</td>
<td>3</td>
<td>0</td>
<td>3</td>
<td>100%</td>
<td>N/A</td>
</tr>
<tr>
<td><strong>Total</strong></td>
<td><strong>27</strong></td>
<td><strong>8</strong></td>
<td><strong>35</strong></td>
<td><strong>77%</strong></td>
<td>9 of 36 pts (25%)</td>
</tr>
<tr>
<td><strong>Total %</strong></td>
<td><strong>77%</strong></td>
<td><strong>23%</strong></td>
<td><strong>100%</strong></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Table 12. Field site A1 validation results. Each validation table shows comparisons between the sediment delivery potential (SDP) of erosional features identified or not identified in each study areas using the GIS–based validation survey technique with best-fit user thresholds.
**A2 validation results**

There were a total of 78 erosional features that were identified in study area A2.

Fourteen of 78 (18%) field surveyed points were not closely related to an SPI signature (errors of omission). Ten of these points had SDPs of 1 (lowest risk) and four had SDPs of 2 (medium risk). All features with SDP values of 3 (highest risk) were identified using DTA.

Forty of the 127 (31%) total CSA prediction points in the study area were not closely related to an erosional feature during the field survey; known as commission errors or false positives. The commission errors are predicted CSA that were not closely associated with a field surveyed erosional feature.

The ‘Total’ row in Table 13 shows that of the 78 features identified, 64 (82%) were closely associated with an SPI signature from GIS terrain analysis, and 14 were not (omission errors).

<table>
<thead>
<tr>
<th>SDP value</th>
<th>Correctly predicted</th>
<th>Incorrectly predicted</th>
<th>Total identified</th>
<th>Accuracy (%)</th>
<th>Commission errors</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 (Low)</td>
<td>45</td>
<td>10</td>
<td>55</td>
<td>82%</td>
<td>N/A</td>
</tr>
<tr>
<td>2 (Medium)</td>
<td>14</td>
<td>4</td>
<td>18</td>
<td>78%</td>
<td>N/A</td>
</tr>
<tr>
<td>3 (High)</td>
<td>5</td>
<td>0</td>
<td>5</td>
<td>100%</td>
<td>N/A</td>
</tr>
<tr>
<td><strong>Total</strong></td>
<td><strong>64</strong></td>
<td><strong>14</strong></td>
<td><strong>78</strong></td>
<td><strong>82%</strong></td>
<td>40 of 127 pts (31%)</td>
</tr>
<tr>
<td><strong>Total %</strong></td>
<td><strong>82%</strong></td>
<td><strong>18%</strong></td>
<td><strong>100%</strong></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
B2 validation results

Study area B2 had a total of 34 erosional features that were identified in the field.

Four of 34 (12%) field surveyed points were not closely related to an SPI signature (errors of omission). One of these points had SDPs of 1 (lowest risk) and three had SDPs of 2 (medium risk). All features with SDP values of 3 (highest risk) were identified using DTA.

Twelve of the 34 (35%) total CSA prediction points in the study area were not closely related to an erosional feature during the field survey; known as commission errors or false positives. The commission errors are predicted CSA that were not closely associated with a field surveyed erosional feature.

The ‘Total’ row shows that of the 34 features identified, 30 (88%) were closely associated with an SPI signature from GIS terrain analysis, and 4 were not (omission errors).

Table 14. Field site B2 validation results.

<table>
<thead>
<tr>
<th>SDP value</th>
<th>Correctly predicted</th>
<th>Incorrectly predicted</th>
<th>Total identified</th>
<th>Accuracy (%)</th>
<th>Commission errors</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 (Low)</td>
<td>12</td>
<td>1</td>
<td>13</td>
<td>92%</td>
<td>N/A</td>
</tr>
<tr>
<td>2 (Medium)</td>
<td>15</td>
<td>3</td>
<td>18</td>
<td>83%</td>
<td>N/A</td>
</tr>
<tr>
<td>3 (High)</td>
<td>3</td>
<td>0</td>
<td>3</td>
<td>100%</td>
<td>N/A</td>
</tr>
<tr>
<td>Total</td>
<td>30</td>
<td>4</td>
<td>34</td>
<td>88%</td>
<td>12 of 34 pts (35%)</td>
</tr>
<tr>
<td>Total %</td>
<td>88%</td>
<td>12%</td>
<td>100%</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
**Best Fit Thresholds**

The benefits of having an intuitive way of quickly determining best fit thresholds was recognized early while using DTA methods to locate CSAs. Attempts were made to find a strong relationship between flow accumulation, slope, and area in order to create a simple calculation that would offer users a range of best-fitting threshold values that aligned with their goals. This simple calculation/algorithm method proved difficult because of the large number of factors in play. For example, how dense a network of CSA points users want to identify is directly related to the density of the SPI network, which is set by the SPI threshold. Another difficulty lay in the available terrain attributes; particularly slope and flow accumulation. The physical surface area of any given area of interest is rarely constant, and average values of both slope and flow accumulation are dependent on surface area, making correlations difficult.

Terrain attributes calculated for an area should be compared relative to one another within an area of interest; they do not represent static values that correspond to a specific runoff volume or pollutant loading rate. Thresholds are used in order to compare the attributes in relative terms. Since each landscape has unique characteristics, it is not suggested to apply static threshold values to terrain attributes.

Each SPI raster created over a variable area and displayed in GIS is very user specific and thus it is only possible to give a broad range of “best” threshold values to use. No one threshold can better predict the occurrence and length of ephemeral gullies, and therefore individual calibration of the SPI threshold is needed for each application site (Daggupati, 2012). Again, the threshold used depends on project goals, available resources, and the physical characteristics of the area of interest – primarily its overall relief. For instance, some users may want to identify every potential CSA in a very small area where lower thresholds would be appropriate; some may only wish to identify the biggest potential sediment sources throughout an expansive area where lower thresholds would introduce unnecessary clutter.

The algorithm method was abandoned due to the variability involved with SPI calculations. SPI percentile threshold calculations are dependent on area and the amount
of DEM pre-processing and hydrologic conditioning performed. The area parameter itself is not as limiting as pre-processing parameters, as it could be held constant for a temporary test-site threshold calculation, but it is impossible to predict the types and amounts of pre-processing to be used, and their effects on the DEM and subsequent SPI. For instance, pit filling pre-processing can introduce continuous SPI signatures in-channel, essentially analogous to the stream flow. These signatures in stream channels will typically contain the highest SPI values in the output layer and they will significantly skew threshold calculations. There are ways to remove SPI signatures from main channels, though it requires some convoluted steps along with heads-up digitization which can become progressively time consuming as areas and stream densities increase. It was therefore not feasible to design an algorithm or tool that could automatically suggest a threshold based on a given SPI layer.

After trial and error it was decided that the ideal way to determine the best fit threshold value for a given area of interest was to use a visual process which involves overlaying an SPI raster layer on top of recently acquired high-resolution orthophotography, then manually increasing the SPI’s threshold until a good representation of the flow was witnessed between the two layers (Figure 28). Landscape features to look for when matching flow between the SPIs and orthophotos include visible erosional features and areas of concentrated flow. Grassed waterways also make useful features to align SPI signatures to, as they often exist along concentrated flows paths that, without them, would have led to surface erosion. These features are most evident in spring leaf-off aerial photos that were captured shortly after spring snowmelt, but before in-field farm operations (Figure 29). For an expanded discussion on visually determining best-fit thresholds, see APPENDIX A, in the sections on “Visualizing terrain attributes” and “Locate and prioritize potential CSAs sections.”
Figure 28. Rough method used to determine SPI thresholds. If the SPI signatures looked too crowded or dense (example 1), the threshold value was increased incrementally by shifting the break line further toward the right tail of the histogram until display results were satisfactory and vice versa for sparse SPI populations (example 2).
Figure 29. Spring-time acquired leaf-off imagery (top photo) clearly showing overland flow paths that can be used to match SPI signatures when establishing thresholds (bottom photo).
Conclusions
The results show that DTA SPI layers are effective at not only identify erosional features, but the erosional features with the highest potential for delivering sediment to surface waters, also known as CSAs. Digital terrain analysis methods were shown to predict field erosional features at an accuracy ranging between 77 to 88% in the ZRW. Flat to low sloping terrain similar to the ~2% average catchment slope in the A1 headlands field site showed less accurate predictions when compared to sites A2 and B2 where average slopes that were 3x steeper. Because field validation was limited to observations gathered during one year’s season, a long term study with field inspections over several growing seasons would be needed to make a better informed analysis of DTA prediction accuracies.

Current SPI limitations include lack of subsurface flow considerations and the possibility that very low relief areas may not be accurately described. The former could hinder analysis accuracy in areas dominated by subsurface flows, such as forest and karst regions, and the latter is mostly the result of low DEM resolutions. Combining high resolution terrain analysis with tools that consider subsurface flows could eliminate these limitations, as could the inclusion of hydrologic conductivity as a denominator in the SPI calculation. SPI was also shown to have weak correlation to SDP values, particularly in the SDP1 group, meaning that SPI values themselves would likely be ineffective at directly determining the sediment delivery potential of erosional features, though the visualization and threshold fitting processes used to locate potential CSAs was shown to overcome this limitation by allowing users to rank and prioritize CSAs.
FIELD-SCALE CONSERVATION PRACTICE TARGETING AND RECOMMENDATIONS

Recent advances in precision conservation have led to rethinking the way Best Management Practices (BMPs) are selected for a particular site, with a growing emphasis on big picture benefits rather than spending resources for localized improvements that may not address a given landscape’s largest sources of pollution. Identifying CSAs and targeting those areas for BMP implementation help ensure the largest sources are being accounted for.

Following the CSA identification methods presented in the Digital Terrain Analysis Manual (APPENDIX A), BMP suitability should be carefully considered as the first step in the implementation process. Agroecoregions, as described in the APPENDIX A – Case Studies section, group physical landscape characteristics, making their use a good starting point for choosing regional conservation practice suitability. County-level location may also influence BMP selection, as conservation districts may have a list of suitable practices established from combinations of landowner equipment and trends, available program funds, cost/benefit analyses, and minimizing the amount of land taken out of production, among others.

A sediment reduction-based BMP suitability by agroecoregion table was created for several agroecoregions found in the Minnesota River Basin (Table 15) for the purpose of informing the upland field survey data sheet (see APPENDIX A – Field Assessment Manual section). The table was originally based off a statewide Minnesota Phosphorus Index study conducted by UMN researches, though was modified here to include regions located in the ZRW, along with applicable NRCS conservation practices, and was populated with input from district conservationists and NRCS staff throughout the ZRW. A similar series of tables were created for the ZRW in 2008 by NRCS and SWCD staff using Cooperative Conservation Partnership Initiative Farm Bill funds to document general resource concerns and conservation needs at the HUC8 watershed scale (Table 16). The rapid watershed assessment tables provides conservation practice cost estimates and effectiveness for reducing specific resource concerns for cropland, pasture, and forest.
land use/cover. The reduction effectiveness rating is based on both benchmark conditions and degree of change in conditions by conservation system(s) application. It is represented by a numerical value rated from -5 (most damaging to resources) to 5 (best protection offered by treatment).

Table 15. Best management practice suitability by agroecoregion showing the most common NRCS conservation practices (CP) on left ranked from low (L) to highly (H) suitable.

<table>
<thead>
<tr>
<th>NRCS CP#</th>
<th>Sediment Reduction Conservation Practices</th>
<th>Rochester Plateau</th>
<th>Blufflands</th>
<th>Undulating Plains</th>
<th>Level Plains</th>
<th>Rolling Moraine</th>
<th>Steeper Alluvium</th>
<th>Alluvium &amp; Outwash</th>
</tr>
</thead>
<tbody>
<tr>
<td>328</td>
<td>Conservation Crop Rotation</td>
<td>H</td>
<td>H</td>
<td>M</td>
<td>M</td>
<td>M</td>
<td>M</td>
<td>M</td>
</tr>
<tr>
<td>329</td>
<td>Conservation Tillage</td>
<td>H</td>
<td>H</td>
<td>H</td>
<td>H</td>
<td>M</td>
<td>M</td>
<td>M</td>
</tr>
<tr>
<td>332</td>
<td>Contour Buffer Strip</td>
<td>H</td>
<td>H</td>
<td>M</td>
<td>L</td>
<td>H</td>
<td>M</td>
<td>M</td>
</tr>
<tr>
<td>330</td>
<td>Contour Farming</td>
<td>H</td>
<td>H</td>
<td>M</td>
<td>L</td>
<td>H</td>
<td>M</td>
<td>M</td>
</tr>
<tr>
<td>340</td>
<td>Cover Crop</td>
<td>H</td>
<td>H</td>
<td>H</td>
<td>H</td>
<td>H</td>
<td>M</td>
<td>M</td>
</tr>
<tr>
<td>342</td>
<td>Critical Area Planting</td>
<td>M</td>
<td>M</td>
<td>M</td>
<td>M</td>
<td>M</td>
<td>M</td>
<td>M</td>
</tr>
<tr>
<td>362</td>
<td>Diversion</td>
<td>L</td>
<td>L</td>
<td>L</td>
<td>L</td>
<td>L</td>
<td>L</td>
<td>M</td>
</tr>
<tr>
<td>386</td>
<td>Field Border</td>
<td>H</td>
<td>H</td>
<td>H</td>
<td>H</td>
<td>M</td>
<td>M</td>
<td>M</td>
</tr>
<tr>
<td>410</td>
<td>Grade Stabilization Structure</td>
<td>H</td>
<td>H</td>
<td>M</td>
<td>L</td>
<td>M</td>
<td>M</td>
<td>M</td>
</tr>
<tr>
<td></td>
<td>- Grass Cover (CRP only)</td>
<td>H</td>
<td>H</td>
<td>H</td>
<td>H</td>
<td>H</td>
<td>H</td>
<td>M</td>
</tr>
<tr>
<td>393</td>
<td>Grass Filter Strip</td>
<td>H</td>
<td>H</td>
<td>H</td>
<td>H</td>
<td>H</td>
<td>H</td>
<td>H</td>
</tr>
<tr>
<td>412</td>
<td>Grass Waterway</td>
<td>H</td>
<td>H</td>
<td>H</td>
<td>H</td>
<td>H</td>
<td>H</td>
<td>H</td>
</tr>
<tr>
<td>590</td>
<td>Nutrient Management</td>
<td>L</td>
<td>L</td>
<td>L</td>
<td>L</td>
<td>L</td>
<td>L</td>
<td>L</td>
</tr>
<tr>
<td>512</td>
<td>Pasture &amp; Hayland Planting</td>
<td>M</td>
<td>M</td>
<td>M</td>
<td>M</td>
<td>M</td>
<td>M</td>
<td>M</td>
</tr>
<tr>
<td>378</td>
<td>Pond</td>
<td>M</td>
<td>M</td>
<td>L</td>
<td>L</td>
<td>L</td>
<td>M</td>
<td>M</td>
</tr>
<tr>
<td>528A</td>
<td>Prescribed Grazing</td>
<td>M</td>
<td>M</td>
<td>M</td>
<td>M</td>
<td>M</td>
<td>M</td>
<td>M</td>
</tr>
<tr>
<td>350</td>
<td>Sediment Basin</td>
<td>H</td>
<td>H</td>
<td>M</td>
<td>M</td>
<td>M</td>
<td>M</td>
<td>M</td>
</tr>
<tr>
<td>725</td>
<td>Sinkhole Treatment</td>
<td>H</td>
<td>H</td>
<td>M</td>
<td>L</td>
<td>L</td>
<td>L</td>
<td>L</td>
</tr>
<tr>
<td>580</td>
<td>Streambank &amp; Shoreline Protection</td>
<td>H</td>
<td>H</td>
<td>H</td>
<td>H</td>
<td>H</td>
<td>H</td>
<td>H</td>
</tr>
<tr>
<td>585</td>
<td>Stripcropping</td>
<td>M</td>
<td>M</td>
<td>M</td>
<td>L</td>
<td>M</td>
<td>L</td>
<td>L</td>
</tr>
<tr>
<td>600</td>
<td>Terrace</td>
<td>H</td>
<td>H</td>
<td>M</td>
<td>L</td>
<td>M</td>
<td>M</td>
<td>M</td>
</tr>
<tr>
<td>645</td>
<td>Upland Wildlife Habitat Management</td>
<td>M</td>
<td>M</td>
<td>M</td>
<td>M</td>
<td>M</td>
<td>M</td>
<td>M</td>
</tr>
<tr>
<td>382 / 472</td>
<td>Use Exclusion / Fencing</td>
<td>M</td>
<td>M</td>
<td>L</td>
<td>M</td>
<td>H</td>
<td>H</td>
<td>H</td>
</tr>
<tr>
<td>638</td>
<td>Water and Sediment Control Basin</td>
<td>H</td>
<td>H</td>
<td>H</td>
<td>H</td>
<td>H</td>
<td>H</td>
<td>H</td>
</tr>
<tr>
<td>614</td>
<td>Watering Facility</td>
<td>L</td>
<td>L</td>
<td>M</td>
<td>M</td>
<td>M</td>
<td>L</td>
<td>L</td>
</tr>
<tr>
<td>657</td>
<td>Wetland Restoration</td>
<td>L</td>
<td>L</td>
<td>M</td>
<td>M</td>
<td>M</td>
<td>L</td>
<td>M</td>
</tr>
</tbody>
</table>
Table 16. Rapid watershed assessment for the Zumbro River Watershed row crop land use. Courtesy of USDA-NRCS.

<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Contour Buffer Strips (ac.) 332</td>
<td>332</td>
<td>Ac</td>
<td>$157.22</td>
<td>10</td>
<td>0.02</td>
<td>$314.35</td>
<td>4</td>
<td>3</td>
<td>3</td>
<td>3</td>
</tr>
<tr>
<td>Contour Farming (ac.) 330</td>
<td>330</td>
<td>Ac</td>
<td>$7.00</td>
<td>1</td>
<td>0.00</td>
<td>$7.00</td>
<td>3</td>
<td>3</td>
<td>3</td>
<td>3</td>
</tr>
<tr>
<td>Cover Crop (ac.) 340</td>
<td>340</td>
<td>Ac</td>
<td>$48.44</td>
<td>1</td>
<td>0.01</td>
<td>$48.92</td>
<td>4</td>
<td>3</td>
<td>3</td>
<td>3</td>
</tr>
<tr>
<td>Critical Area Planting (ac.) 242</td>
<td>242</td>
<td>Ac</td>
<td>$180.00</td>
<td>10</td>
<td>0.03</td>
<td>$209.72</td>
<td>5</td>
<td>5</td>
<td>3</td>
<td>3</td>
</tr>
<tr>
<td>Field Border (ft.) 586</td>
<td>586</td>
<td>Ft</td>
<td>$0.08</td>
<td>10</td>
<td>0.01</td>
<td>$0.80</td>
<td>3</td>
<td>3</td>
<td>2</td>
<td>3</td>
</tr>
<tr>
<td>Filter Strip (ac.) 393</td>
<td>393</td>
<td>Ac</td>
<td>$77.80</td>
<td>10</td>
<td>0.02</td>
<td>$171.60</td>
<td>2</td>
<td>0</td>
<td>4</td>
<td>4</td>
</tr>
<tr>
<td>Grade Stabilization Structure (no.) 410</td>
<td>410</td>
<td>No</td>
<td>$19.000.00</td>
<td>10</td>
<td>0.01</td>
<td>$209.27</td>
<td>0</td>
<td>4</td>
<td>0</td>
<td>3</td>
</tr>
<tr>
<td>Grassed Waterway (ac.) 412</td>
<td>412</td>
<td>Ac</td>
<td>$189.58</td>
<td>10</td>
<td>0.02</td>
<td>$209.81</td>
<td>0</td>
<td>2</td>
<td>2</td>
<td>4</td>
</tr>
<tr>
<td>Nutrient Management (ac.) 590</td>
<td>590</td>
<td>Ac</td>
<td>$5.50</td>
<td>1</td>
<td>0.00</td>
<td>$5.50</td>
<td>1</td>
<td>1</td>
<td>5</td>
<td>0</td>
</tr>
<tr>
<td>Pest Management (ac.) 595</td>
<td>595</td>
<td>Ac</td>
<td>$5.50</td>
<td>1</td>
<td>0.00</td>
<td>$5.50</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Residue and Tillage Management, Mulch Till (ac.) 329/B</td>
<td>329B</td>
<td>Ac</td>
<td>$15.00</td>
<td>1</td>
<td>0.00</td>
<td>$15.00</td>
<td>4</td>
<td>2</td>
<td>3</td>
<td>3</td>
</tr>
<tr>
<td>Residue Management, No-Till Strip Till Direct Seed (ac.) 229A</td>
<td>229A</td>
<td>Ac</td>
<td>$30.00</td>
<td>1</td>
<td>0.00</td>
<td>$30.00</td>
<td>5</td>
<td>3</td>
<td>3</td>
<td>3</td>
</tr>
<tr>
<td>Restoration and Management of Declining Habitats (ac.) 643</td>
<td>643</td>
<td>Ac</td>
<td>$778.73</td>
<td>15</td>
<td>0.01</td>
<td>$883.77</td>
<td>3</td>
<td>3</td>
<td>2</td>
<td>2</td>
</tr>
<tr>
<td>Riparian Forest Buffer (ac.) 391</td>
<td>391</td>
<td>Ac</td>
<td>$414.04</td>
<td>15</td>
<td>0.01</td>
<td>$414.04</td>
<td>1</td>
<td>0</td>
<td>2</td>
<td>2</td>
</tr>
<tr>
<td>Streambank &amp; Shoreline Protection (ft.) 380</td>
<td>380</td>
<td>Ft</td>
<td>$335.00</td>
<td>10</td>
<td>0.10</td>
<td>$393.50</td>
<td>0</td>
<td>2</td>
<td>1</td>
<td>4</td>
</tr>
<tr>
<td>Stripcropping (ac.) 585</td>
<td>585</td>
<td>Ac</td>
<td>$50.00</td>
<td>5</td>
<td>0.01</td>
<td>$255.05</td>
<td>4</td>
<td>2</td>
<td>1</td>
<td>3</td>
</tr>
<tr>
<td>Subsurface Drain (ft.) 656</td>
<td>656</td>
<td>Ft</td>
<td>$9.00</td>
<td>30</td>
<td>0.03</td>
<td>$270.00</td>
<td>2</td>
<td>2</td>
<td>-2</td>
<td>1</td>
</tr>
<tr>
<td>Terrace (ft.) 600</td>
<td>600</td>
<td>Ft</td>
<td>$3.50</td>
<td>10</td>
<td>0.00</td>
<td>$35.00</td>
<td>3</td>
<td>3</td>
<td>2</td>
<td>2</td>
</tr>
<tr>
<td>Underground Outlet (ft.) 620</td>
<td>620</td>
<td>Ft</td>
<td>$40.54</td>
<td>10</td>
<td>0.03</td>
<td>$405.40</td>
<td>3</td>
<td>3</td>
<td>3</td>
<td>1</td>
</tr>
<tr>
<td>Upland Wildlife Habitat Management (ac.) 645</td>
<td>645</td>
<td>Ac</td>
<td>$196.70</td>
<td>3</td>
<td>0.00</td>
<td>$727.73</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Waste Utilization (ac.) 633</td>
<td>633</td>
<td>Ac</td>
<td>$15.00</td>
<td>1</td>
<td>0.00</td>
<td>$15.00</td>
<td>1</td>
<td>0</td>
<td>3</td>
<td>2</td>
</tr>
<tr>
<td>Water &amp; Sediment Control Basin (ac.) 658</td>
<td>658</td>
<td>No</td>
<td>$6,000.00</td>
<td>10</td>
<td>0.03</td>
<td>$657.00</td>
<td>1</td>
<td>4</td>
<td>3</td>
<td>3</td>
</tr>
<tr>
<td>Well Decommissioning (ac.) 251</td>
<td>251</td>
<td>No</td>
<td>$885.00</td>
<td>10</td>
<td>0.00</td>
<td>$885.00</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Wetland Restoration (ac.) 657</td>
<td>657</td>
<td>Ac</td>
<td>$6,000.00</td>
<td>15</td>
<td>0.01</td>
<td>$638.05</td>
<td>2</td>
<td>2</td>
<td>1</td>
<td>3</td>
</tr>
</tbody>
</table>

REFERENCES


Basso, B. 2005 Digital terrain analysis: data source, resolution and applications for modeling physical processes in agroecosystems. Rivista Italiana di Agrometeorologia. 5-14 (2) 2005


Horton, R.E. 1933. The Role of Infiltration in the Hydrologic Cycle. Transaction of the American Geophysical Union. 14: 446-460


Vakhtin, B. 1930. On the determination of mathematical characteristics of topography. Geodezist. No. 2-3: 7-16

Vendrusculo, L.G. and A.L. Kaleita. 2013. Terrain analysis and data mining techniques applied to location of classic gully in a watershed. Iowa State University Digital Repository: Agricultural and Biosystems Engineering. ASABE meeting presentation paper #131619828


APPENDIX A

2014 Digital terrain analysis technical manual
The following report – titled the Zumbro River Watershed Restoration Prioritization & Sediment Reduction Project – was finalized and submitted in 2014 and contains a detailed technical manual for GIS users of all levels to conduct digital terrain analyses, create stream power indices, and locate and prioritize critical source areas. The report also contains field assessment guides and several case studies from within and outside the ZRW. It was written by myself, with Jim Klang (Keiser & Associates) and Greg Wilson (BARR Engineering) contributing to the Field Assessment Manual section.
Final Project Report

Zumbro River Watershed Restoration Prioritization & Sediment Reduction Project
This document has been prepared in partial fulfillment of the Legislative-Citizen Commission on Minnesota Resources (LCCMR) Environment and Natural Resources Trust Fund with work plan approved 6/23/2011. A multifaceted team led by the Zumbro Watershed Partnership was assembled to identify and prioritize areas in the Zumbro River Watershed that are critical for restoring and protecting water quality. Team members consisted of Barr Engineering, University of Minnesota, and various Soil & Water Conservation District (SWCD) staff throughout the Zumbro River.

Cover photo courtesy of USDA NRCS Photo Gallery http://photogallery.nrcs.usda.gov/

All other photos/maps courtesy of UMN, ESRI® ArcGIS, MNGeo, and FSA NAIP
Report Overview

This document provides digital terrain analysis methods and procedures for creating Critical Source Area (CSA) predictions in association with the Zumbro River Watershed Restoration Prioritization and Sediment Reduction project. It is to be used in conjunction with the Field Assessment manuals. Digital terrain analysis is the preferred method for locating CSA’s due to its efficiency and high-quality, readily accessible input data. It has been the focus of several recent studies in Minnesota with overall accuracies ranging from 78-88% (see Appendix section A.1 for details). The project is seeking to determine the feasibility of using existing LiDAR and other GIS data to identify and rank a list of CSAs throughout the Zumbro River Watershed. The top 50 ranked sites from the list will then be targeted for Best Management Practice (BMPs) implementation planning for their more significant, larger-scale, water-quality benefits. For this project, GIS software is used to perform a terrain analysis, which employs elevation data to characterize the physical features of the landscape. Terrain analysis can be used to identify locations with a high potential for erosion and pollutant runoff. These identified source areas can then be assessed for further evaluation. Additional spatial analyses can also be incorporated, including source proximity to a water body and soil erosion risk factors. Terrain analysis and other spatial analyses do not eliminate the need for field assessments. However, they can reduce the amount of time spent in the field and enhance data collection efforts by enabling technicians to select potentially sensitive sites.

It is important to note that many of the sites identified as sensitive by the GIS analysis will already have appropriate management and operation. Thus, these tools also provide an important opportunity to recognize producer accomplishments and track program progress necessary for supporting basin management and Total Maximum Daily Load efforts.
Digital Terrain Analysis Manual

Overview

This manual requires the use of Esri’s ArcGIS computer software with Spatial Analyst extension installed. The basic version (ArcView license) is sufficient for the methods described in this manual. This manual is also designed to accommodate users of either ArcGIS versions 9.0 to 9.3.1 or 10.0 to 10.2 – the former will be referred to as 9.x and later as 10.x from here on. Other GIS-based software programs that are able to process large raster datasets and calculate logical map algebra should work for terrain analysis processing but will not be covered in this manual.

The terrain analysis process involves combining primary attributes to form secondary attributes. The core primary attributes used for this terrain analysis include flow direction, flow accumulation, and slope. Secondary attributes include Stream Power Index (SPI) and Compound Topographic Index (CTI).

SPI is calculated as the product of the natural log of both slope and flow accumulation. High SPI values displayed in GIS represent areas on the landscape where high slopes and flow accumulations exist and thus areas where flows can concentrate with erosive potential. For this reason, SPI is very useful for determining potential Critical Source Area (CSA) locations. CTI is the quotient of both slope and flow accumulation. It can show areas on a landscape that pond and store water, and is therefore useful for locating potential wetland locations. The plan and profile curvature terrain attributes are also used primarily to identify upland sinkhole locations, and to aid in ravine identification (see appendix section A.3).
Procedure
The digital terrain analysis core processes can be visualized using the following flow chart (fig. 1).

![Digital terrain analysis flow chart](image)

**Figure 30. Digital terrain analysis flow chart**

Digital terrain analysis begins with a planning process where project goals are established and an appropriate scale for assessment is defined. The spatial scale will determine the amount of data acquisition necessary to address project goals. The attributes created may or may not require pre-processing. This again is at the discretion of the project goals. The attributes are either primary or secondary in nature, depending on whether they derive directly from elevation data or a secondary product. The attributes, when combined with relevant ancillary data, should provide enough information to locate and prioritize potential Critical Source Areas (CSAs). Ground truthing is an important step necessary to relate mapping to planned goals. The objective of ground truthing is to determine best-fit threshold values for a given Area of Interest (AOI) by comparing digital terrain attributes to real-world conditions. When thresholds have been established, CSAs can then be located and prioritized using a combination of primary attributes, secondary attributes, and ancillary data. CSA validation is used to determine accuracy of predictions and reveal the existence of commission and omission errors. This step is fundamental to the user learning process since locating potential CSAs digitally is an adaptive process and validation provides opportunities to improve visualization and prediction techniques. Evaluation of site conditions should accompany field validation. The Field Assessment and Sensitive Site Identification Guidance manuals were developed to assist in site
evaluations, and to direct efforts and track results when visiting priority sites in the field. The final step is to make decisions regarding how to address field-verified CSAs. This may involve contacting and working with land owners, determining which BMPs are most suited for the agroecoregion, and/or securing conservation practice funds for BMP implementation, among others.

Data acquisition

For the initial primary attribute calculations, only a raster DEM is required, but ancillary data will be necessary to create CSA predictions – most of which are available at the Minnesota ‘data deli’ website: http://deli.dnr.state.mn.us/

- **Digital Elevation Model (DEM)** – A Digital Elevation Model contains one elevation value (as measured above Mean Sea Level) in each pixel, or cell, of data. Ideally, LiDAR elevation data should be used in terrain analysis for its high spatial resolution and accuracy characteristics. LiDAR data are available for the entire State of Minnesota, downloadable at the county level from either of the two links below:
  
  ftp://ftp.lmic.state.mn.us/pub/data/elevation/lidar/
  ftp://lidar.dnr.state.mn.us/

  LiDAR data from the above sources provide DEM’s in both 1 and 3 meter resolutions. Digital terrain analyses are best processed using a 3 meter DEM to minimize processing times and file sizes while maintaining a high level of elevation detail (Galzki, et al., 2011).

  o **Note:** When downloading LiDAR data, an ftp client such as FileZilla should be used due to large file sizes associated with LiDAR geodatabases. LiDAR datasets for some counties exceed 5 gigabytes and can be computationally inefficient to acquire and process. In some cases, it may be necessary to use lower resolution DEM data. 30m DEM data is still readily available throughout the state, though it should be noted that this will considerably reduce the ability to accurately predict CSA locations (Srinivasan et al., 2009).

- **Surface waters** – Current stream data containing both perennial and intermittent networks along with lake/wetland layers will be necessary to determine hydrologic connection to secondary attributes.

- **Watershed catchments** – Watershed data at various spatial scales. These are typically ordered from the number of digits in a hydrologic unit code (HUC) – from 2 digits representing regional watersheds to 12 digits representing subwatersheds. These layers are also convenient for use as an output extent when creating a clipped raster subset (see DEM clipping in Pre-process section).
• **Cities and political boundaries** – Political boundary and populated area data can be useful for spatial orientation, locating areas of interest, and improving map presentation.

• **Land cover/land use** – The most current National Land Cover Database (NLCD) raster layer.

• **Environmental Benefits Index** – The EBI layer integrates soil erosion risk, water quality risk and habitat quality factors to determine the relative conservation value of a parcel of land. It can be useful for locating regions with high erosion risk. The Soil Erosion Risk portion of the EBI can also be used alone to aid with CSA placement. The EBI and its individual layers are available at a 30m resolution for most of the State of Minnesota here: [http://www.bwsr.state.mn.us/ecological_ranking/](http://www.bwsr.state.mn.us/ecological_ranking/)


• **High resolution aerial orthophotos** – Orthorectified and georeferenced photos should be used to ensure correct alignment with surface features. Color or Color Infrared (CIR) photos with at least 5 meter resolution are preferred with leaf-off photos (spring or fall) being ideal. Recently acquired FSA National Aerial Imagery Program (NAIP) digital photos from Spring, Summer, and Fall throughout Minnesota are readily available at: [http://www.mngeo.state.mn.us/chouse/airphoto/](http://www.mngeo.state.mn.us/chouse/airphoto/)

ArcGIS software users can connect the MNGEO’s web map service though a GIS server. This will negate the need to download any photos. Instructions for connection are here: [http://www.mngeo.state.mn.us/chouse/wms/how_to_use_wms.html](http://www.mngeo.state.mn.us/chouse/wms/how_to_use_wms.html)

1. Open ArcMap and click on 'Add Data'
2. Look in the Catalog, and click on 'GIS Servers'
3. Highlight 'Add WMS Server' so that it appears in the Name window, and hit 'Add'. An 'Add WMS Server' window will pop up.
4. To bring up the Imagery server, type ‘[http://geoint.lmic.state.mn.us/cgi-bin/wms](http://geoint.lmic.state.mn.us/cgi-bin/wms)’ (without quotes) in the URL window. You can click on the 'Layers' button to see a list of the layers available under the wms. Click 'OK'.
5. To bring up the Scanned DRG server, type ‘[http://geoint.lmic.state.mn.us/cgi-bin/wmsz](http://geoint.lmic.state.mn.us/cgi-bin/wmsz)’ (without quotes) in the URL window. You can hit the 'Get Layers' button to see a list of the layers available under the wms. Click 'OK'.

6. Now when you look under 'GIS Servers' you have two new entries: 'LMIC WMS server (aerial photography) on geoint.lmic.state.mn.us' and 'LMIC WMS server (quad sheet drgs) on geoint.lmic.state.mn.us'.

7. Still in the 'Add Data' window under 'GIS Servers', highlight one of the services listed under #6 to bring it into the 'Name' window, then click on 'Add'. The service, with all of its layers, has now been added to your ArcMap project.

- **Other** – Other useful information could range from regional data such as soils (SSURGO data) and Crop Productivity Indices (CPI); feedlots, culverts, and point source locations to field specific information such as individual landowner nutrient application rates, existing conservation practice locations, artificial drainage placement, etc.

**Pre-process DEM**

Digital Elevation Models can benefit from pre-processing before terrain analysis is conducted. The amount of pre-processing required may depend on the user’s local knowledge of their Area of Interest (AOI) and its characteristics, and the resolution and quality of the original DEM. A semi-automated utility for both creating AOIs and hydrologically conditioning DEMs will be presented here. Alternatively, advanced GIS users may find it advantageous to create their own Python scripts and/or ModelBuilder flow paths within ArcGIS to semi-automate pre-process and terrain attribute calculations to decrease processing times and ensure consistent outputs.

- **Activate Spatial Analyst Extension**
  This initial step is necessary for certain Arctool processes to run. ArcGIS will remember your selection and automatically activate selected extensions every time the program is run.

1. From the **Tools** menu (ArcMap 9.x) or **Customize** menu (10.x), select **Extensions…** and check-on the **Spatial Analyst** extension.
2. Click Close.
Hydrologic Conditioning

Hydrologic conditioning (HC) is the process of modifying a DEM to change flow routing and drainage. The most common practice of HC is to remove “digital dams” that block the hypothetical flow of water typically associated with road crossings and other obstructions. One method of removing digital dams is to “burn” the stream through the obstruction to force flow downstream.

HC can be a time consuming process, thus it is important to consider whether your project goals would benefit from the operation, and if so, how much correction is needed and at what scale. For instance, some projects may only warrant burning the largest culverts along high order streams while others may require burning tile lines at the field scale.

Some points to consider:

- HC will only change terrain analysis attributes in close proximity to the digital dams removed.
- HC is most useful when combined with pit filling – if pit filling is not necessary or suitable in your AOI, HC will provide minimal terrain analysis benefits. However, if pit filling is to be used, hydro-conditioned DEMs will tend to produce more accurate terrain attributes within filled depressions. For instance, when filling all sinks in a DEM, HC can improve flow routing by unblocking large depression areas that would otherwise fill with hypothetical water to force flow over obstructions. The Stream Power Index signatures in those unblocked depressions will be more representative of actual overland flow when sinks have been filled.
The above image shows an example of how water ponds (in blue) behind road crossings when using a non-conditioned DEM. There are culverts present at both crossings (circled in yellow), though the DEM does not recognize culverts and sees the road as an obstruction – known as a digital dam. Ideally all DEM’s used for SPI creation should be hydrologically corrected, though the process can be time consuming and small culverts may not show up in aerial photography making field verification necessary.

ArcGIS includes tools that can be used to hydrologically condition DEMs, such as **Topo to Raster** (Vaughn 2012). Several 2nd party applications also exist with HC capabilities. The NRCS GIS Engineering toolset introduced in the Data Acquisition section is one such utility recommended for its ability to burn streams through a semi-automated process of digitizing culverts. The user must input culverts either by importing a polyline shapefile or by manually digitizing their locations.
See the Data Acquisition section for the NRCS tools zip file download link. Once the file is downloaded to your computer, follow the readme instructions to install the software:

[from the version1.1.7_ReadMe.txt]

Installing the tools:
---------------------
No special or admin privileges are required, simply unzip the zip file to a local directory. An "NRCS_GIS_ENGINEERING_TOOLS" folder will be created in specified location. Within the NRCS_GIS_ENGINEERING_TOOLS folder there will be an "NRCS Engineering Tools.tbx" toolbox file and a "SUPPORT" folder. The support folder contains the necessary scripts, files, and symbology layers, and must always reside in the same directory as the toolbox.

Adding to ArcMAP:
----------------
Enable the ArcToolbox window (if necessary), right click, and select "Add Toolbox". Browse to the location where the files were unzipped, then the "NRCS_GIS_ENGINEERING_TOOLS" Folder within, and click once to select or highlight the NRCS Engineering Tools Toolbox, then click the "Open" button in the bottom right hand corner of the dialog box.

ArcMap Settings:
-----------------
Make sure that the Spatial and 3D Analyst extensions are enabled by going to the Customize > Extensions Menu (ArcGIS10) or the Tools > Extensions Menu (ArcGIS 9.3). 9.3 Users should also go to the Tools > Options Menu, click on the Geoprocessing Tab, and make sure that both "Overwrite the outputs of Geoprocessing Operations" and "Add Results of geoprocessing operations" options are selected. "Results are temporary by default" should also be UN-CHECKED.

END
When properly setup in ArcMap, the NRCS tools should resemble the following image in your ArcToolbox:

The following section will guide users on area of interest and hydrologic conditioning DEM pre-processing using the NRCS GIS Engineering Tools. For manual AOI raster clipping, see Appendix section A.2.

1. Launch ArcToolbox by clicking the toolbar icon (9.x) or ArcToolbox in the Geoprocessing menu (10.x).

2. Expand the NRCS Engineering Tools, then expand the Watershed Tools toolset, followed by the Watershed Delineation toolset. Double-click the Define Area of Interest tool to start it.

Minnesota LiDAR data acquired at the county level can contain very large file sizes. It is therefore important to minimize the spatial area to be processed to reduce output files sizes and increase processing times. The Define Area of Interest tool creates a subset of a raster dataset and will be used for this purpose.

Note: There are several additional ways to find this (or any) tool in ArcToolBox:
o Select the **Index** tab at the bottom of ArcToolbox and scroll through the list to find **Clip** (Data Management) (9.x).

o Select the **Search** tab at the bottom and type in ‘fill’ to find any tools with fill in their titles (9.x).

o From the **Geoprocessing** menu, choose **Search For Tools** (10.x).

3. **Browse to and Select Workspace**: Choose your workspace folder where outputs will be stored. Select a destination directory without spaces and choose a name for the folder based on your project or area of interest.

4. **Input DEM**: Your DEM, preferably a 3m LiDAR elevation dataset.

5. **Enter your Area of Interest**: Click the **Add feature** icon (#1 circled red in above image), then minimize the Define Area of interest window. The cursor should be a cross icon. The add feature tool works as a polygon editor, with each click creating a new vertex. The sketch is finished by double clicking to connect the first and last sketch vertices. Optionally, the **Use features from** field can be used with a compatible raster or vector file fitting you AOI.

6. **Interval for Contours (feet) (optional)**: Select desired contour foot contours. If left blank, no contours will be created.

7. **Choose DEM Elevation Units (optional)**: User preference.

8. Click OK to run tool script. Several new layers will be added to your map.
1. Open NRCS Engineering Tools > Watershed Tools > Watershed Delineation > Create Stream Network

The **Create Stream Network** tool serves multiple purposes: it creates a stream network, it is used to burn culvert locations, and it creates a hydro-conditioned DEM all within the AOI established in the previous **Define Area of Interest** tool.

2. **Select Project_AOI feature**: Select the AOI that was created by the previous **Define Area of Interest** tool

3. **Digitize Culverts (optional)**: Click the Add feature icon (#2 circled in red above) then minimize the current window. The add feature function works as a line sketch tool. Use the function to make a line that represents a culvert at any obvious or known locations where a culvert exists. The **DepthGrid** layer created by the previous tool **Define Area of Interest** can aid in showing where water backs up at impoundments such as road crossings (following figure). Culverts are likely to exist at these locations. Create as many digitized culverts as necessary to ensure an accurate stream network representation
4. **Enter Stream Threshold in Acres:** This value is the minimum contributing area required to form a stream. The default value of 1 is adequate in most situations and will form stream headwaters near catchment boundaries.

5. Click OK to run tool script. Several new layers will be added to your map.
   - *Note:* The hydro-conditioned DEM will be created and called **hydroDEM** but will NOT be automatically added to your map. It is located in an auto-created file geodatabase within the workspace you selected in the first **Define Area of Interest** tool.
- **Pit & Sink Filling**
  Along with hydro-conditioning, pit filling should also be considered before terrain attribute calculations are made. This procedure fills depressions with hypothetical water flow and forces drainage to the lowest possible outlet. These depressions can vary considerably in scale from an isolated single cell to hundreds of contiguous cells covering well over a thousand acres. The pit-filling process may not be appropriate for all areas, especially where water is held and evaporated in depressions or where extensive tile drainage exists (see Case Studies section for examples). It is, however, a more conservative approach than using a non-filled DEM because it tends to err on the side of overestimating flows (Galzki, et al. 2011) – SPI signatures created from pit filled DEMs are more analogous to saturation excess runoff flow paths produced from large storm events than unsaturated flows. For SPI creation, users may generally find filling pits most suitable for steep-sloping landscapes and less suitable for low relief areas, though it is highly advisable to experiment with various pit fill Z limits, including a “fill all” run and a run with no pit filling. This will allow comparisons to be made among the SPI layers and help determine which best represents the landscape.

For CTI layer creation, a ‘fill all’ routine should be used to accurately depict surface water storage.

1. Open **ArcToolbox > Spatial Analyst Tools > Hydrology > Fill**

2. **Input surface raster**: Your DEM. If you used the NRCS Engineering tools previously, your **Input surface raster** will be **hydroDEM** for you hydro-conditioned DEM, or **[Your workspace folder name]_DEM** for your non-hydro-conditioned DEM. If you manually created a clipped subset of your original DEM, your **Input surface raster** will be the ‘dem_clip’ layer. To fill the tool fields, select layers from the drop-down,
drag the layer to the blank field, or browse to the desired layer by clicking on the folder icon left of field.

3. **Output surface raster**: Browse to output workspace and name using it something you can remember, e.g. 'dem_fill'. It may be useful to add the unit amount used to fill the DEM so that users can identify each layer’s Z limit when calculating multiple filled DEMs; e.g. ‘dem_fill1m’ or ‘dem_fillall’

4. **Z limit**: The maximum elevation difference between a sink and its pour point to be filled. Units will be the same as the DEM’s Z (vertical) axis, typically meters.
   
   *Note*: The default, which is achieved by leaving the Z limit field blank, will fill all sinks regardless of depth

5. Click OK to run. The output surface raster is added to your map as a new layer
Filter

At times, LiDAR data expressed in fine-resolution DEMs can contain either errors or spurious features which impede flow analysis and/or other terrain analysis, though these anomalies are becoming a non-issue with advancing technology in LiDAR acquisition along with improved quality control and assurance deliverables. The filter tool employs a low pass filter using a 3x3 moving window to “smooth” the raster and create a more contiguous dataset. Caution should be used when filtering, as it essentially ‘dumbs down’ the data by averaging out extreme outliers. Similar to pit filling, it is recommended to run terrain analysis with both filtered and non-filtered processes and determine which outputs best suit the terrain. The filter tool is typically run after pit filling.


   ![Filter window]

2. **Input raster**: Your DEM. If pit filling was previously used, your **Input raster** will be ‘dem_fill’. If pit filling was not used, but clipping was, your **Input raster** will be ‘dem_clipped’. If NRCS tools were used, the **Input Raster** will be **hydroDEM** or **[Your workspace folder name]_DEM**

3. **Output raster**: Browse to output workspace and name it, e.g. ‘dem_filter’.

4. **Filter type (optional)**: the enhancement to be performed in the filter analysis.
   - **Note**: The default is "LOW" which is required to do the smoothing we seek.

5. Click OK to run.
6. The output raster is added to your map as a new layer.
**Calculate primary attributes**

Primary attributes are derived directly from the DEM. The slope, flow direction, and flow accumulation primary attributes will be used to calculate secondary attributes. Many of the other primary attributes created here will be used to visualize landscape surfaces and terrain attributes.

- **Slope**
  1. **ArcToolbox > Spatial Analyst Tools > Surface > Slope**

     ![Slope Tool](image)

     - **Input raster**: Your DEM. If pre-processing was used, this should be the final DEM created, such as ‘dem_fill’ or ‘dem_filter’.
     - **Output raster**: Browse to output workspace and name output layer ‘slope_dem’.
     - **Output measurement (optional)**: Select ‘PERCENT_RISE’
       - **Note**: It is important for the rest of the analysis that you select PERCENT_RISE, even though the data will look the same.
     - **Z factor (optional)**: For DEMs with vertical (Z) units in meters, type 1, or else leave as default
     - Click OK to run. The output raster is added to your map as a new layer.

- **Aspect**
  1. **ArcToolbox > Spatial Analyst Tools > Surface > Aspect**
2. **Input Raster**: Your DEM. If pre-processing was used, this should be the final DEM calculated, such as ‘dem_fill’ or ‘dem_filter’.

3. **Output raster**: Browse to output workspace and name output layer ‘aspect_dem’.

4. Click OK to run. The output raster is added to your map as a new layer.
- **Plan & Profile Curvature**
  Plan curvature is measured perpendicular to the direction of descent and describes converging/diverging flow. It is well suited for describing soil water content and characteristics. Profile curvature is measured in the direction of maximum descent or aspect direction. It is a measure of flow acceleration and suited for erosion/deposition rate and geomorphology visualization.
1. **ArcToolbox > Spatial Analyst Tools > Surface > Curvature**

![Curvature dialog box](image)

2. **Input Raster**: Your DEM. If pre-processing was used, this should be the final DEM calculated, such as ‘dem_fill’ or ‘dem_filter’.

3. **Output curvature raster**: Browse to output workspace and name output layer ‘curve_dem’.

4. **Output profile curve raster**: Browse to output workspace and name layer as ‘pro_dem’.

5. **Output plan curve raster**: Browse to output workspace and name layer as ‘plan_dem’.

6. Click OK to run. The 3 output rasters are added to the map as new layers.
- **Hillshade**
  The hillshade tool creates a shaded relief layer from a surface raster by considering the illumination source angle and shadows. The resulting hillshade raster creates a pseudo 3D display of topography.

1. **ArcToolbox > Spatial Analyst Tools > Surface > Hillshade**

2. **Input Raster**: Your DEM. If pre-processing was used, this should be the final DEM calculated, such as ‘dem_fill’ or ‘dem_filter’.
3. **Output raster**: Browse to output workspace and name output layer ‘hs_dem’.
4. Accept defaults for **Azimuth** and **Altitude**
   - **Note**: You can try checking on **Model Shadows**, it can be helpful in visualization, but in some cases it may make little difference.
5. **Z factor (optional)**: For DEMs with vertical (Z) units in meters, enter 1, or else leave as default
6. Click OK to run. The output raster is added to your map as a new layer.
Flow Direction
ArcMap’s Flow Direction tool uses a calculation method called the ‘D8’ algorithm. This method is well suited to the identification of individual channels, channel networks and basin boundaries making it suitable for terrain analysis CSA identification. However, it is based on two simplifying assumptions that do not capture the geometry of divergent flow over hillslopes. The two simplifications are the use of 8 discrete flow angles, and each pixel has a single flow direction (Rivix, 2008). Due to these factors, the ‘D-Infinite’ algorithm was created to overcome D8 limitations and therefore provide an increased potential to improve terrain analysis results. Several software programs exist with dedicated DEM processing offering both D8 and D-Infinite calculations (e.g. TauDEM, RichDEM, RiverTools, etc.). The D8 method imbedded in the Flow Direction ArcTool is used in this manual, though users are encouraged to process DEMs with the D-Infinite method Flow Direction calculation if available.

1. ArcToolbox > Spatial Analyst Tools > Hydrology > Flow Direction

2. Input Raster: Your DEM. If pre-processing was used, this should be the final DEM calculated, such as ‘dem_fill’ or ‘dem_filter’.

3. Output flow direction raster: Browse to output workspace and name output layer ‘flowdir_dem’.

4. Click OK to run. The output raster is added to your map as a new layer.
• **Flow Accumulation**

1. **ArcToolbox > Spatial Analyst Tools > Hydrology > Flow Accumulation**

![Flow Accumulation dialog box](image)

2. For **Input Flow Direction Raster**, use the output of Flow Direction from earlier step. If you kept the suggested name, it will be ‘flowdir_dem’.

3. **Output accumulation raster**: Browse to output workspace and name output layer ‘flowacc_dem’.

4. Accept defaults for other parameters.

5. Click OK to run. The output raster is added to your map as a new layer.
Calculate secondary attributes

- Stream Power Index (SPI)

1. Launch the Raster Calculator by clicking on Spatial Analyst Tools > Map Algebra > Raster Calculator

2. Enter formula so the Map Algebra expression looks exactly as follows:
   \[ \text{Ln}((\text{"flowacc_dem"} + 0.001) \times (\text{"slope_dem"} / 100 + 0.001)) \]
   - Note: The spaces between operators are required for proper calculation

3. Output raster: Browse to output workspace and name output layer ‘spi’.
4. Click OK to run calculation.
• **Compound Topographic Index (CTI)**

1. **Launch the Raster Calculator** by clicking on **Spatial Analyst Tools > Map Algebra > Raster Calculator**

2. Enter formula so the Map Algebra expression looks exactly like: 
   \[ \ln\left(\frac{\text{flowacc_dem} + 0.001}{\left(\frac{\text{slope_dem}}{100}\right) + 0.001}\right) \]
   - **Note:** The formula above is the same as the SPI formula with the only difference being the division between Flow Accumulation and Slope.

3. **Output raster:** Browse to output workspace and name output layer ‘cti’.

4. Click OK to run calculation.
Visualizing terrain attributes

- **Terrain Attribute Comparison** – Often, the best way to understand differences in terrain attribute calculations is to view each layer in conjunction with one another. By paying careful attention to a specific portion of the landscape, one can overlay each of the terrain attributes to gain a better understanding of the relationships between each attribute.

- **Aerial Photo Comparison** - Utilizing aerial photography is a great way to better understand your landscape, and it may be possible to validate some of the largest features in your area of interest with aerial photos alone. While ground-truthing is the most effective way to determine the accuracy of terrain attribute-based predictions of critical source areas, this is not always possible – especially on privately-owned land. Furthermore, photos when used with flow accumulation and its associated secondary terrain attributes, often help in assessing whether or not further hydrologic conditioning is required for the task at hand.

- **Swipe function**
  1. To display the Effects toolbar, right-click anywhere in the toolbar and select Effects.
  2. Select the Swipe Tool to "wipe" a layer using a horizontal or vertical line across the screen.
  3. Make sure the layer you want to "swipe" is shown in the "Layer:" box.
  4. Click on the map and drag to swipe (*do not release mouse button; the mouse must be depressed to get the swipe effect*).

Example of swipe function:
Symbology for Terrain Attributes

Often this is a matter of personal preference, but there are a few tips/tricks in display used for specific terrain attributes:

1. **Slope** - Colormap variations
2. **Flow Accumulation** - Visualize upslope contributing area as if it were a watershed boundary.
3. **CTI** – Blue/water – display highest values darkest
4. **SPI** – Brown/sediment - display highest values darkest

- **SPI/CTI visualization** – Once calculated, the SPI and CTI layers are not very informative without first removing a majority of the cells that have low erosion (SPI) or ponding (CTI) risk. The layer histograms can be used to estimate a threshold for these unwanted values for quick display changes. More precise methods for determining how many cells to remove from the layers are discussed in the **Determining thresholds** section.

To modify the original SPI and/or CTI layers to display percentile values:

1. Double click on the layer in the Table of Contents window in ArcMap to open the layer’s Properties menu.
2. In Layer Properties, open the Symbology tab (1). On the right side under ‘Show’ click on ‘Classified’ (2) and in the classification box click ‘Classify...’ (3). The Classification window will open. At this point users can experiment with several different classification methods, classes, and threshold values. Keep in mind that any changes
made here in Layer Property Symbology will not modify the data in anyway; it will only change the way the data is displayed in the active ArcMap data frame.

- The Classes pull down menu allows for the user to select the number of class breaks to be calculated using the user defined classification method. Using class breaks between 1 and 10 should be appropriate for displays.
- With the classification method, there is no right or wrong method to use, though the Quantile and Natural Breaks (Jenks) classification methods often match well with signature gradients. Esri provides the following descriptions for each classification method from their ArcGIS Help Resource Center:
  - Equal interval divides the range of attribute values into equal-sized sub-ranges. This allows you to specify the number of intervals, and ArcGIS will automatically determine the class breaks based on the value range.
  - Defined interval allows you to specify an interval size used to define a series of classes with the same value range.
  - With Quantile classification, each class contains an equal number of features. A quantile classification is well suited to
linearly distributed data. Quantile assigns the same number of data values to each class. There are no empty classes or classes with too few or too many values.

- Natural Breaks (Jenks) classes are based on natural groupings inherent in the data. Class breaks are identified that best group similar values and that maximize the differences between classes. The features are divided into classes whose boundaries are set where there are relatively big differences in the data values.

- The Geometrical Interval classification scheme creates class breaks based on class intervals that have a geometrical series. The geometric coefficient in this classifier can change once (to its inverse) to optimize the class ranges. The algorithm creates geometric intervals by minimizing the sum of squares of the number of elements in each class. This ensures that each class range has approximately the same number of values with each class and that the change between intervals is fairly consistent.

- The Standard deviation classification method shows you how much a feature's attribute value varies from the mean. Class breaks are created with equal value ranges that are a proportion of the standard deviation—usually at intervals of 1, ½, ⅓, or ¼ standard deviations using mean values and the standard deviations from the mean.

  - The Data Exclusion option can be used to exclude all data below or above any user determined threshold value.

3. The simplest method for display is to use two classes to represent all signatures over a certain threshold. This threshold value is at the users’ discretion, though quantitative methods for calculating statistical thresholds are presented in the Determining thresholds section.

  - For the simple method described here, set Classes to ‘2’ and Classification Method to ‘Manual’ in that order. Two values will display in the Break Values column on right (see following figure). For this initial step, click and drag the lower break line to the approximate location shown in regards to the background histogram, or place it at the break value of ~2. This can be easily fine-tuned later. Click OK.
Back in the Symbology window, there will be two class symbols displayed – one black and one white – with the ranges associated with each to their right. The black symbol by default will contain all values below the threshold we chose, and the white contains the values above. Double-click the white rectangle symbol and a color palette will appear. Click any color you prefer that is highly visible, such as ‘Mars Red’. Double-click the black rectangle and choose “No Color” at the top of the palette window. If the layer is active, you can click ‘Apply’ to see the changes behind the Layer Properties window instantly, otherwise click ‘OK’.

Users will likely want to tweak the threshold value used to best represent the surface flow paths (SPI) or ponding (CTI) in their area of interest.

- If the SPI signatures look too crowded or dense (example 1 below), the threshold values should be increased incrementally by clicking and dragging the vertical break line in the classification window until display results are satisfactory and vice versa for sparse SPI populations (example 2).

Note: The symbol colors will need to be changed again after each classification change.
> Treat the CTI layer using the same technique described in the previous step. A proper CTI threshold should display areas of impounded water if pit filling was used during DEM pre-processing.
Often it is preferable to display SPI and CTI signatures with color gradients that represent high and low values within the same signature. For this purpose we can use the classification window with more than two classes.

- Under Classification Method, choose ‘Quantile’ or ‘Natural Breaks (Jenks)’ and Classes between 5 and 10 (user preference).
- We will use the Data Exclusion option to remove all values below a threshold. In the Classification window’s Data Exclusion box, click “Exclusion…”

Under the Value tab, type your desired data exclusion range in the blank. For instance, to exclude all values below a threshold value of 2, and a minimum value range of -14, you would enter “-14 - 2” (without quotes). The minimum or maximum value used can be below or above the true value respectively to ensure full exclusion of data in the desired range.

*Note:* The range will be displayed in the underlying Classification window in the upper right, as Minimum and Maximum

- Click on the Apply button to see the changes in the underlying window’s histogram to ensure it matches your exclusion range. If the results are satisfactory, click OK on both windows to return to the Layer Properties window.
In the layer properties window, you can set your preferred color ramp for pixel display by clicking on the Color Ramp pull down. It may be best to match the highest values with the darkest colors and lowest values with lightest.
As with the two class display approach, you may find that the exclusion range used allows too many or too few signatures for display. The method for correction is to change the threshold value in the data exclusion range. If the signatures are too crowded, increase the threshold value closer to your maximum value, and vice versa.

**Determining thresholds**

The SPI and CTI raster layers are most useful when displayed at a certain percentage of values above a threshold. The threshold depends mainly on local topography and overall slopes, and there is often a range of percentile values that will represent surface features sufficiently. Common thresholds are typically between the top 15% of values for flat areas to the top 1% of values for high relief areas.

Using estimation to visualize thresholds was previously described. This section will detail several methods for calculating exact percentile values from raster layers. Though not a necessary step for locating potential CSAs, the percent of SPI or CTI values displayed should be known to ensure consistency among users, or if following SOPs and/or publishing results. Methods for creating exportable SPI/CTI raster files with permanently-set thresholds will also be explained in this section.

When determining thresholds, the user must consider the spatial extent of the area being processed, as software has limited abilities to process large data sizes. For instance, if using Microsoft Excel, the maximum records affect ability to input LiDAR data:

- Excel 2003 max records - 65,569
- Excel 2007 max records - 1,048,575
Statistical Packages – Many around 10 million

If Excel maximum records become an issue, users may circumvent those limitations by creating random samples from the SPI raster at a 95% or better confidence interval. There are also many statistical software packages that can readily compute percentiles from large datasets, such as the free to use R program (CRAN, http://www.r-project.org/). Since those programs often have a learning curve for even basic functioning, using a more familiar program such as Microsoft Excel may be preferable. This manual will focus on using Excel for threshold calculations. A full explanation on using the R statistical software package for percentile calculations is presented in the appendix (see appendix section A.4).

Calculating thresholds using Excel:

When using Excel, first consider data size. Using 3m LiDAR derived attributes from an AOI of 2,332 acres or more will contain too many records to be contained in a single Excel 2007 sheet. As mentioned previously, there are ways to circumvent these limitations. Two methods for using Excel to calculate thresholds will be described in detail. One will use an exported text file (also known as ASCII file) from ArcMap to be opened directly in Excel, while the other method will first use a random sample from stream power index values to be opened in Excel.

- Raster to ASCII method
  1. Launch the Raster to ASCII tool by clicking on Conversion Tools > From Raster > Raster to ASCII in ArcToolbox

    ![Raster to ASCII tool screenshot]

    a. **Input raster**: Your SPI raster layer.
    b. **Output ASCII raster file**: Any folder location of your choosing. Name the file ‘spi_text’
    c. Click OK to run.

123
2. Open Microsoft Excel with a blank workbook.

3. In Excel 2007/2010, choose the **Data** tab, and click on **From Text** from the **Get External Data** group (pictured below). In Excel 2003 and earlier, navigate to the **Data** pull down menu and choose > **Import External Data > Import Data…**

4. Browse to the saved ‘spi_text’ file created previously and click **Import**. The Text Import Wizard will open.

5. In the step 1 of 3 window, click the “Delimited” radio button and click **Next**.

6. In step 2 of 3, under the Delimiters checkbox fields, un-select Tab, check the Space box and click **Next**.

7. In step 3 of 3, leave the fields at default and click **Finish**.

8. In the new Import Data window that appears, click **OK**.

---

*Note: If the output text file exceeds 250mb, users should consider proceeding with other percentile calculation methods described in this manual.*
9. The data from the text file is added to your current worksheet.

10. Notice that the first 6 rows of the sheet are populated with data properties. These should be deleted. Move your cursor over the 1st row header until the pointer turns into a right pointing arrow ➔ then click and drag down to the 6th row (fig. 2). Once the cells are highlighted, right click anywhere in the blue highlighted section and choose delete. Once the header cells are deleted, click any cell in the sheet to unselect the highlighted rows.

   o **Note:** If the following ‘Large Operation’ warning box appears, click OK.

```
Figure 31
```

9. The data from the text file is added to your current worksheet.

10. Notice that the first 6 rows of the sheet are populated with data properties. These should be deleted. Move your cursor over the 1st row header until the pointer turns into a right pointing arrow ➔ then click and drag down to the 6th row (fig. 2). Once the cells are highlighted, right click anywhere in the blue highlighted section and choose delete. Once the header cells are deleted, click any cell in the sheet to unselect the highlighted rows.

   o **Note:** If the following ‘Large Operation’ warning box appears, click OK.

```
Figure 31
```

```
<table>
<thead>
<tr>
<th></th>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Acols</td>
<td>2873</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>nrows</td>
<td>2783</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>ulclcorner</td>
<td>518999</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>ylclcorner</td>
<td>4886006</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>cellsize</td>
<td>3</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>NO_DATA_value</td>
<td>-9999</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td></td>
<td>-9999</td>
<td>-9999</td>
<td>-9999</td>
<td>-9999</td>
</tr>
<tr>
<td>8</td>
<td></td>
<td>-9999</td>
<td>-9999</td>
<td>-9999</td>
<td>-9999</td>
</tr>
<tr>
<td>9</td>
<td></td>
<td>-9999</td>
<td>-9999</td>
<td>-9999</td>
<td>-9999</td>
</tr>
<tr>
<td>10</td>
<td></td>
<td>-9999</td>
<td>-9999</td>
<td>-9999</td>
<td>-9999</td>
</tr>
<tr>
<td>11</td>
<td></td>
<td>-9999</td>
<td>-9999</td>
<td>-9999</td>
<td>-9999</td>
</tr>
<tr>
<td>12</td>
<td></td>
<td>-9999</td>
<td>-9999</td>
<td>-9999</td>
<td>-9999</td>
</tr>
</tbody>
</table>
```

**Figure 31**
11. Many of the cells will contain a value of -9999 which is ArcMap’s default NoData value. All cells containing that value will need to be removed as they will affect the percentile calculation. The Find and Replace editing tool in Excel can be used for this purpose. In Excel 2007/2010, from the Home tab, find the editing group (far right) and click on the ‘Find & Select’ button and choose ‘Replace…’ (pictured below). The ‘Find and Replace’ dialog box will open. Excel 2003 users should click the Edit pull down menu, then choose ‘Find…’ Select the ‘Replace’ tab after the tool opens.

- Note: The Find and Replace function can be quickly brought up by typing Ctrl+F in all Excel versions.

12. In the Find and Replace dialog box, type ‘-9999’ into the ‘Find what’ field, and leave the ‘Replace with’ field empty. This will replace all -9999 NoData cells with a blank cell.
13. Click ‘Replace All’ to run the operation.
   - Note: During this operation, Excel may become unresponsive. This
     is normal, and the replace function may take several minutes to
     complete depending on data size.

14. You should receive a notice saying Excel has completed its search.
    Click OK.

15. To calculate percentiles from the data, we will use the built-in
    Percentile function. The data range will first need to be determined.
    The easiest way is to click the first cell in the upper-right-most corner
    of the sheet (A1) and type Ctrl+Shift+End. All active cells in the
    worksheet will be highlighted. Make note of the row and column
    header extents, e.g. ‘A1 to DFM2796’ as they will be used for the
    percentile array.

16. Click a blank cell anywhere below the highlighted cells, and type
    ‘=percentile(’ (without quotes) and the percentile function will become
    active with format (array, k).

17. For array, type in your data range from the previous step as the array
    using the format ‘top left cell:lower right cell’ e.g. ‘A1:DEF200’ then
    type a comma.
18. For the k parameter, enter your percentile value, such as .95 for the 95\textsuperscript{th} percentile threshold value. Finish the function by ending with a closing parentheses and hit enter. The function will calculate the threshold of acceptance value from your original range of SPI or CTI values.
• **Random point method**

  1. In ArcGIS 9.x, Open **ArcToolbox > Data Management Tools > Feature Class > Tools > Create Random Points**

     In ArcGIS 10.x, Open **ArcToolbox > Data Management Tools > Feature Class > Create Random Points**

     - **Note:** The Spatial Analyst or 3D Analyst extension is required to use Create Random Points with both ArcView and ArcEditor licenses.
a. **Output Location**: Choose a geodatabase workspace as the output location. The Random Point tool requires an existing geodatabase, either file or personal, for output compatibility. Folders will not be accepted by this tool.

b. **Output Point Feature Class**: Name the output file ‘random_points’

c. **Constraining Feature Class (optional)**: This is the boundary of your SPI and/or CTI layer(s). It must be vector format (shapefile, coverage, or feature class). It is often easiest to use the same **Output Extent** vector layer when clipping the original DEM to your area of interest. If clipping was not used, a polygon can be created around your SPI layer for use as the **Constraining Feature Class**.

d. **Number of Points [value or field] (optional)**: Click the radio button next to Long, and use the blank to input the desired number of random points. Users should create enough sample points from the population size to ensure at least a 95% confidence interval with a 1% margin of error. Table 1 can be used to this purpose.

  - **Note**: For determining population size of your SPI raster, see appendix section A.5.

e. Leave the rest of the fields as default and click OK to run. The output feature class is added to your map as a new layer.

2. Open ArcToolbox > Spatial Analyst Tools > Extraction > Extract Values to Points

![Extract Values to Points](image)
a. **Input point features**: Your ‘random_points’ layer created in previous step.

b. **Input raster**: Your SPI or CTI raster layer.

c. **Output point features**: Browse to output workspace and name output layer ‘random_spi’

d. Click OK to run. The output shapefile is added to your map as a new layer.
Table 17

<table>
<thead>
<tr>
<th>Population Size</th>
<th>Confidence = 95%</th>
<th>Confidence = 99%</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>5.0% 3.5% 2.5% 1.0%</td>
<td>5.0% 3.5% 2.5% 1.0%</td>
</tr>
<tr>
<td>10</td>
<td>10    10    10    10</td>
<td>10    10    10    10</td>
</tr>
<tr>
<td>20</td>
<td>19    20    20    20</td>
<td>19    20    20    20</td>
</tr>
<tr>
<td>30</td>
<td>28    29    29    30</td>
<td>29    29    30    30</td>
</tr>
<tr>
<td>50</td>
<td>44    47    46    50</td>
<td>47    46    49    50</td>
</tr>
<tr>
<td>75</td>
<td>63    69    72    74</td>
<td>67    71    73    75</td>
</tr>
<tr>
<td>100</td>
<td>80    89    94    99</td>
<td>87    93    96    99</td>
</tr>
<tr>
<td>150</td>
<td>108   126   137   148</td>
<td>122   135   142   149</td>
</tr>
<tr>
<td>200</td>
<td>132   160   177   196</td>
<td>154   174   186   198</td>
</tr>
<tr>
<td>250</td>
<td>152   190   215   244</td>
<td>182   211   229   246</td>
</tr>
<tr>
<td>300</td>
<td>169   217   251   291</td>
<td>207   246   270   295</td>
</tr>
<tr>
<td>400</td>
<td>196   265   318   384</td>
<td>250   309   348   391</td>
</tr>
<tr>
<td>500</td>
<td>217   306   377   475</td>
<td>285   365   421   485</td>
</tr>
<tr>
<td>600</td>
<td>234   340   432   565</td>
<td>315   416   490   579</td>
</tr>
<tr>
<td>700</td>
<td>248   370   481   653</td>
<td>341   462   554   672</td>
</tr>
<tr>
<td>800</td>
<td>260   396   526   739</td>
<td>363   503   615   763</td>
</tr>
<tr>
<td>1,000</td>
<td>278   440   606   906</td>
<td>399   575   727   943</td>
</tr>
<tr>
<td>1,200</td>
<td>291   474   674  1067</td>
<td>427   636   827  1119</td>
</tr>
<tr>
<td>1,500</td>
<td>306   515   759  1297</td>
<td>460   712   959  1376</td>
</tr>
<tr>
<td>2,000</td>
<td>322   563   869  1655</td>
<td>498   808  1141  1785</td>
</tr>
<tr>
<td>2,500</td>
<td>333   597   952  1984</td>
<td>524   879  1288  2173</td>
</tr>
<tr>
<td>3,500</td>
<td>346   641  1068  2565</td>
<td>558   977  1510  2890</td>
</tr>
<tr>
<td>5,000</td>
<td>357   678  1176  3288</td>
<td>586  1066  1734  3842</td>
</tr>
<tr>
<td>7,500</td>
<td>365   710  1275  4211</td>
<td>610  1147  1960  5165</td>
</tr>
<tr>
<td>10,000</td>
<td>370   727  1332  4899</td>
<td>622  1193  2098  6239</td>
</tr>
<tr>
<td>25,000</td>
<td>378   760  1446  6939</td>
<td>646  1285  2399  9972</td>
</tr>
<tr>
<td>50,000</td>
<td>381   772  1491  8056</td>
<td>655  1318  2520 12455</td>
</tr>
<tr>
<td>75,000</td>
<td>382   776  1506  8614</td>
<td>658  1330  2563 13583</td>
</tr>
<tr>
<td>100,000</td>
<td>383   778  1513  8762</td>
<td>659  1336  2585 14227</td>
</tr>
<tr>
<td>250,000</td>
<td>384   782  1527  9248</td>
<td>662  1347  2626 15555</td>
</tr>
<tr>
<td>500,000</td>
<td>384   783  1532  9423</td>
<td>663  1350  2640 16055</td>
</tr>
<tr>
<td>1,000,000</td>
<td>384   783  1534  9512</td>
<td>663  1352  2647 16317</td>
</tr>
<tr>
<td>2,500,000</td>
<td>384   784  1536  9567</td>
<td>663  1353  2651 16476</td>
</tr>
<tr>
<td>10,000,000</td>
<td>384   784  1536  9594</td>
<td>663  1354  2653 16560</td>
</tr>
<tr>
<td>100,000,000</td>
<td>384   784  1537  9603</td>
<td>663  1354  2654 16584</td>
</tr>
<tr>
<td>300,000,000</td>
<td>384   784  1537  9603</td>
<td>663  1354  2654 16586</td>
</tr>
</tbody>
</table>

† Copyright, The Research Advisors (2006). All rights reserved.
3. Microsoft Excel cannot open the .dbf file format so the ‘random_points’ shapefile’s table will need to be exported as a text (ASCII) file.
   a. Right click on the new ‘random_spi’ layer in the table on contents window, and choose ‘Open Attribute Table’
   b. Click the upper left pull down menu button (table options) and choose the ‘Export…’ option.
   
   ![Excel Attribute Table Export Menu](image)

   c. In the Export Data window, click on the browse button to the right of the ‘Output table’ field.
   d. Save the file in a folder (not a geodatabase), naming it spi_points.txt or cti_points.txt. Make sure to save the file as Text File under the ‘Save as type’ pull down and click Save (fig. 3).
   e. Back in the Export Data window, make sure ‘All Records’ is selected in the Export pull down, and click OK.
f. When the process has completed, you can select No when prompted to add to the current map.

4. Open Microsoft Excel with a blank workbook.
   a. In Excel 2007/2010, choose the Data tab, and click on From Text from the Get External Data group (pictured below). In Excel 2003 and earlier, navigate to the Data pull down menu and choose > Import External Data > Import Data…

   ![Image of Excel screen](image.png)

   Figure 32

   b. Browse to the saved text file created in the steps above and click Import and the Text Import Wizard will open.
c. In the step 1 of 3 window, click the “Delimited” radio button and click Next.

Original data type

Choose the file type that best describes your data:
- **Delimited** - Characters such as commas or tabs separate each field.
- **Fixed width** - Fields are aligned in columns with spaces between each field.

d. In the step 2 of 3, under the Delimiters checkbox fields, un-select Tab, and check the Comma box and click Next.

e. In step 3 of 3, leave the fields at default and click Finish.
f. In the new Import Data window that appears, click OK.

g. The data from the text file is added to your current worksheet.

5. Several columns may be currently displayed in the Excel worksheet – we are only interested in the column named RASTERVALU. We will now calculate the threshold value using the percentile function in Excel.
a. Click on a blank cell in the sheet and type `=percentile(' (without quotes) and the percentile function will become active with format (`array`, k).
b. For array, select all cells in the column named ‘RASTERVALU’ by clicking on the alphabetic character above that column, then type a comma.
   o Note: Including the cell with the text ‘RASTERVALU’ in the array will not affect the percentile calculation.

c. For the k parameter, enter your percentile value such as .95 for the 95th percentile threshold value. Finish the function by ending with a closing parentheses and hit enter. The function will calculate the threshold of acceptance value from your original range of SPI or CTI values.
Rank secondary attributes

Once the percentile thresholds are known, they can be used with the SPI and CTI layers in ArcMap. The percentile values will be used to display all cell pixels above those thresholds. If additional display detail is desired, those cells can then be further ranked with color gradients using reclassification techniques. Refer to the Visualize terrain attributes ‘SPI visualization’ section for detailed instructions on when to use those percentile thresholds.

Often, it is desirable to have multiple SPI layers each set to display different percentiles. For this purpose, separate SPI or CTI raster layers can be created each with permanently set percentile thresholds by using the **Reclassify** tool.

a. In ArcMap, open **ArcToolbox > Spatial Analyst Tools > Reclass > Reclassify**

b. **Input raster**: Your original SPI or CTI layer.

c. **Reclass field**: This should default to “Value”

d. The **Reclassification** is done using the same procedure as outlined previously and initiated by clicking the “Classify…” button.
   o **Note**: Make sure to use your desired threshold value in the data exclusion range.
e. **Output raster**: Browse to output workspace and name output layer spi or cti followed by the percentile threshold used, e.g. “spi_95”

f. Check the box next to **Change missing values to NoData (optional)**.

g. Click OK to run. The output raster is added to your map as a new layer.

  o **Note**: You may have to enter Layer Properties and set the new SPI or CTI layer’s symbology to “Stretched” for a smooth display color gradient.

**Locate and prioritize potential CSAs**

The data acquired earlier will now be used to assist in CSA placement.

1. Start a new ArcMap session with a blank map. Start populating your map with a base layer consisting of orthophoto(s) from the area of interest and the data layers collected in the Data Acquisition section. The layers in the table of contents should be generally organized so that orthophotos are on bottom, followed by raster layers, then polygon, polyline, and point vectors layers on top in that order.

  o **Note**: Some layers may benefit from using lowered display transparencies, such as the hillshade layer. This will allow base layers to still be visible. Layer transparency can be adjusted through the effects toolbar (1) or the layer properties display tab (2).
2. Create a new point shapefile or feature class to use for CSA placement.
   a. To create a new shapefile, open ArcCatalog either through ArcMap (version 10.x) or the separate ArcCatalog application.
   b. Browse to your preferred workspace folder or geodatabase using the catalog tree, right-click on your folder and select New, then “Shapefile…”, or right-click on your geodatabase and select New then “Feature Class…” The Create New Shapefile or New Feature Class window will open.
      o **Create New Shapefile:** Choose a name for the shapefile, such as “CSA points”. Make sure ‘Feature Type’ is set to **Point**. You should set the spatial reference to match the spatial coordinate system used in your other data layers. For data acquired from many Minnesota government sources, including MN DNR and MNGeo, the coordinate system used will often be “NAD 1983 UTM Zone 15N” but could differ, including UTM Zone 14N or 16N if using data from the far eastern or western parts of the state. Figure 4 shows Minnesota UTM zone grids, with zone numbers circled in red.
An easy way to select the coordinate system is to use the Import option. From the Create New Shapefile window, click the ‘Edit…’ button in the Spatial Reference box. The Spatial Reference Properties window will open. Click the ‘Import…’ button. Browse to any vector of raster file currently being used in your active ArcMap session, select it and click Add. The coordinate system should be the North American Datum 1983 UTM system. Click OK. Back in the Create New Shapefile window, click OK and the new shapefile will be added to your chosen folder.

- **Note:** When importing coordinate systems, some layers may not have spatial references set. ArcMap will still display those layers by automatically using the first coordinate system seen in the active data frame.

  o **OR create New Feature Class:** Choose a Name and Alias for the new feature class. The Name must not have spaces – instead use underscores for spaces. The Alias can contain spaces. In the Type pull down menu, select ‘Point Features’. Click ‘Next >’. The second step involves choosing a coordinate system for the new Feature Class. Follow the steps from the Create New Shapefile process above using the ‘Import…’ button to select NAD 1983 UTM system. Click ‘Next >’ on the next three windows to create the new feature class.

c. Add the new shapefile or feature class to your active ArcMap session by either dragging the file from ArcCatalog onto the map, or using the Add Data button.

d. Before new points can be placed, an editing session must be started. Right click on the new shapefile or feature class point layer and choose ‘Edit Features’ then ‘Start Editing’. If a window appears with warnings, click Continue. You are now able to place new points on the map using the editing functions.
CSA Placement and Prioritization

Critical Source Areas (CSAs) are defined as portions of the landscape that combine high pollutant loading with a high propensity to deliver runoff to surface waters, either by an overland flow path or by sub-surface drainage. These areas have a higher likelihood of conveying more pollutants to surface waters than other portions of the landscape and thus coincide well with high SPI value characteristics. Features that could be associated with CSAs include culverts, drop structures, gullies, ravines, grassed waterways, bank slumping and erosion, in-stream vehicle/livestock crossings, tile drain outlets and side-inlets, exposed tile, and open intakes. CSA features can be placed anywhere on the landscape but users should focus targeting efforts to certain areas, depending on project goals.

A set of criteria were developed that facilitates systematic assessment of the factors involved in critical area identification. The ideal criteria incorporate the inherent characteristics associated with SPI, efficiency of the hydrologic system in pollutant transport, magnitude of the source, and type of pollutant into guidelines that can be applied throughout the watershed. Critical area criteria should be applied consistently throughout the project watershed. This ensures that the study area does not receive biased identification and also that landowners do not feel singled out or excluded from the selection process depending on whether areas of their land met the criteria or not (Line & Spooner, 1995).

Criteria for placement and prioritization of CSAs include:

- Magnitude of the pollutant source
  - Contributing area
  - Average SPI value
  - SPI signature length
- Hydraulic transport of pollutants and proximity to the water resource
- Land use/land cover
- Sub-watershed soil characteristics
- Existing conservation practices
- Crop productivity indices

Terrain analysis users should select these CSA sites for field visits and evaluation based on:

- GIS analysis results
- In-house knowledge
- Available resources (e.g., funding, staff time, etc.)
Time commitments should be factored in when determining how many points to place, as creating a potential CSA at each hydrologically connected SPI signature could involve substantial validation time spent in the field. It may be preferable to only place CSAs at the locations where signature lengths are longest and in close proximity to surface water, the average SPI signature(s) value is high, no BMPs exist, and soil characteristics show high potential risk for soil erosion. It is also important to note any regional-specific factors that may exist in the area of interest, such as sinkholes, feedlots and/or cattle grazing operations, and their proximity and contribution to any potential CSAs.
1. Using your orthophoto and surface water layers in ArcMap, activate the SPI layer previously set with your desired threshold display, then zoom into your area of interest. The SPI signatures should resemble surface runoff flow paths on the map (fig. 5).

![Figure 34](image)

**Figure 34.** The above images depict how an SPI signature can be visualized as a flow path. The arrows represent flow direction

2. The following metrics should be considered for each potential CSA. They are not listed in order of importance – the weight of each metric should be tailored to fit project goals.
   - Identification by aerial photography – High resolution orthorectified aerial photos play an important role in the CSA identification process. The
orthorectification process geometrically corrects aerial imagery such that the scale of the image is uniform. In GIS, orthophotos help match SPI and CTI signatures to physical features on the landscape. Though some large features can be identified using only aerial photos, they are most useful when overlain with SPI or CTI signatures. The layers can then be turned on and off for photo comparisons, or the swipe function can be used for the same purpose. When land cover type cannot be distinguished from aerial photography, land cover/land use layers can be used with the swipe function in a similar fashion.

If multiple aerial photos are available for your area of interest, consider date, time of year, and surface moisture conditions present at the time of photo acquisition. Common orthophotos available from Minnesota Geospatial Information Office include Spring, Summer and Fall series. The most recently available leaf-off imagery taken during Springtime is often most preferable for CSA identification, as soil moisture and areas prone to ponding are most evident, and surface erosional features have not yet been worked through in the field.
The first image (previous page) is an orthophoto taken in the spring of 2011 with several gullies evident, followed by the same photo with an SPI layer overlain (above). The SPI signatures closely match the surface erosion where flows concentrate. Note the white arrows highlight differences between apparent erosion on the photo vs SPI signatures, likely explained by the gap between date of LiDAR flown (11/27/2008) and aerial photo acquisition (mid-
Signature length – SPI signature lengths are representative of their associated contributing areas. Longer SPI signatures will typically have larger upland contributing areas and therefore increased risk of sediment and nutrient volume conveyance. The length should be considered in relation to other signatures in close proximity in order to ignore threshold bias. Slope must also be considered in relation to signature length, as short signatures occurring over an area of high relief can exhibit considerable surface erosion vs. a short signature over flat topography.

Note: Signature lengths can be easily calculated when using line vector data in lieu of a raster SPI dataset [see Average SPI value metric below].

Average SPI value – The portions of a signature with the highest SPI values have the greatest potential to erode the landscape. The overall SPI value of a signature flow path can be visualized using a smoothed or “stretched” color gradient.

Note: Advanced GIS users may prefer a quantitative approach over this qualitative visualized one by converting a reclassed SPI raster to polyline vector data. Individual SPI statistics can then be calculated for each signature. The mean, minimum, maximum, sum, and standard deviation can be particularly useful for prioritization purposes. Signature length can also be easily calculated if using line vectors.
contributing area – The contributing area
land of CSAs can be used to estimate the
amount of potential sediment and nutrient
delivery at those pour points. Contributing
areas can be manually created by “heads-up”
digitization using elevation contours, or by
using third party software to automatically
create catchments. A free-to-use
ArcToolbox set is available from the Natural
Resource Conservation Service (NRCS)
med ‘NRCS GIS Engineering Tools
v1.17’ which allows creation of contributing
area catchments from a user defined point
long with many other great scripts). The
image on right shows an example of the
RCS tool’s Watershed Delineation toolset
over an SPI layer and orthophoto. The acres
and average slope are automatically
calculated as shown.

See Appendix section A.6 for step-by-
step instructions for watershed creation
using the NCRS tool.

- Land use/land cover – land cover
information can aid initial large-scale
screenings for CSAs and be used to
filter out use-types that are of low
priority. Historical land use
information combined with historic
aerial photos can also be a great asset
for checking crop rotation practices at
the field scale. For instance, priorities
can be targeted to fields identified as
implementing several sequential
seasons of continuous corn.

The image on left shows land cover in
• Proximity to water – Signatures that terminate in or near surface waters are typically of highest concern, though the exact location of the CSA point placement may vary depending on project goals. For instance, if agricultural funds are to be used to install BMPs in upland areas, users might only target upland field SPI signatures and place points at field edges, whereas TMDL concerns may shift user focus to riparian areas and signatures entering waterways.
  o Note: Advanced users may wish to create an SPI layer clipped from a stream corridor buffer for riparian-only CSA identification, and vice versa for upland-only identification.

The grey horizontal lines represent the extent of the stream buffer. The top signature terminates at the buffer-field edge. The lower signatures terminate at the stream edge. Note: the bottom middle signature terminates just past the buffer. A field visit verified a steep knick point drop to water level at the signature.

• Existing conservation – Conservation practices (CPs) may already exist that address located CSAs, some of which may be evident using high resolution aerial photos. Local knowledge of existing best management practices and conditions should be used when locating CSAs. It should be noted that the presence of CPs shouldn’t necessarily eliminate the placement of a CSA unless the condition of the practice is known. All CPs have a useful lifespan, and their condition cannot always be ascertained from GIS and remotely sensed data.
The three images, starting from the furthest left, show an SPI signature leading to an intermittent stream. The middle image shows conservation practices exist under the SPI signature, in this case a grassed waterway. Using color infrared (CIR) orthophotos, shown in the right image, can also greatly aid in detecting vegetated areas.
Sub-catchment soil characteristics – A Soil Erosion Risk raster layer can be used to display areas with high soil sheet and rill erosion risk. The raster layer is available as part of the Minnesota Environmental Benefits Index (EBI) series from the Minnesota Board of Water & Soil Resources (BWSR) website (see ‘Data acquisition’ section for link). Based off the Universal Soil Loss Equation (USLE), the 30 meter spatial resolution raster was calculated using rainfall erosivity (R), soil erodibility (K), and topographic length and slope factors (LS). The cropping management (C) and conservation practice (P) factors were omitted (CP=1) as they would warrant field specific data that is not readily available.

The Soil Erosion Risk raster layer, much like SPI/CTI layer(s), is most useful when displayed with values above a certain threshold. These can be created in the same manner as the percentile thresholds calculated previously with SPI and/or CTI layers. Common thresholds used to display areas of elevated soil erosion risk can range from the top 30% of values and up, though with inherent USLE factor and source data variability, users may find useful thresholds significantly below that range.
SSURGO soils data – The NRCS Soil Survey Geographic Database (SSURGO) is a large collection of soil-related data that can be used to inform CSA identification. The SSURGO nationwide database contains a multitude of information sorted within unique soil map units. SSURGO data can also be integrated within the ArcGIS environment by use of the NRCS Soil Data Viewer extension which provides the ability to visually map each individual criterion with matching attributes. Available data range from physical soil properties to construction, development, and planning suitabilities (see next image). Several criteria within the database can be of particular use for CSA identification, including depth to water table, ponding and flooding frequency, crop productivity index, drainage class, and hydric rating, among others.
Building site development interpretations are designed to be used as tools for evaluating soil suitability and identifying soil limitations for various construction purposes. As part of the interpretation process, the rating applies to each soil in its described condition and does not consider present land use.

Example interpretations can include: soil suitable for construction, soil not suitable for construction, and soil with limitations. Example interpretations can include: soil suitable for construction, soil not suitable for construction, and soil with limitations.
3. When suitable locations have been identified for CSA placement, start editing on your CSA point shapefile/feature class.
   - **ArcGIS ver. 9.x**: Using the editor toolbar:
     
     ![ArcGIS Editor Toolbar](image)

     Set the Task pull down to “Create New Features” and the Target to your CSA point layer. Use the Sketch function (the pencil-shaped icon) to place a single geographic CSA point on the map with each click. 
     *Note:* You can use the Undo button or press Ctrl+Z to remove the last point placed while editing.

   - **ArcGIS ver. 10.x**: Start an editing session with the CSA point layer and the Create Features window will open. Select the CSA point layer in the Create Feature window. At the bottom of the window under **Construction Tools**, click the Point button.

     ![Construction Tools](image)

     The cursor will turn into a point editor, and each click on the map will place a geographical point at that location.

4. When finished creating new features, save your edits, and stop editing using the Editor toolbar pull down menu.
**CSA output and evaluation**

Once the Critical Source Area point layer has been completed, it can be used to create physical and digital maps, and exported into a variety of mobile devices to guide field work. Common mobile devices include:

- Tablets with ArcGIS for Windows Mobile installed (one mobile deployment license is included with each ArcGIS Desktop license)
- iPad with ArcGIS free app
- Handheld GPS units with a Windows mobile operating system installed

The accompanying Field Assessment Manual can aid in data collection and evaluation during field visits. An overall determination of site status at each CSA should be made, e.g.:

- Where appropriate conservation measures are in place, recognize good site management
- Where improvements could be made, suggest possible conservation measures
- Where CSA tools were in error, record the findings (tracking errors will improve both the GIS protocols and a GIS professional’s judgment that is required during evaluation)
Appendix

A.1 Digital terrain analysis accuracy results

Table 2 shows comparisons between the Sediment Delivery Potential (SDP) of erosional features identified or not identified in several Dodge Co., MN study areas using the GIS–based validation survey technique and a 97.5th percentile threshold calculated from each HUC12 study area.

SDP scores consist of three incremental values of risk: low, medium, and high (1, 2, and 3 respectively). The score was determined by a field technician’s best professional judgment. Some of the factors that influenced the SDP score include general size and position of the feature in the landscape, the size of the drainage contributing area, and obvious indicators of sediment delivery, such as active alluvial fans. Although subjective, these SDP scores provide qualitative categories that can be used to compare the relative impact of gullies on potential water quality degradation (Galzki et. al., 2011).

<table>
<thead>
<tr>
<th>SDP value of erosional features</th>
<th>Validation result</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Features identified</td>
</tr>
<tr>
<td>1 (Low)</td>
<td>44</td>
</tr>
<tr>
<td>2 (Medium)</td>
<td>23</td>
</tr>
<tr>
<td>3 (High)</td>
<td>8</td>
</tr>
<tr>
<td>Total</td>
<td>75</td>
</tr>
</tbody>
</table>

In total, 96 features (gullies, ravines, tile outlets, bank slumps, grassed waterways) were identified in the field.

21 out of 96 (22%) field surveyed points were not closely related to a 97.5th percentile SPI signature (errors of omission). 15 of these points had sediment delivery potentials (SDP) of 1 (lowest risk) and the remaining 6 had SDPs of 2 (medium risk).

74 out of 139 (53%) CSA prediction points combined in all study areas were not closely related to an erosional feature during the field survey (commission errors or false positives).

The ‘Total’ row is showing that out of the 96 features identified, 75 were closely associated with an SPI signature from GIS terrain analysis, and 21 were not (omission errors).
errors). The commission errors, also known as false positives, are predicted CSA points (there were 139 in total) placed using preliminary GIS analysis that were not closely associated with a field surveyed location.

The following two figures contain boxplots using data from the same Dodge Co. study areas. Figure 7 compares a 1-10 SPI rank to erosional feature SDP assigned values. The lower limit of the box represents the 1st quartile, the top limit is the 3rd quartile, and the middle solid line is the median value of the data. The whiskers are 1.5x the inner quantile range, with dots representing outliers. Figure 8 shows the same boxplot configuration with a comparison made between field verified points vs. an equal number of randomly generated points.
Table 3 shows comparisons between the Sediment Delivery Potential (SDP) of erosional features identified or not identified in several Wabasha Co., MN study areas using the GIS–based validation survey technique with a 97.5th percentile threshold.

Table 19

<table>
<thead>
<tr>
<th>SDP value of erosional features</th>
<th>Features identified</th>
<th>Features not identified</th>
<th>Total erosional features identified</th>
<th>Accuracy (%)</th>
<th>Commission errors</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 (Low)</td>
<td>12</td>
<td>1</td>
<td>13</td>
<td>92%</td>
<td>N/A</td>
</tr>
<tr>
<td>2 (Medium)</td>
<td>15</td>
<td>3</td>
<td>18</td>
<td>83%</td>
<td>N/A</td>
</tr>
<tr>
<td>3 (High)</td>
<td>3</td>
<td>0</td>
<td>3</td>
<td>100%</td>
<td>N/A</td>
</tr>
<tr>
<td>Total</td>
<td>30</td>
<td>4 (omission errors)</td>
<td>34</td>
<td>88%</td>
<td>12 of 34 pts</td>
</tr>
</tbody>
</table>

In total, 34 features (gullies, ravines, tile outlets, bank slumps, grassed waterways) were identified in the field.

4 out of 34 (12%) field surveyed points were not closely related to a 97.5th percentile SPI signature (errors of omission). One of the points had an SDP of 1, and three had SDPs of 2 – one of which was a slumping feature which typically do not have SPI signatures relating to them.

10 out of 34 (29%) field surveyed points were not closely related to a 99th percentile SPI signature (errors of omission). The majority of these points had estimated SDPs of 2. *This is not shown in the above table.*

12 out of 34 (35%) CSA prediction points were not closely related to an erosional feature during the field survey (commission errors or false positives).

The ‘Total’ row is showing that out of the 34 features identified, 30 were closely associated with an SPI signature from GIS terrain analysis, and 4 were not (omission errors). The commission errors, also known as false positives, are predicted CSA points (there were 34 in total, it was a coincidence that there were also 34 field points) placed using preliminary GIS analysis that were not closely associated with a field surveyed location.

The following two figures contain boxplots using data from the same Wabasha Co. study areas. Figure 9 compares a 1-10 SPI rank to erosional feature SDP assigned values. The lower limit of the box represents the 1st quartile, the top limit is the 3rd quartile, and the middle solid line is the median of the data. The whiskers are 1.5x the inner quartile range, with dots representing outliers. Figure 10 shows the same
boxplot configuration with a comparison made between field verified points vs. an equal number of randomly generated points.

Figure 9

Figure 10
The following table and figure (Table 4 and Figure 11) were taken from the 2011 Galzki, et al. paper, published in the Journal of Soil and Water Conservation. They show terrain analysis accuracy results in the same format presented in the two proceeding examples. Galzki’s study was conducted in two watersheds, named Beauford and Seven Mile Creek, within the Minnesota River basin, near Mankato, MN.

Table 20

Comparison between gully features identified or not identified in Seven Mile Creek watershed using the geographic information system–based validation survey technique with an 85th percentile threshold.

<table>
<thead>
<tr>
<th>Feature*</th>
<th>Identified</th>
<th>Not identified</th>
<th>Total features present</th>
</tr>
</thead>
<tbody>
<tr>
<td>SDP 3 gully</td>
<td>31</td>
<td>1</td>
<td>32</td>
</tr>
<tr>
<td>SDP 2 gully</td>
<td>17</td>
<td>5</td>
<td>22</td>
</tr>
<tr>
<td>SDP 1 gully</td>
<td>17</td>
<td>12</td>
<td>29</td>
</tr>
<tr>
<td>Total</td>
<td>65</td>
<td>18 (omission errors)</td>
<td>83</td>
</tr>
<tr>
<td>False positive</td>
<td>43 (omission errors)</td>
<td>–</td>
<td>–</td>
</tr>
</tbody>
</table>

Notes: SDP = sediment delivery potential. – = not applicable.
* A lower value of SDP indicates lower sediment delivery potential and a smaller catchment area.
Figure 11
Comparison of flow accumulation (FA) and stream power index (SPI) for random points versus field-sampled gully points in the Seven Mile Creek watershed. The whisker ends represent the 99% confidence interval.
A.2 Create Area of Interest DEM manually using Clip

- **Clip DEM Raster**
  
  Minnesota LiDAR data acquired at the county level can contain very large file sizes. It is therefore important to minimize the spatial area to be processed to reduce output files sizes and increase processing times. The Clip ArcMap tool creates a subset of a raster dataset and will be used for this purpose.
  
  - *Note:* There are two Clip tools in the ArcToolbox – only one of which will create a subset of raster data.

1. Open **Data Management Tools > Raster > Raster Processing > Clip**

![Clip tool interface]

2. **Input Raster:** Your DEM

3. **Output Extent (optional):** A raster or vector (point, line, or polygon) layer that covers the full extent of you AOI. For example, this could be a shapefile/feature class that you created yourself, HUC12 catchment(s), any digitized landscape feature, etc.
4. Check the box next to **Use Input Features for Clipping Geometry (optional)**.

5. **Output Raster Dataset**: Browse to output workspace and name with something you can remember, e.g. 'dem_clipped'.

6. Click OK to run. The clipped output surface raster is added to your map as a new layer.
A.3 Create Stream Power Index for ravine identification

A ravine is defined as a small, narrow and deep depression, smaller than a valley, and larger than a gully (Bates and Jackson, 1984). Ravines grow by head cutting action, but unlike gullies, are too large to be transversed by farm equipment.

Researchers in the UMN Dept. of Soil, Climate & Water developed an algorithm to aid in ravine identification while working in the Minnesota River Basin. The algorithm output is a topographic indice similar to the Stream Power Index, but includes aspect information which takes concave ravine profiles into account. This algorithm consists of slope steepness greater than 7%, standard deviation of aspect greater than 40%, and a flow accumulation threshold between 200 and 7400 cells, depending on topography.

Starting from the procedures outlined in the Digital Terrain Analysis Manual, the ravine algorithm will begin with a Digital Elevation Model.

The algorithm output generally displays best results when pit filling is included during DEM pre-processing. This is explained in the ‘Pre-process DEM’ section.

The Slope and Aspect raster layers are calculated directly from the DEM as shown in the ‘Calculate primary attributes’ section. Remember to use ‘PERCENT_RISE’ in the arctool output measurement. The Flow Accumulation raster is also used for the algorithm, and thus a Flow Direction raster will need to be created before Flow Accumulation.

1. The **Reclassify** tool will be used to set the raster layer parameters for the ravine algorithm. Starting with the Slope raster layer, open the **Reclassify** Tool:
   a. In ArcMap, open **ArcToolbox > Spatial Analyst Tools > Reclass > Reclassify**
b. **Input raster:** Your Slope (slope_dem) layer.

c. **Reclass field:** This should default to ‘Value’

d. **Reclassification:** Click on the ‘Classify…’ button.
   o Using the classification method pull down, select Equal Interval, and select 1 from the Classes pull down.
   o Click the ‘Exclusion…’ button and type ‘0-7’ (without quotes) in the exclusion value field, and then click OK.
   o Click OK at the bottom right of the Classification window to return to the Reclassify tool.

e. **Output raster:** Browse to output workspace and name output layer ‘slope_ravine’

f. Check the box next to **Change missing values to NoData (optional)**

g. Click OK to run. The output raster is added to your map as a new layer.
2. Open the **Reclassify** tool again to process the **Flow Accumulation** raster layer:

![Reclassify Tool Image]

- **Input raster:** Your Flow Accumulation (flowacc_dem) layer.
- **Reclass field:** This should default to ‘Value’
- **Reclassification:** Click on the ‘Classify…’ button.
  - Using the classification method pull down, select Equal Interval, and select 1 from the Classes pull down.
  - Click the ‘Exclusion…’ button. The best exclusion range used here will vary depending on the overall topography steepness. As a general guideline: for steepest slopes, type ‘0-7400’ in the exclusion range (without quotes), and for shallow slopes, type ‘0-200’.
  - Click OK at the bottom right of the Classification window to return to the Reclassify tool.
- **Output raster:** Browse to output workspace and name output layer ‘fa_ravine’
- **Change missing values to NoData (optional)**
- Click OK to run. The output raster is added to your map as a new layer.
3. The **Aspect** raster layer is first processed using the **Focal Statistics** arctool before being reclassified. To begin processing the **Aspect** raster:

   a. In ArcMap, open **ArcToolbox > Spatial Analyst Tools > Neighborhood > Focal Statistics**

   ![Focal Statistics Tool](image)

   b. **Input raster**: Your Aspect (aspect_dem) layer
   c. **Output raster**: Browse to output workspace and name output layer ‘aspect_FS’
   d. **Statistics type (optional)**: Select ‘STD’ (standard deviation) from the pull down menu.
   e. Leave the other options as default (as shown above) and click OK to run. The output raster is added to your map as a new layer
4. Open the **Reclassify** tool once more to continue processing the **Aspect** raster layer:

   ![Reclassify Tool](image)

   a. **Input raster:** Your Aspect Focal Statistics raster layer from the previous step (aspect_FS)
   
   b. **Reclass field:** This should default to ‘Value’
   
   c. **Reclassification:** Click on the ‘Classify…’ button
      - Using the classification method pull down, select Equal Interval, and select 1 from the Classes pull down.
      - Click the ‘Exclusion…’ button and type ‘0-40’ (without quotes) in the exclusion value field, and then click OK.
      - Click OK at the bottom right of the Classification window to return to the Reclassify tool dialog.

   • **Note:** The ‘Old values’ range listed may not be rounded to 40. It is okay to leave the value as is, or simply click the value and change it to 40, without decimals. The same is true for previous Slope and Flow Accumulation reclassifications.
d. **Output raster**: Browse to output workspace and name output layer ‘aspect_ravine’

e. Check the box next to **Change missing values to NoData** (optional)

5. Click OK to run. The output raster is added to your map as a new layer. Now that all these raster layers have been reclassified into single-level rasters, the **Extract by Mask** ArcTool will be used to extract only the pixels from all three layers that overlay each other.

a. In ArcMap, open **ArcToolbox > Spatial Analyst Tools > Extraction > Extract by Mask**

![Extract by Mask](image)

b. **Input raster**: Your reclassified Aspect layer ‘aspect_ravine’

c. **Input raster or feature mask data**: Your reclassified Slope raster ‘slope_ravine’

d. **Output raster**: Browse to output workspace and name output layer ‘aspslop_mask’

e. Click OK to run. The output raster is added to your map as a new layer

6. The **Extract by Mask** ArcTool will be used one more time to create the final ravine raster.

a. In ArcMap, open **ArcToolbox > Spatial Analyst Tools > Extraction > Extract by Mask**
b. **Input raster:** Your reclassified Flow Accumulation layer ‘fa_ravine’

c. **Input raster or feature mask data:** Your Aspect/Slope masked raster from the previous mask iteration ‘aspslop_mask’

d. **Output raster:** Browse to output workspace and name output layer ‘ravines’

e. Click OK to run. The final Ravine output raster is added to your map as a new layer
A.4 Calculating thresholds using R statistical package

It may be preferable to use a dedicated statistical software program to calculate percentile thresholds, as they are capable of handling large data sets. Though most any statistical program can be used for this calculation, R is recommended as it’s both free to use and able to process simple to complex functions. The calculation of thresholds using R is straightforward and will require downloading and installing the R stats package along with a small add-on.

1. **Acquire and install R**
   
   Download R for your Windows, Mac, or Linux operating system from the following link: [http://cran.r-project.org/bin/windows/base/old/2.14.2/](http://cran.r-project.org/bin/windows/base/old/2.14.2/)
   
   - **Note:** It is recommended to install R version 2.14.2 for full compatibility with maptools.

2. **Launch the R application.** RGui will open with an active R Console window. The R console contains a command line that will be used for all R function inputs.
3. Install and load the maptools add-on package. This will allow the user to import dbf files directly into R.
   a. To install maptools, type in command line:

   ```r
   install.packages("maptools", repos = "http://cran.case.edu")
   ```

   If prompted to use personal library, choose Yes.
   Note: Make sure computer is connected to internet for this step.

   b. Load maptools package into R by typing in command line:

   ```r
   library(maptools)
   ```

   Note: The maptools package will need to be loaded into R each time the application is run using the above command. It will only need to be installed one time.

4. Prepare data for import into R. When exporting raster layer data for R input, any NoData cells around the area of interest will be exported as well. To circumvent NoData cells in exported data, convert raster cells to point shape data by using the **Raster to Point** Arctool as follows:

   a. Open **ArcToolbox > Conversion Tools > From Raster > Raster to Point**

   ![Raster to Point](image)

   b. **Input raster**: your SPI or CTI layer.

   c. **Output point features**: Browse to output workspace and name output layer either spi_points or cti_points.
o  Note: Avoid storing the output feature in a geodatabase, as the .dbf table will be inaccessible from that location. Instead, store it in a folder as a shapefile.

d. Click OK to run.
  o  Note: The output from the **Raster to Point** shapefile contains three types of files, one of which is a .dbf file that contains attribute information. In this case, it contains each 3x3 meter cell value needed to compute a threshold (assuming a 3m DEM was used).

5. **Import data into R**
   a. We will import the **Raster to Point** shapefile’s .dbf table computed previously. Recall the output location of that file. R uses programming language that is case sensitive and requires certain formatting. We will use the following format for the **read** import function:

   ```r
   identifier <- read.dbf("directory address/file_name.dbf")
   ```

   The identifier is a user created name assigned to data and is therefore not case sensitive. It cannot contain spaces. Users should adopt naming conventions using either no space or a period (.) symbol as a separator to make reading, sharing, and verifying code easier. The address location must use forward slash (/) as the directory separator.

   Example of **read** import syntax:

   ```r
   SPIpoints <- read.dbf("C:/My GIS data folder/spi_points.dbf")
   ```

   Press enter once the command has been typed. There should be no messages displayed.

   Note: The program may not be responsive for a few minutes depending on the size of the imported file.

   b. Check your imported data’s header and make note of the column names by using the head function in the R console:

   ```r
   head(your.identifier.name)
   ```

   Example:

   ```r
   head(SPIpoints)
   ```
The exact name of the raster value’s column is needed for threshold calculations. Typically, Raster to Point dbf files use ‘GRID_CODE’ for the raster value column name.

6. **Calculate threshold percentile values**

   Percentiles are calculated using the quantile function in R.

   \[
   \text{quantile(your.identifier.name}\$\text{raster\_value\_column\_name, percentile)}
   \]

   The ‘your.identifier.name’ is taken from previous step a; ‘raster\_value\_column\_name’ is taken from previous step b; and percentile is recognized in R as a probability statement – any numerical value between 0 and 1 can be used.

   *Note*: a list of several percentiles can be used in one command line by using c(percentile1, percentile2,…percentileN)

   **Examples:**

   \[
   \text{quantile(spi.points}\$\text{GRID\_CODE, .85)}
   \]  
   #one percentile
   \[
   \text{quantile(SPIpoints}\$\text{GRID\_CODE, c(.9, .95, .975, .99))}
   \]  
   #multiple percentiles
> quantile(spi.points$GRID_CODE, c(.9, .95, .975, .99))
  90%   95%   97.5%   99%  
-0.3947131  0.4792112  1.4413573  2.6114289
>

A.5 Determine the cell count of your raster layer of interest

1. Double click on the layer in the table of contents window.
2. In the symbology tab, select ‘classified’ in the left window. If asked to calculate a histogram, say yes.
3. Click on the ‘Classify…’ icon.
4. The number of records in the raster layer will be displayed in the top right under Classification Statistics as Count. This can also be thought of as the population size of the SPI raster.

5. Click cancel on both windows to revert back to your original symbology.
A.6 Delineate catchments using NRCS GIS Engineering Tools

The contributing area upland of CSAs can be used to estimate the amount of potential sediment and nutrient delivery at those pour points. The Natural Resource Conservation Service (NRCS) offers a free tool called ‘NRCS GIS Engineering Tools v1.17’ which allows creation of contributing area catchments from a user defined point.

1. Define Area of Interest
   a. In the NRCS Engineering Tools toolbox, expand Watershed Tools followed by Watershed Delineation and double click the Define Area of Interest tool script.
b. **Browse to and Select Workspace:** Choose your workspace folder where outputs will be stored

c. **Input DEM:** Your DEM, preferably a 3m LiDAR elevation dataset.

d. **Enter your Area of Interest:** Click the **Add feature** icon (1 circled red in above image), then minimize the **Define Area of interest** window. The add feature tool works as a polygon editor, with each click creating a new vertex. The sketch is finished by double clicking to connect the first and last sketch vertices.

e. **Interval for Contours (feet) (optional):** Select desired contour foot contours. If left blank, no contours will be created

f. **Choose DEM Elevation Units (optional):** User preference

g. Click OK to run tool script. Several new layers will be added to your map

2. **Create Stream Network**

   a. In the **NRCS Engineering Tools** toolbox, expand **Watershed Tools** followed by **Watershed Delineation**, and double click the **Create Stream Network** tool script
b. **Select Project_AOI feature:** Select the AOI that was created by the previous Define Area of Interest tool

c. **Digitize Culverts (optional):** Click the Add feature icon 2 circled in red above then minimize the current window. The add feature function works as a line sketch tool. Use the function to make a line that represents a culvert at any obvious or known locations where a culvert exists. The DepthGrid layer created by the previous tool can aid in showing where water backs up at impoundments such as road crossings. Culverts are likely to exist at these locations. Create as many digitized culverts as necessary to ensure an accurate stream network representation.

d. **Enter Stream Threshold in Acres:** This value is the minimum contributing area required to form a stream. The default value of 1 is adequate in most situations and will form stream headwaters near catchment boundaries.

e. Click OK to run tool script
3. Create Watersheds
   a. In the NRCS Engineering Tools toolbox, expand Watershed Tools followed by Watershed Delineation, and double click the Create Watershed tool script

   ![Create Watershed window]

   Select A0I Stream Network Feature: Select the stream network feature that was created by the previous Create Stream Network tool

   c. Digitize Outlets: Click the Add feature icon 3 circled in red above then minimize the current window. The add feature function works as a line sketch tool. Each click adds a vertex and double clicking ends the sketch. Use the function to make a small line perpendicular to any stream outlets where a watershed is to be created. A catchment will be created upstream of the digitized outlet line(s).

   d. Click OK to run tool script. The watersheds will be added to your map as a new layer
e. **Enter Stream Threshold in Acres:** This value is the minimum contributing area required to form a stream. The default value of 1 is adequate in most situations and will form stream headwaters near catchment boundaries.
Field Assessment Manual

Zumbro River Watershed Restoration
Prioritization & Sediment Reduction Project

2014
Field Assessment Manual

Overview

This document provides data collection protocols and forms for conducting field assessments associated with the ZWP Priority Management Zone (PMZ) and Critical Source Area (CSA) project. The project is seeking to determine the feasibility of using existing LiDAR data and other GIS data to identify and rank a preliminary list of the top 50 CSAs for the Zumbro River watershed. The areas from the list will then be targeted for best management practices (BMPs) implementation as they will have more significant, larger-scale, water-quality benefits. For this project, GIS software is used to perform a terrain analysis, which uses elevation data to characterize the physical features of the landscape. Terrain analysis can be used to identify locations with a high potential for erosion and pollutant runoff. These identified source areas then can be assessed for further evaluation. Additional spatial analyses also are incorporated, including soil erosion risk and source proximity to a water body. Terrain analysis and other spatial analyses do not eliminate the need for field assessments. However, they can reduce the amount of time spent in the field and enhance data collection efforts by enabling technicians to select potentially sensitive sites.

For this part of the project, field procedures are conducted to both complement and evaluate the performance of the GIS analysis. The field assessments can be used to assess the adequacy of the spatial analysis in predicting critical source areas. These results, though mainly qualitative, can also be used to provide substantial insight into locating bank-related PMZ and CSA sites of concern. In addition, the GIS analysis can be enhanced using field data to generate an inventory of streambank locations in need of stabilization. Field collection methods used to develop the inventory are designed to inform managers regarding the extent of sensitive banks and provide efficient information transfer to subsequent evaluation teams.

It is important to note that many of the sites identified as sensitive by the GIS analysis will already have appropriate management and operation. Thus, these tools also provide an important opportunity to recognize producer accomplishments and track program progress necessary for supporting basin management and Total Maximum Daily Load efforts.

This document is divided into three sections. As field technicians gain experience with the tools over time, they have the flexibility to carry only the sections needed. The three sections are as follows:

1) Section one provides a decision flow chart that provides guidance for selecting sites and tools, as well as conducting field assessments.
2) Section two provides the data collection forms to be used when conducting the field assessments. This section is intended to become all that experienced field staff will need to perform a PMZ or CSA lead implementation plan and/or targeting a site’s implementation needs.

3) Section three provides detailed protocols for collecting data associated with the field survey data and streambank erosion assessment forms.

District staff will use the following forms to record field data:

- **Field Survey Data Sheet**: On this form, staff will record general site information, including site location and general Ag field and channel conditions. Staff will walk the field edge and riparian corridor and note any pour points, defined as channelized flow from the field to an outlet, such as surface water. Tile intakes also are considered pour points. This information will be recorded on the Field Survey Data Sheet. While walking in or near the channel, staff will note any stream bank erosion and record information using the Streambank Erosion Assessment Form. The Field Survey Data Sheet may also be used in lieu of the assessment form if only minor to moderate slumping is evident.
Yr 2, 3, ..., Update Terrain Analysis for Sensitive Sites based on new science and field findings

Use Terrain Analysis to Select and Prioritize Sensitive Sites

Create Sensitive Site List (e.g., n=30)

Adjust List Based on Office Knowledge

Work with Local Stakeholders for Information

Schedule Site Visit Rotation

Yr - 1
n = 1 to 10

Complete Upland Field and Channel Forms

Are Erosion Concerns Present?

Yes

Acknowledge sites that are well-maintained

No

Work with Local Stakeholders for Information

Yr - 2
n = 11 to 20

Complete Upland Field and Channel Forms

Are Erosion Concerns Present?

Yes

Work with issues on selected sites

No

Adjust List Based on Office Knowledge

Yr - 3
n = 21 to 30

Complete Upland Field and Channel Forms

Are Erosion Concerns Present?

Yes

Work with issues on selected sites

No

Adjust List Based on Office Knowledge

Sensitive sites prioritization list

Acknowledgment sites that are well-maintained

1. 
2. 
3. 

---

- Yr 1: n = 1 to 10
- Yr 2: n = 11 to 20
- Yr 3: n = 21 to 30

- Complete Upland Field and Channel Forms
- Are Erosion Concerns Present?
- Acknowledge sites that are well-maintained
- Work with issues on selected sites

- Schedule Site Visit Rotation
- Adjust List Based on Office Knowledge
- Work with Local Stakeholders for Information

- Decision Tree
For a full description and protocol of the flow pathway, please see the Sensitive Site Identification Protocol.

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td><strong>Star</strong></td>
</tr>
<tr>
<td></td>
<td>- Determine management objectives (PMZ and CSA)</td>
</tr>
<tr>
<td></td>
<td>- Select terrain analysis tools that fit with identified objectives</td>
</tr>
<tr>
<td>2</td>
<td><strong>Use Terrain Analysis to Select and Prioritize Sensitive Sites</strong></td>
</tr>
<tr>
<td></td>
<td>- Run selected tools</td>
</tr>
<tr>
<td></td>
<td>- Use analysis results to identify high-priority sites</td>
</tr>
<tr>
<td>3</td>
<td><strong>Create Sensitive Site List</strong></td>
</tr>
<tr>
<td></td>
<td>- Determine an appropriate number of sites to select for further examination</td>
</tr>
<tr>
<td></td>
<td>- Base the list length on management objectives and available resources</td>
</tr>
<tr>
<td></td>
<td>- Determine the number of sites that can be visited each year</td>
</tr>
<tr>
<td></td>
<td>- Populate site list using highest-ranked sites from terrain analysis results</td>
</tr>
<tr>
<td>4</td>
<td><strong>Adjust List Based on Office Knowledge</strong></td>
</tr>
<tr>
<td></td>
<td>- Review site list for obvious errors in terrain analysis results</td>
</tr>
<tr>
<td></td>
<td>- Move sites with known management practices that address issues to Acknowledgement List</td>
</tr>
<tr>
<td>5</td>
<td><strong>Work with Local Stakeholders for Information and Access</strong></td>
</tr>
<tr>
<td></td>
<td>- Reach out to local producers to share project goals</td>
</tr>
<tr>
<td></td>
<td>- Gather information on site practices to refine target list</td>
</tr>
<tr>
<td></td>
<td>- Identify producers who are willing to allow site access</td>
</tr>
<tr>
<td>6</td>
<td><strong>Schedule Site Visit Rotation</strong></td>
</tr>
<tr>
<td></td>
<td>- Work with producers to schedule site access (only a portion of the sites will be visited in a given year)</td>
</tr>
<tr>
<td></td>
<td>- Establish a longer-term schedule rotation for re-visiting sites</td>
</tr>
<tr>
<td>7</td>
<td><strong>Visit Sites Selected for Given Year</strong></td>
</tr>
<tr>
<td></td>
<td>- Conduct assessments of the identified sites</td>
</tr>
<tr>
<td></td>
<td>- Ensure assessor has permission to access site prior to conducting examinations</td>
</tr>
<tr>
<td>8</td>
<td><strong>Complete Upland Field and Channel Forms</strong></td>
</tr>
<tr>
<td></td>
<td>- Record the findings on the assessment protocol forms, communicating institutional memory</td>
</tr>
<tr>
<td></td>
<td>- Compare field assessments to terrain analysis results</td>
</tr>
<tr>
<td>9</td>
<td><strong>Are Erosion Concerns Present?</strong></td>
</tr>
<tr>
<td></td>
<td>- Use field assessment to identify presence of erosion concerns</td>
</tr>
<tr>
<td></td>
<td>- Note whether concerns are being addressed by management practices</td>
</tr>
<tr>
<td>10</td>
<td><strong>Generate Acknowledgement and Issue Lists</strong></td>
</tr>
<tr>
<td></td>
<td>- Place well-maintained fields on acknowledgement list</td>
</tr>
<tr>
<td></td>
<td>- Place fields in need of additional management practices on list of concerns</td>
</tr>
<tr>
<td></td>
<td>- Work with landowners to increase management on sites of concern</td>
</tr>
<tr>
<td></td>
<td>- Maintain master list that includes sites of concern and acknowledgement sites</td>
</tr>
<tr>
<td>11</td>
<td><strong>Update Terrain Analysis for Sensitive Sites</strong></td>
</tr>
<tr>
<td></td>
<td>- Revisit sensitive site list periodically</td>
</tr>
<tr>
<td></td>
<td>- Add new sensitive sites as evaluated sites move to acknowledgement list</td>
</tr>
<tr>
<td></td>
<td>- Conduct new terrain analyses as necessary to update sensitive site identification when:</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### Field Survey Data Sheet

<table>
<thead>
<tr>
<th>Site ID#</th>
<th>Streambank Location</th>
<th>Discharges to…</th>
<th>Feature</th>
<th>Flow Orientation</th>
<th>Photo #</th>
<th>Land Use</th>
<th>Tillage Direction</th>
<th>Tile Style</th>
<th>% Crop Residue</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Left bank Left bank</td>
<td>Perennial stream</td>
<td>Culvert</td>
<td>N</td>
<td>#</td>
<td>Corn</td>
<td>N</td>
<td>Clay</td>
<td>0-15%</td>
</tr>
<tr>
<td></td>
<td>Right bank Right bank</td>
<td>Intermittent stream</td>
<td>Drop structure</td>
<td>NE</td>
<td></td>
<td>Soybean</td>
<td>NE</td>
<td>Corrugated metal pipe</td>
<td>15-30%</td>
</tr>
<tr>
<td></td>
<td>Note: while looking downstream</td>
<td>Grassy waterway</td>
<td>Gully</td>
<td>E</td>
<td></td>
<td>Alfalfa</td>
<td>E</td>
<td>Plastic</td>
<td>&gt;30%</td>
</tr>
<tr>
<td></td>
<td>Other:</td>
<td></td>
<td>Open intake</td>
<td>SE</td>
<td></td>
<td>Wheat</td>
<td>SE</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Side inlet</td>
<td>S</td>
<td></td>
<td>Pasture</td>
<td>S</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Slumping</td>
<td>SW</td>
<td></td>
<td>Forest</td>
<td>SW</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Exploded tile</td>
<td>W</td>
<td></td>
<td>Other:</td>
<td>W</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Ravine</td>
<td>NW</td>
<td></td>
<td>__________</td>
<td>NW</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Other:</td>
<td>__________</td>
<td></td>
<td>__________</td>
<td>__________</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>__________</td>
<td>__________</td>
<td></td>
<td>__________</td>
<td>__________</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Vegetative Buffer</th>
<th>Buffer Condition</th>
<th>Buffer Width (ft)</th>
<th>Sediment Delivery Potential (1-3)</th>
<th>Gully/Slumping Width (ft)</th>
<th>Gully/Slumping Depth (ft)</th>
<th>Gully/Slumping Length (ft)</th>
<th>Intake Distance (ft)</th>
<th>Intake Size (in)</th>
<th>Tile Size (in)</th>
<th>Comments:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Yes</td>
<td>0</td>
<td>1</td>
<td>Manure App Evidence</td>
<td>Yes</td>
<td>BMP Recommendations</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>No</td>
<td>0</td>
<td>1</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Note: while looking downstream Describe location & direction taken; provide drawing if necessary

Date (xx/xx/xxxx)

Vegetative Buffer Condition

- Yes
- No

Buffer Condition

- 0
- 1
- 2
- 3
- 4

Manure App Evidence

- Yes
- No

BMP Recommendations

- Yes
- No

Intake Size

- (in)

Tile Size

- (in)
**Streambank Erosion Assessment Form**

*For detailed procedures on completing this worksheet, please see Manual page 12*

<table>
<thead>
<tr>
<th>Field ID:</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>GPS:</td>
<td></td>
</tr>
<tr>
<td>Date:</td>
<td></td>
</tr>
<tr>
<td>Prepared By:</td>
<td></td>
</tr>
</tbody>
</table>

**Field Conditions (e.g. weather):**

<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Impacted by Livestock Access</strong></td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td><strong>Impacted by Equipment Access</strong></td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
<td>No</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Riparian Cover Type</th>
<th>Perennial Cover</th>
<th>Managed Land Uses Within 10 ft of water body</th>
</tr>
</thead>
<tbody>
<tr>
<td>Riparian Perennial Cover Quality</td>
<td>Woody Grass</td>
<td>Road Homestead Crop Grazed Livestock heavy use area</td>
</tr>
<tr>
<td></td>
<td>Good</td>
<td>Road Homestead Crop Grazed Livestock heavy use area</td>
</tr>
<tr>
<td></td>
<td>Fair</td>
<td>Road Homestead Crop Grazed Livestock heavy use area</td>
</tr>
<tr>
<td></td>
<td>Poor</td>
<td>Road Homestead Crop Grazed Livestock heavy use area</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Riparian Perennial Cover Buffer Width (ft)</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>30 ft</td>
<td></td>
</tr>
<tr>
<td>10 – 30 ft</td>
<td></td>
</tr>
<tr>
<td>&lt; 10 ft</td>
<td></td>
</tr>
</tbody>
</table>
Note the type of erosion indicators observed (exposed escarpment, exposed tree roots, slumped debris at the toe, etc.) and other erosion concerns:

<table>
<thead>
<tr>
<th>Field ID:</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>________</td>
<td></td>
</tr>
<tr>
<td>Field ID:</td>
<td></td>
</tr>
<tr>
<td>________</td>
<td></td>
</tr>
<tr>
<td>Field ID:</td>
<td></td>
</tr>
<tr>
<td>________</td>
<td></td>
</tr>
<tr>
<td>Field ID:</td>
<td></td>
</tr>
<tr>
<td>________</td>
<td></td>
</tr>
<tr>
<td>Field ID:</td>
<td></td>
</tr>
<tr>
<td>________</td>
<td></td>
</tr>
<tr>
<td>Field ID:</td>
<td></td>
</tr>
<tr>
<td>________</td>
<td></td>
</tr>
</tbody>
</table>
Field Survey Data Sheet Protocol

Overview

The field survey form should be completed when a field technician observes any form of surface erosion that has hydrological connection to surface waterways. The form is also used to document terrain analysis field verification and the presence and condition of existing BMPs. Where erosion is present, the technician should measure the length, depth, and width of the feature when applicable. For features with varying measurements, such as gullies, make an estimate of the overall dimensions. Some qualitative judgments will be necessary for certain parameters, such as the sediment delivery potential, crop residue, and BMP conditions.

Procedure

2. Identify surface erosion feature – This is recorded under the feature column. For a basic differentiation of gullies and ravines – a ravine is typically forested and not able to be driven across, whereas a gully can be driven across by farm equipment. A side inlet is a ridged berm structure with tile drain adjacent to a waterway.
   - Determine what type of waterway the feature discharges to, what bank (left or right) the feature is in relation to that waterway, and what cardinal direction the feature discharges.
   - Determine buffer information. If the feature is located in forested land, these can be ignored unless other buffer concerns exist.

3. Determine upland field characteristics – These include land use, tillage, and tile information. Also note any evidence or knowledge of recent or current manure application. For % crop residue, see appendix 2 for a visual example of various percentages.

4. Document feature with picture(s) – Take as many pictures as necessary to capture the extent of feature. Note spatial references for photos taken at each site (not needed if camera is using built in GPS features for this function). If possible, take photos with field technician standing in/near feature for scale reference.

5. Make BMP recommendations for feature when applicable – See appendix section.

6. Make note of any other observations/concerns in comments section – For example, if the feature is a gully, these notes would be beneficial to note: whether or not it is actively eroding; if it is advancing into upland field(s); has unique knick points, or has several closely grouped knick points; etc.
Streambank Erosion Assessment Protocol

**Overview**

A qualitative assessment will be used to document areas where streambank erosion is occurring. The following form should be completed when a field technician observes signs of bank erosion. These signs include the presence of an exposed escarpment, soil cracking near the bank, exposed tree roots and/or obvious slumped debris at the toe, or other signs. Where erosion is present, the technician should measure the length and height of the eroding bank. A qualitative judgment regarding the vegetative cover also should be indicated, along with impacts from livestock or equipment access.

**Procedure**

7. **Identify indicators of streambank erosion** – This streambank assessment only needs to be performed on sites where indicators of streambank erosion are present.

8. **Compile data** – Gather the information listed to complete the **streambank erosion worksheet** for each location with indicators of streambank erosion.
   - Length and height of eroding bank
   - Impacted by livestock access
   - Impacted by equipment access
   - Riparian cover type
     - Perennial cover, or
     - Managed land uses within 10 feet of water body
   - Riparian perennial cover quality (N/A if managed land uses are within 10 feet of water body)
   - Riparian perennial cover buffer width (N/A if managed land uses are within 10 feet of water body)

9. **Note the type of erosion indicators observed and other erosion concerns**
Appendix 1. Examples of Different Bank Conditions

Figure A. Tributary, Kalamazoo River watershed

Figure A depicts a small stable stream setting.

Completing a streambank erosion inventory form at this site would not be necessary. This stream illustrates well-established perennial vegetative cover. The buffer width is > 30 feet.

Figure B. Kalamazoo River

Figure B depicts a site with noticeable bank erosion.

Exposed roots indicate active erosion. Slumped soils indicate undercutting typical for erosion induced by channel hydrology. This stream has poor perennial vegetative cover (shallow grass roots and sparse woody vegetation density). The buffer width is < 10 feet.

For this site, the evaluation would measure the bank height using the average dimension along the bank that stretches from submerged toe of the slope to grassed soil horizon.
Figure C. Rouge River

Figure C depicts a site with outside bend bank erosion.

For this site, a streambank erosion assessment would be conducted. The erosion illustrated here is typical of erosion induced by channel hydrology. Perennial vegetative cover is poor. The buffer width is < 10 feet.

This site is an interesting example of bank erosion. Grass/woody roots extend to the waterline, but are so few and shallow that they provide minimal bank protection. Also, this site is downstream from a dam (not pictured). Impoundments usually are associated with atypically high erosion due to increased sediment transport capacity as a result of the low sediment concentrations in the water released from the impoundment.

Figure D. Hagar Creek, Ottawa County, MI

Figure D depicts a site with active erosion on at least three bank locations.

The tree root balls shown slumping into the stream (middle of the photo) is typical of erosion inducted by channel hydrology. The near bank to the left has poor woody vegetative cover and poor grass understory cover. Buffer width is < 10 feet.

(Photos and some narrative content were adapted from MI DEQ Standard Operating Procedure – Assessing bank erosion potential using Rosgen’s Bank Erosion Hazard Index (BEHI). Available at: http://search.michigan.gov/search?affiliate=mi-deq&query=stream%20bank%20erosion)
Appendix 2. BMP Recommendation Guidance

Recent advances in precision conservation have led to rethinking the way Best Management Practices (BMPs) are selected for a particular site, with a growing emphasis on big picture benefits rather than spending resources for localized improvements that may not address a given landscape’s largest sources of pollution. Identifying CSAs and targeting those areas for BMP implementation help ensure the largest sources are being accounted for mitigation.

Following the CSA identification method presented in the Digital Terrain Analysis Manual, BMP suitability should be carefully considered as the first step in the implementation process. Agroecoregions, as described in the Case Studies section, group physical landscape characteristics, making their use a good starting point for choosing regional conservation practice suitability. County-level location may also influence BMP selection, as conservation districts may have a list of suitable practices established from combinations of landowner equipment and trends, available program funds, cost/benefit analyses, and minimizing the amount of land taken out of production, among others.

A sediment reduction-based BMP suitability by agroecoregion table was created for several agroecoregions found in the Minnesota River Basin (Figure E) for the purpose of informing the upland field survey data sheet. The table was originally based off a statewide Minnesota Phosphorus Index study conducted by UMN researches, though was modified here to include regions located in the Zumbro River Watershed, along with applicable NRCS conservation practices, and was populated with input from district conservationists and NRCS staff throughout the Zumbro River Watershed. A similar series of tables were created for the Zumbro River Watershed in 2008 by NRCS and SWCD staff using Cooperative Conservation Partnership Initiative Farm Bill funds to document general resource concerns and conservation needs at the HUC8 watershed scale (Figure F). The rapid watershed assessment tables provide conservation practice cost estimates and effectiveness for reducing specific resource concerns for cropland, pasture, and forest land use/cover. The reduction effectiveness rating is based on both benchmark conditions and degree of change in conditions by conservation system(s) application. It is represented by a numerical value rated from -5 (most damaging to resources) to 5 (best protection offered by treatment).
Figure E. BMP suitability by agroecoregion. Color coded rows show suitability rated from Low (L) to Highly (H) suitable for a particular agroecoregion in the Zumbro R. Watershed

<table>
<thead>
<tr>
<th>NRCS CP#</th>
<th>Conservation Practices</th>
<th>Alluvium &amp; Outwash</th>
<th>Blufflands</th>
<th>Level Plains</th>
<th>Rochester Plateau</th>
<th>Rolling Moraine</th>
<th>Steeper Alluvium</th>
<th>Undulating Plains</th>
</tr>
</thead>
<tbody>
<tr>
<td>328</td>
<td>Conservation Crop Rotation</td>
<td>M</td>
<td>H</td>
<td>M</td>
<td>H</td>
<td>H</td>
<td>M</td>
<td>L</td>
</tr>
<tr>
<td>329</td>
<td>Conservation Tillage</td>
<td>M</td>
<td>L</td>
<td>M</td>
<td>L</td>
<td>H</td>
<td>M</td>
<td>M</td>
</tr>
<tr>
<td>332</td>
<td>Contour Buffer Strip</td>
<td>L</td>
<td>M</td>
<td>M</td>
<td>M</td>
<td>M</td>
<td>L</td>
<td>M</td>
</tr>
<tr>
<td>330</td>
<td>Contour Farming</td>
<td>M</td>
<td>H</td>
<td>M</td>
<td>H</td>
<td>H</td>
<td>M</td>
<td>M</td>
</tr>
<tr>
<td>340</td>
<td>Cover Crop</td>
<td>M</td>
<td>H</td>
<td>H</td>
<td>H</td>
<td>M</td>
<td>M</td>
<td>L</td>
</tr>
<tr>
<td>342</td>
<td>Critical Area Planting</td>
<td>M</td>
<td>L</td>
<td>M</td>
<td>M</td>
<td>M</td>
<td>H</td>
<td>L</td>
</tr>
<tr>
<td>362</td>
<td>Diversification</td>
<td>L</td>
<td>M</td>
<td>M</td>
<td>H</td>
<td>L</td>
<td>L</td>
<td>L</td>
</tr>
<tr>
<td>554</td>
<td>Drainage Water Management</td>
<td>M</td>
<td>L</td>
<td>M</td>
<td>M</td>
<td>M</td>
<td>M</td>
<td>L</td>
</tr>
<tr>
<td>386</td>
<td>Field Border</td>
<td>M</td>
<td>H</td>
<td>H</td>
<td>H</td>
<td>H</td>
<td>M</td>
<td>H</td>
</tr>
<tr>
<td>410</td>
<td>Grade Stabilization Structure</td>
<td>L</td>
<td>H</td>
<td>M</td>
<td>H</td>
<td>L</td>
<td>M</td>
<td>L</td>
</tr>
<tr>
<td>-</td>
<td>Grass Cover (CRP only)</td>
<td>M</td>
<td>M</td>
<td>H</td>
<td>M</td>
<td>H</td>
<td>L</td>
<td>L</td>
</tr>
<tr>
<td>393</td>
<td>Grass Filter Strip</td>
<td>M</td>
<td>M</td>
<td>H</td>
<td>H</td>
<td>H</td>
<td>M</td>
<td>M</td>
</tr>
<tr>
<td>412</td>
<td>Grass Waterway</td>
<td>H</td>
<td>H</td>
<td>H</td>
<td>H</td>
<td>M</td>
<td>H</td>
<td>H</td>
</tr>
<tr>
<td>590</td>
<td>Nutrient Management</td>
<td>H</td>
<td>H</td>
<td>M</td>
<td>H</td>
<td>M</td>
<td>M</td>
<td>M</td>
</tr>
<tr>
<td>512</td>
<td>Pasture &amp; Hayland Planting</td>
<td>M</td>
<td>M</td>
<td>L</td>
<td>H</td>
<td>L</td>
<td>M</td>
<td>L</td>
</tr>
<tr>
<td>378</td>
<td>Pond</td>
<td>L</td>
<td>H</td>
<td>M</td>
<td>H</td>
<td>L</td>
<td>M</td>
<td>L</td>
</tr>
<tr>
<td>528A</td>
<td>Prescribed Grazing</td>
<td>M</td>
<td>M</td>
<td>M</td>
<td>M</td>
<td>M</td>
<td>M</td>
<td>M</td>
</tr>
<tr>
<td>350</td>
<td>Sediment Basin</td>
<td>M</td>
<td>M</td>
<td>M</td>
<td>M</td>
<td>H</td>
<td>M</td>
<td>M</td>
</tr>
<tr>
<td>725</td>
<td>Sinkhole Treatment</td>
<td>M</td>
<td>H</td>
<td>L</td>
<td>H</td>
<td>L</td>
<td>M</td>
<td>M</td>
</tr>
<tr>
<td>580</td>
<td>Streambank &amp; Shoreline Protection</td>
<td>L</td>
<td>H</td>
<td>L</td>
<td>M</td>
<td>M</td>
<td>M</td>
<td>L</td>
</tr>
<tr>
<td>585</td>
<td>Stripcropping</td>
<td>L</td>
<td>H</td>
<td>M</td>
<td>H</td>
<td>M</td>
<td>M</td>
<td>L</td>
</tr>
<tr>
<td>600</td>
<td>Terrace</td>
<td>L</td>
<td>H</td>
<td>M</td>
<td>H</td>
<td>L</td>
<td>M</td>
<td>M</td>
</tr>
<tr>
<td>645</td>
<td>Upland Wildlife Habitat Management</td>
<td>L</td>
<td>L</td>
<td>L</td>
<td>L</td>
<td>L</td>
<td>L</td>
<td>L</td>
</tr>
<tr>
<td>382 / 472</td>
<td>Use Exclusion / Fencing</td>
<td>M</td>
<td>M</td>
<td>L</td>
<td>M</td>
<td>L</td>
<td>H</td>
<td>M</td>
</tr>
<tr>
<td>638</td>
<td>Water and Sediment Control Basin</td>
<td>M</td>
<td>H</td>
<td>H</td>
<td>H</td>
<td>H</td>
<td>H</td>
<td>H</td>
</tr>
<tr>
<td>614</td>
<td>Watering Facility</td>
<td>L</td>
<td>L</td>
<td>M</td>
<td>L</td>
<td>M</td>
<td>M</td>
<td>M</td>
</tr>
<tr>
<td>657</td>
<td>Wetland Restoration</td>
<td>L</td>
<td>L</td>
<td>M</td>
<td>L</td>
<td>L</td>
<td>L</td>
<td>L</td>
</tr>
</tbody>
</table>
Figure F. Rapid watershed assessment for the Zumbro River Watershed row crop land use. Courtesy of USDA-NRCS\textsuperscript{15}.

<table>
<thead>
<tr>
<th>Conservation Practice</th>
<th>Code</th>
<th>Units</th>
<th>Installation Cost</th>
<th>Life</th>
<th>O&amp;M Factor</th>
<th>Total Annual Cost</th>
<th>Soil Erosion - Sheet and Rill</th>
<th>Soil Erosion - Ephemeral Gully</th>
<th>Water Quality - Excessive Nutrients and Organics in Surface Water</th>
<th>Water Quality - Excessive Suspended Sediment and Turbidity in Surface Water</th>
</tr>
</thead>
<tbody>
<tr>
<td>Contour Buffer Strips (ac.) 332</td>
<td>332</td>
<td>Ac</td>
<td>$157.22</td>
<td>10</td>
<td>0.02</td>
<td>$25.51</td>
<td>4</td>
<td>3</td>
<td>3</td>
<td>3</td>
</tr>
<tr>
<td>Contour Farming (ac.) 330</td>
<td>330</td>
<td>Ac</td>
<td>$7.00</td>
<td>1</td>
<td>0.00</td>
<td>$7.00</td>
<td>3</td>
<td>3</td>
<td>3</td>
<td>3</td>
</tr>
<tr>
<td>Cover Crop (ac.) 340</td>
<td>340</td>
<td>Ac</td>
<td>$48.44</td>
<td>1</td>
<td>0.01</td>
<td>$48.92</td>
<td>4</td>
<td>3</td>
<td>3</td>
<td>3</td>
</tr>
<tr>
<td>Critical Area Planting (ac.) 342</td>
<td>342</td>
<td>Ac</td>
<td>$186.29</td>
<td>10</td>
<td>0.03</td>
<td>$20.72</td>
<td>3</td>
<td>3</td>
<td>3</td>
<td>3</td>
</tr>
<tr>
<td>Field Border (ft) 386</td>
<td>386</td>
<td>Ft</td>
<td>$0.08</td>
<td>10</td>
<td>0.01</td>
<td>$0.08</td>
<td>3</td>
<td>3</td>
<td>3</td>
<td>3</td>
</tr>
<tr>
<td>Filter Strip (ac.) 393</td>
<td>393</td>
<td>Ac</td>
<td>$77.80</td>
<td>10</td>
<td>0.02</td>
<td>$11.82</td>
<td>2</td>
<td>0</td>
<td>4</td>
<td>4</td>
</tr>
<tr>
<td>Grade Stabilization Structure (no.) 410</td>
<td>410</td>
<td>No</td>
<td>$15,000.00</td>
<td>10</td>
<td>0.01</td>
<td>$2,092.57</td>
<td>0</td>
<td>4</td>
<td>0</td>
<td>3</td>
</tr>
<tr>
<td>Geared Waterway (ac.) 412</td>
<td>412</td>
<td>Ac</td>
<td>$1,895.68</td>
<td>10</td>
<td>0.02</td>
<td>$283.41</td>
<td>0</td>
<td>5</td>
<td>2</td>
<td>4</td>
</tr>
<tr>
<td>Nutrient Management (ac.) 369</td>
<td>369</td>
<td>Ac</td>
<td>$5.50</td>
<td>1</td>
<td>0.00</td>
<td>$5.50</td>
<td>1</td>
<td>1</td>
<td>5</td>
<td>0</td>
</tr>
<tr>
<td>Pest Management (ac.) 393</td>
<td>393</td>
<td>Ac</td>
<td>$3.50</td>
<td>1</td>
<td>0.00</td>
<td>$3.50</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Residue and Tillage Management, Mulch Till (ac.) 329B</td>
<td>329B</td>
<td>Ac</td>
<td>$15.00</td>
<td>1</td>
<td>0.00</td>
<td>$15.00</td>
<td>4</td>
<td>2</td>
<td>3</td>
<td>3</td>
</tr>
<tr>
<td>Residue Management, No-Till Strip Till/Direct Seed (ac.) 229A</td>
<td>229A</td>
<td>Ac</td>
<td>$0.00</td>
<td>1</td>
<td>0.00</td>
<td>$0.00</td>
<td>5</td>
<td>3</td>
<td>3</td>
<td>3</td>
</tr>
<tr>
<td>Restoration and Management of Declining Habitats (ac.) 643</td>
<td>643</td>
<td>Ac</td>
<td>$78.24</td>
<td>15</td>
<td>0.01</td>
<td>$82.72</td>
<td>3</td>
<td>3</td>
<td>2</td>
<td>2</td>
</tr>
<tr>
<td>Riparian Forest Buffer (ac.) 391</td>
<td>391</td>
<td>Ac</td>
<td>$414.04</td>
<td>15</td>
<td>0.01</td>
<td>$44.02</td>
<td>1</td>
<td>0</td>
<td>2</td>
<td>2</td>
</tr>
<tr>
<td>Streambank &amp; Shoreline Protection (ft) 580</td>
<td>580</td>
<td>Ft</td>
<td>$2,250.00</td>
<td>10</td>
<td>0.10</td>
<td>$339.24</td>
<td>0</td>
<td>2</td>
<td>1</td>
<td>4</td>
</tr>
<tr>
<td>Strip cropping (ac.) 585</td>
<td>585</td>
<td>Ac</td>
<td>$0.00</td>
<td>5</td>
<td>0.01</td>
<td>$17.05</td>
<td>4</td>
<td>2</td>
<td>1</td>
<td>3</td>
</tr>
<tr>
<td>Subsurface Drain (ft) 606</td>
<td>606</td>
<td>Ft</td>
<td>$9.00</td>
<td>10</td>
<td>0.03</td>
<td>$9.90</td>
<td>2</td>
<td>2</td>
<td>2</td>
<td>1</td>
</tr>
<tr>
<td>Terrace (ft) 600</td>
<td>600</td>
<td>Ft</td>
<td>$3.50</td>
<td>10</td>
<td>0.00</td>
<td>$3.50</td>
<td>3</td>
<td>3</td>
<td>2</td>
<td>1</td>
</tr>
<tr>
<td>Underground Outlet (ft) 620</td>
<td>620</td>
<td>Ft</td>
<td>$40.04</td>
<td>10</td>
<td>0.03</td>
<td>$4.04</td>
<td>3</td>
<td>5</td>
<td>3</td>
<td>3</td>
</tr>
<tr>
<td>Upland Wildlife Habitat Management (ac.) 645</td>
<td>645</td>
<td>Ac</td>
<td>$196.70</td>
<td>3</td>
<td>0.00</td>
<td>$72.23</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Waste Utilization (ac.) 633</td>
<td>633</td>
<td>Ac</td>
<td>$15.00</td>
<td>1</td>
<td>0.00</td>
<td>$15.00</td>
<td>1</td>
<td>0</td>
<td>3</td>
<td>2</td>
</tr>
<tr>
<td>Water &amp; Sediment Control Basin (no.) 638</td>
<td>638</td>
<td>No</td>
<td>$6,000.00</td>
<td>10</td>
<td>0.03</td>
<td>$95.05</td>
<td>1</td>
<td>4</td>
<td>3</td>
<td>3</td>
</tr>
<tr>
<td>Well Decommissioning (no.) 551</td>
<td>551</td>
<td>No</td>
<td>$68.50</td>
<td>10</td>
<td>0.00</td>
<td>$88.71</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Wildlife Restoration (ac.) 657</td>
<td>657</td>
<td>Ac</td>
<td>$6,000.00</td>
<td>15</td>
<td>0.01</td>
<td>$630.05</td>
<td>2</td>
<td>2</td>
<td>1</td>
<td>3</td>
</tr>
</tbody>
</table>

\textsuperscript{15} \url{http://www.nrcs.usda.gov/Internet/FSE_DOCUMENTS/nrcs142p2_022493.pdf}, accessed March, 2014
Appendix 3. Examples of Different Crop Residue Percentages

Figure G. Visual crop residue examples

The images in the vertical columns show crop residues for corn (left) and soybean (right) – From top to bottom: 25%, 50%, 75%, 90%

Courtesy of Iowa State University, University Extension–Integrated Crop Management, [http://www.ipm.iastate.edu/ipm/icm/node/1792/print](http://www.ipm.iastate.edu/ipm/icm/node/1792/print).
Case Studies

Zumbro River Watershed Restoration
Prioritization & Sediment Reduction Project

2014
Case Studies

Accurate delineation for modeling and controlling nonpoint source pollution requires identification of the mechanisms for generating runoff, the pathways for delivery and quantification of the relative pollutant loadings, as well as the risk for erosion. Field testing and case study summaries of the desktop analyses and site evaluation protocols from various agroecoregions across the state have been provided to enhance the transfer of the technologies to conservation districts across the state.

The case studies discussed in this section demonstrate how the available tools and data are adaptable to a wide range of conditions provided the user has a good knowledge of conditions. When trying to solve the complex issues involved with impaired waters it is important to examine all the attributes of the study area: hydrology, soils, land use and people. These assessments are a vital part of that process.

Each case study is organized either by location/watershed or integrated application, and they typically describe the agroecoregion, landscape and scale of the study area, known impairments, types of CSAs identified in both GIS and field, the type of field validation preformed, as well as observations and lessons learned, where appropriate.
Location of case studies presented spread across five different Minnesota Counties – Blue Earth, Dodge, Stearns, Wabasha, and Washington
Agroecoregions

An agroecoregion is a concept stemming from an extensive multi-disciplined research project conducted at the University of Minnesota. The idea of agroecoregions was created to define regions with relatively homogenous physical characteristics in agriculturally impaired Minnesota watersheds. Minnesota has 39 distinct agroecoregions which are landscape units that share relatively uniform crop productivity, climate, geologic parent material, soil drainage, and slope steepness. The researchers found that the variance in soil erosion, stream biotic habitat, stream water quality, lake water quality, and ground water quality was smaller within agroecoregion boundaries than within watershed boundaries, and that through linked biophysical and economic modeling, the economic costs of reducing phosphorus loads to streams were lower when best management practices (BMPs) were targeted to specific agroecoregions compared with an untargeted strategy involving entire watersheds (Hatch et. al., 2001). Thus agroecoregions provide a nice complement to CSA identification and remediation.

The following site provides a link to download the Minnesota agroecoregion layer as a polygon feature class within and outside a file geodatabase (either can be directly accessed within ArcGIS software): http://devel.gisdata.mn.gov/da_DK/dataset/agri-agroecoregions/resource/f53059b9-8339-4528-a8b4-b291551062de

The Zumbro River watershed was the focus of a study involving digital terrain analysis and CSA identification; several locations in the watershed were visited between 2012 and 2013 and excerpts from those findings are highlighted in the first three agroecoregions and associated case studies described in the following sections.

Level Plains

The Level Plains agroecoregion is located in Southeast MN (see next image) and composed of fine-textured, soils with row crop production on relatively flat to moderately steep topography without sinkholes. The majority of soils are poorly drained, while a significant portion is well drained. This agroecoregion has a very high density of intermittent streams and a moderate density of permanent streams. Water erosion potentials are high, while wind erosion potentials are low. Practices to control soil erosion by water and sediment delivery to streams are important. These include conservation tillage, and grassed filter strips along streams. Tile intakes at the base of steep slopes should be replaced with French drains or blind inlets (Olmsted^1).
Case Study #1

Case study #1 is located in Dodge County, MN in the headwaters of the Middle Fork of the Zumbro River near West Concord, MN. A 1¼ mile long ditched stream section was walked on Nov. 18th, 2012.

November weather in 2012 as monitored at the Dodge County Municipal Airport had a mean temperature of 37°F and a total of only 0.19 inches of precipitation compared to a 30+ year average of 1.76 inches (NOAA archives). The region was considered to be in moderate drought at the time (droughtmonitor.unl.edu). The stream section walked has a turbidity impairment.

Several CSAs were identified in the field, nearly all of which were gullies and a few instances of bank slumping and tile outlet erosion. Length, width, and depth measurements were taken at each identified erosional feature.
Observations and lessons learned: In ditched stream sections with steep, high walls, an SPI signature as short as one to two pixels (depending on threshold used) can often coincide with significant erosion in the field as compared to the same length signature along flat riparian areas. When using short SPI signatures to identify and rank potential CSAs, it is especially important to consider contributing area and soil erosion risk characteristics for each point.

Several SPI layers were calculated in the study area to show how both pit filling and hydro-conditioning affect signatures. The site shown in the following images was chosen for the presence of a large culvert road crossing and a high concentration of
stream flow. Sites with those two characteristics tend to produce erroneous SPI signatures when pit filling without hydro-conditioning is used (3A). Note the signature that parallels the buffer just north of the stream, which doesn’t exist in the non-pit filled images. Also note the signature that starts at top of images and either terminates at buffer (non-pit filled) or stream (pit-filled).
The above figures show SPI signatures calculated from a 3 meter DEM with varying degrees of pre-processing performed. All SPI signatures are from the 97.5th percentile within the extent shown (~136 acres). Figures in the left column were not hydro-conditioned, while figures in right column were – the DEM was hydro-conditioned by burning the stream (blue line) through the north-south oriented road crossing culvert in the top-right of image.

1A & 1B – Not pit filled. The results are essentially identical.

2A & 2B – Pit filled using a 1 meter z-limit. The displays are nearly identical with only slight color gradient variation between the two. Note the new signatures near the buffer just north of stream that didn’t exist in 1A & 1B. These additions can influence CSA predictions.

3A & 3B – Pit filled with no maximum z-limit, meaning all pits were completely filled. In this example, 2B and 3B are nearly identical. This is not always the case [see case study #5 – Steep Dryer Moraine]. Note the straight signature somewhat paralleling the stream in 3A. This can be used to estimate where main channel flow will exist during flooding or culvert blockage. Caution should be used when identifying potential CSAs from those seemingly “erroneous” signatures.
Rochester Plateau

The Rochester Plateau agroecoregion is located in Southeast MN and composed of well-drained, fine-textured loessial soils developed on moderate to steep slopes in karst with a high density of intermittent streams and sinkholes, and a mixture of row crop, livestock operations, and dairy production systems. Water erosion potentials are extreme, while wind erosion potentials are low. Stream water quality ranges from fair to poor. Phosphorus transport risks to surface waters are high to severe. Major resource concerns in this agroecoregion are soil erosion by water, cattle and hog operation management, nutrient management from manure and fertilizer, and rapid leaching or seepage of pollutants to ground water in areas with karst topography and sinkholes. Soil erosion should be controlled by any or all of the following practices where applicable: conservation tillage, contour farming, stripcropping, terracing, grassed waterways, and sediment detention basins. Riparian buffer strips are recommended along streams. Best management practices for cattle include livestock exclusion from streams, and practices to reduce feedlot runoff (Olmsted¹).
Case Study #2

Case study #2 focuses on a small tributary to the Middle Fork of the Zumbro River in northeast Dodge County, MN approximately 5 miles from Pine Island, MN. The naturally meandering stream contains a Soil Conservation Service grade stabilization structure (shown below) that was constructed in 1967 for controlling gully erosion in the draw and was the site for several sedimentation surveys over the years. Several disjointed sections of the stream were field verified by walking along the stream corridor on October 15th, 2012, including the 1.2 mile section containing the pond.

October weather in 2012 as monitored at the Dodge County Municipal Airport had a mean temperature of 46°F and 1.28 inches of precipitation compared to an historical average of 2.24 inches. The region was considered to be in moderate drought at the time.

CSAs identified were mostly gullies along with some bank slumping and tile outlet erosion. Some areas were worsened by cattle grazing operations in and near the stream. Length, width, and depth measurements were taken at each identified erosional feature.
Observations and lessons learned: Most of the larger gullies near case study #2 flowed through riparian forestland where little underbrush was present and were formed from tile outlets located near the fluvial terrace.

Erosional features on the south side of the stabilization structure were expected to be verified in field due to the presence of multiple long SPI signatures, though none were located – possibly due to cattle exclusion in forested areas both north and south of the pond.
The image on left shows a long (~1/2 mile) SPI signature with several high SPI values following a forested ravine. Users would typically expect to see surface erosion associated with such an SPI, though a field visit showed very little erosion and soil deposition evident from the upslope tree line to the pour point due to a well maintained filter strip (circled in white).
Blufflands

The Blufflands agroecoregion in SE MN has well drained, fine-textured soils on very steep to extremely steep slopes in karst topography. Sinkholes can occur near incised stream drainage networks. This agroecoregion has a very high density of intermittent streams and a moderate density of forested perennial stream networks. Water erosion potentials are extreme, while wind erosion potentials are low. The risk of phosphorus transport to surface waters is moderate to high. On steep lands, practices to control water erosion are important. These include avoiding row crops on steep lands, or if they must be grown on steep lands, using a combination of conservation tillage, strip-cropping, and terracing. Buffers, along with practices that provide stable conveyances of flow, should be provided for ravines and gullies (Olmsted¹).
Case Study #3

Cold Spring Brook is a designated trout stream in western Wabasha County and drains into the Zumbro River at Zumbro Falls, MN. The stream is located in the Bluffland agroecoregion where forested ravines are commonly found. Sedimentation from upland and in-stream sources have caused Cold Spring Brook to be the target of several in-stream trout habitat improvement and bank stabilization projects over the last several years, with Trout Unlimited funding and conducting much of the work.

Approximately five miles of Cold Spring Brook and its surrounding tributary stream corridors were walked in early to mid-June of 2013 for CSA field validation. The preceding winter at the Rochester International Airport (26 miles south of Zumbro Falls) recorded above average snowfall amounts totaling 73.1” from July 2012 to June 2013. The average annual snowfall for Rochester, MN is 48”. The area also received record snowfalls in the first week of May, with Zumbro Falls reporting over 14 inches on May 2nd and 3rd (NOAA). The spring of that year was especially wet in Southeast MN, with April and May receiving precipitation well above average. April and May precipitation totals were 6.33” and 11.04” respectively, with average values of 3.24” and 3.63” respectively (as reported at the Rochester International Airport). Observations during the June field visits noted few crop fields around Zumbro Falls had worked fields due to very wet soils.

Several critical areas were identified in the field – ravines were the most commonly identified feature followed by edge of field gullies and bank erosion. Landowner attempts at remediating erosion were evident at many of the sites. The most common practice was rip-rap placement at head cuts/knick points to control gully erosion and felled trees in ravine channels to reduce flows. Length, width, and depth measurements were taken at each identified erosional feature.
Forest ravines with multiple branches are common in bluffland agroecoregions. Many of the ravine branches were actively advancing into upland fields (pictured). Hillshade layers can aid in identifying these ravines and existing conservation practices such as the grade stabilization structure shown (bottom right). The 98th percentile SPI threshold was found to best represent the flow paths during field verification of this bluffland agroecoregion. The SPI layer shown here was created using a 1 meter pit fill z-limit.
Observations and lessons learned: Despite the above average precipitation in spring, Cold Spring Brook – which is nearly 15 river miles long from headwaters to outlet – lost surface flow only 2 river miles from its outlet to the Zumbro River (as observed on June 5th). This changed the priority of any CSAs upstream in dry runs as they presented lower risk of moving sediment downstream. This example emphasized the need for current stream data that includes both perennial and intermittent classifications.

The image below shows a steep bluff near Cold Spring Brook. The bluff had a slope of ~50% (160ft high by 320ft wide). The hillshade layers help to visualize the area, and most SPI signatures can be seen terminating near the bluff’s toe. During a field visit, one site along the bluff was found to have considerable active erosion. The gully had a near-vertical head cut of ~10 ft. The SPI signature associated with the feature was the only signature originating from the bluff with connectivity to the stream. This section of bluff was also within the top 10% of soil erosion risk raster values contained within this HUC14 catchment.
**Steep Wetter Moraine**

The Steep Wetter Moraine agroecoregion, located in east-central Minnesota, consists of dissected till plain and outwash valleys with ravines commonly occurring along steeply incised river channels, and with a mix of row crops and pasture land.
Case Study #4

The case study #4 site is located in a HUC14 catchment adjacent to the St. Croix River near Basswood Grove, Washington, Co., MN. The site was visited to field verify the existence of a potential CSA that was located with GIS digital terrain analysis techniques. The site was selected due to the presence of a long SPI signature with a high mean value (top 1% of SPI from the HUC14) and flow through elevated soil erosion risk values (top 5% in HUC14, white areas in top right image). The SPI shown was created using no pit filling. Field verification showed no erosion present due to active landowner management of several conservation practices, such as the filter strip pictured bottom left and many grassed waterways. Color infrared ortho-imagery (bottom right image) can be used to locate these conservation practices and give a rough evaluation on their condition and density.
**Steep Dryer Moraine**

The Minnesota Pollution Control Agency (MPCA) assembled a set of BMP implementation strategies for TMDL turbidity reduction compliance in the Chippewa River Watershed in central Minnesota and provided the following descriptions of the Steep Dryer Moraine and Central Till (following section) agroecoregions:

The [Steep Dryer Moraine located in Central to NW MN] agroecoregion consists of loamy soils such as the Chapett, Langhei, and Barnes series developed from glacial moraines. Soils are located on very steep slopes, and are well-drained. Water erosion rates can be severe to extreme, while wind erosion can be moderate to severe. The risk of phosphorus losses to streams and lakes by runoff and erosion is moderate. There are numerous lakes in this agroecoregion, and a moderate density of intermittent streams. Stream water quality is generally poor in this agroecoregion, while lake water quality is threatened. Drinking water wells have a median depth of 80 ft.

Original vegetation was prairie, aspen-oak, oak openings and barrens, and big woods - hardwoods. Protection of lake water quality is a high priority in this agroecoregion. Conservation tillage systems that leave crop residue and maintain soil surface roughness are important. Contour farming and strip cropping are recommended where feasible. Highly erodible land should be placed in permanent grass easements. Restoration of wetlands is encouraged.
Case Study #5

The Pelican Lake watershed, located 15 miles SW of St. Cloud, is a 28.5 sq. mi. catchment that is part of a current TMDL study focused on reducing phosphorus in the lake.

Saint Cloud, MN received 78.5” of snowfall between July 2012 and June 2013 which was above the average annual of 47”. The spring precipitation amounts for March, April and May were above average with totals of 2.63”, 2.90”, and 4.98” respectively compared to averages of 1.55”, 2.57”, and 2.95” respectively.

SPI layers were created in the watershed to locate potential sediment/nutrient erosion sources, followed with CSA predictions along the streams that discharge into the lake. Field visits to the area in mid-May of 2013 did not reveal significant sources of non-point source pollution adjacent to surface waters as most areas had wide buffers with thick perennial vegetation in combination with well drained soils.
Observations and lessons learned: Similar to the 1st case study from the Level Plains agroecoregion, several SPI calculations were also made throughout the Pelican watershed with varying amounts of DEM pre-processing occurring for each run, specifically pit filled and hydro-conditioning (see following graphics). One particular location showed what appeared to be spurious signatures when pit filling with no hydro-conditioning was employed (following graphic 3A), though the flow was confirmed by the landowner stating that ice breakup frequently blocks flow at the road crossing culvert during spring melt and the SPI signature was actually where flow diverts. Out of the six graphics shown, the SPI signatures displayed in graphic 2B created from a 1m z-limit pit filled and hydro-conditioned DEM was confirmed to most closely resemble surface runoff during periods of normal stream flow in the Pelican watershed.

The longest hydrologically connected SPI signature of the top 1% of values in the study area was along Mill Creek (pictured above left). The accompanying field photo shows signs of slumping in the small pasture (foreground) and the landowner had installed rip-rap along the stream bank for stabilization. There was no further evidence of erosion upland of the slumping.
The six graphics on left display SPI signatures calculated from a 3 meter DEM with varying degrees of pre-processing performed. All SPI signatures are from the 97.5th percentile within the extent shown (~41 acres). Graphics in the left column (A) were not hydro-conditioned, while graphics in right column (B) were – the DEM was hydro-conditioned by burning the stream (blue line) through the east-west oriented road crossing culvert.

1A & 1B were not pit filled. The results are essentially identical.

2A & 2B were pit filled using a 1 meter z-limit.

3A & 3B were pit filled with no maximum z-limit, meaning all pits were completely filled.

Central Till

This agroecoregion in central Minnesota consists of well-drained, moderately steep to steep landscapes with fine textured soils of the Ahmeek, Greenwood, and Mora series. Water erosion potentials can be high. Stream and lake water quality are generally fair. Ground water quality is generally fair. Original vegetation was big
woods - hardwoods, conifer bogs and swamps, aspen-birch, and prairie (MPCA Chippewa River Watershed Draft TMDL BMP strategies).
Case Study #6

The study area in case study #6 is near Spring Hill, MN in central Minnesota. The site was visited in mid-April of 2012 to field verify CSA predictions made using terrain analysis attributes. Factors that led to choosing the site include the presence of long SPI signatures with high average cell values through steep upland slopes.

The field visit did not verify considerable erosion present in the upland field containing the SPI signatures possibly due to the field being recently tilled. The downstream area from the pour point relating to the highest ranked SPI signature at the site had in-channel sedimentation evident. That particular SPI was found to terminate at an in-stream vehicle crossing built with course gravel and no buffer.

St. Cloud winter snowfall total received between July 2011 and June 2012 was 27.4” (http://climate.umn.edu/) – well below the average of 46.1”. March and April precipitation totals were near average for those months.
The Wetter Clays & Silts agroecoregion is located in south-central Minnesota and is a vast, flat fertile plain of poorly drained deep soils dominated by row cropping with low erosion rates and high nitrate losses. The region has had a dramatic increase of drain tile installation within the last two decades and the majority of fields now take advantage of artificial drainage.
Case Study #7

Case study #7 focuses on the small 8.6 mi² Beauford Watershed in Blue Earth County, MN – part of the larger HUC8 La Sueur Watershed in the Minnesota River Basin near Mankato, MN. All the ditched streams in the Beauford watershed were walked as part of a project to both identify upland erosion and assess the cost and time involved in doing so. Side inlets were the most commonly identified erosion-related feature in the watershed. Side inlets are a form of artificial drainage common in the Minnesota River Basin and other regions with very flat terrain. Ditch cleaning piles left along the channel corridors inhibit overland flow from entering streams at low points. This can often lead to gullies developing at the edge of fields parallel to the ditch, so a culvert drain pipe is installed to drain runoff at those points. Unfortunately this allows a direct discharge of untreated overland runoff to outlet into surface waters, unless a waterway or other type of conservation practice is present upland. Gullies were also identified during the survey.
The erosional feature shown in this example is a side inlet near Beauford, MN. The multi-branching SPI signatures shown top left are common in this region due to very flat topography. The bottom right image shows a spring-time aerial photo of a long surface runoff flow network approximately 500 yards west of the side inlet shown above. Artificial drainage tile lines exist in the fields as shown in the inset photo (orange lines represent tile lines). The center of the photo shows a darker area with mineral deposits evident from evaporation where ponding still occurs during spring thaw and rainstorm events.
Works Cited


http://www.water.ncsu.edu/watershedss/dss/estuary/shellfish/five.html


http://www.rivertools.com/D8_vs_Dinf.htm A


APPENDIX B

Field GPS accuracies

Trible Pathfinder Office ‘Differential Correction Wizard’ was used to correct the GPS data post-field visit. Estimated accuracies are as follows:

A1 Nov. 18th 2012 visit

Choose 594 code solutions over the carrier solutions
594 code solutions were of higher quality

---------------------------------------------
Differential Correction Summary:
1 file processed. In this file:
47892 (100.00%) of 47892 selected positions were code corrected by processing
45660 (95.34%) of 47892 selected positions were carrier corrected by processing
594 (7.80%) of code positions chosen over carrier, as they were of higher quality

Estimated accuracies for 7982 corrected positions are as follows:

<table>
<thead>
<tr>
<th>Range</th>
<th>Percentage</th>
</tr>
</thead>
<tbody>
<tr>
<td>0-15cm</td>
<td>79.82%</td>
</tr>
<tr>
<td>15-30cm</td>
<td>6.13%</td>
</tr>
<tr>
<td>30-50cm</td>
<td>9.45%</td>
</tr>
<tr>
<td>0.5-1m</td>
<td>2.42%</td>
</tr>
<tr>
<td>1-2m</td>
<td>0.19%</td>
</tr>
<tr>
<td>2.5m</td>
<td>-</td>
</tr>
<tr>
<td>&gt;5m</td>
<td>-</td>
</tr>
</tbody>
</table>

Differential correction complete.
A2 Oct. 15th 2012 visit

Differential Correction Wizard

Filtered out 8 uncorrected positions
(only "Corrected" positions selected for output)

----------------------------------------

Differential Correction Summary:
1 file processed. In this file:
86345 (98.91%) of 87300 selected positions were code corrected by position.
77844 (89.17%) of 87300 selected positions were carrier corrected by position.
1896 (14.49%) of code positions chosen over carrier, as they were of higher quality.

Estimated accuracies for 14538 corrected positions are as follows:

<table>
<thead>
<tr>
<th>Range</th>
<th>Percentage</th>
</tr>
</thead>
<tbody>
<tr>
<td>0-15cm</td>
<td>65.00%</td>
</tr>
<tr>
<td>15-30cm</td>
<td>6.66%</td>
</tr>
<tr>
<td>30-50cm</td>
<td>16.98%</td>
</tr>
<tr>
<td>0.5-1m</td>
<td>9.75%</td>
</tr>
<tr>
<td>1-2m</td>
<td>1.43%</td>
</tr>
<tr>
<td>2-5m</td>
<td>0.11%</td>
</tr>
<tr>
<td>&gt;5m</td>
<td>0.08%</td>
</tr>
</tbody>
</table>

Differential correction complete.
A2 Oct. 22\textsuperscript{nd} 2012 visit

Differential Correction Wizard

Chose 1436 code solutions over the carrier solutions
1436 code solutions were of higher quality

Differential Correction Summary:
1 file processed. In this file:
47328 (99.94\%) of 47358 selected positions were code corrected by positions.
42642 (90.04\%) of 47358 selected positions were carrier corrected by positions.
1436 (20.21\%) of code positions chosen over carrier, as they were of higher quality.

Estimated accuracies for 7892 corrected positions are as follows:

<table>
<thead>
<tr>
<th>Range</th>
<th>Percentage</th>
</tr>
</thead>
<tbody>
<tr>
<td>0-15cm</td>
<td>53.12%</td>
</tr>
<tr>
<td>15-30cm</td>
<td>13.94%</td>
</tr>
<tr>
<td>30-50cm</td>
<td>24.40%</td>
</tr>
<tr>
<td>0.5-1m</td>
<td>7.94%</td>
</tr>
<tr>
<td>1-2m</td>
<td>0.62%</td>
</tr>
<tr>
<td>2-5m</td>
<td>-</td>
</tr>
<tr>
<td>&gt;5m</td>
<td>-</td>
</tr>
</tbody>
</table>

Differential correction complete.

< Back  Close  Cancel  Help
B2 June 2013 visits

Differential Correction Wizard

Filtered out 1 uncorrected positions
(only "Corrected" positions selected for output)

Differential Correction Summary:
1 file processed. In this file:
2199 (99.86%) of 2202 selected positions were code corrected by post-processing
1692 (76.84%) of 2202 selected positions were carrier corrected by post-processing
223 (39.54%) of code positions chosen over carrier, as they were of higher quality.

Estimated accuracies for 733 corrected positions are as follows:

<table>
<thead>
<tr>
<th>Range</th>
<th>Percentage</th>
</tr>
</thead>
<tbody>
<tr>
<td>0-15cm</td>
<td>39.43%</td>
</tr>
<tr>
<td>15-30cm</td>
<td>1.91%</td>
</tr>
<tr>
<td>30-50cm</td>
<td>13.51%</td>
</tr>
<tr>
<td>0.5-1m</td>
<td>38.61%</td>
</tr>
<tr>
<td>1-2m</td>
<td>6.41%</td>
</tr>
<tr>
<td>2-5m</td>
<td>0.14%</td>
</tr>
<tr>
<td>&gt;5m</td>
<td>-</td>
</tr>
</tbody>
</table>

Differential correction complete.
Random point comparison statistical analysis results

The random point comparison statistical analysis was calculated using CRAN R statistical package software, version 3.2.3. The below results are direct outputs from R, cleaned up to remove arbitrary data names and fields. There are two results for each field site; the parametric Welch two sample t-test and the non-parametric Wilcoxon rank sum test. Output parameters are as follows: t = test statistic; df = degrees of freedom; W = test statistic; p-value = sample results probability value.

A1

**Welch Two Sample t-test**

\[
t = -7.8314, \text{ df } = 49.126, \text{ p-value } = 3.404e-10
\]
alternative hypothesis: true difference in means is not equal to 0
95 percent confidence interval:

-8.489619 -5.022553

sample estimates:

<table>
<thead>
<tr>
<th>mean of x</th>
<th>mean of y</th>
</tr>
</thead>
<tbody>
<tr>
<td>-5.8324557</td>
<td>0.9236303</td>
</tr>
</tbody>
</table>

**Wilcoxon rank sum test**

\[
W = 39, \text{ p-value } = 1.816e-10
\]
alternative hypothesis: true location shift is not equal to 0

A2

**Welch Two Sample t-test**

\[
t = -8.2401, \text{ df } = 96.003, \text{ p-value } = 8.796e-13
\]
alternative hypothesis: true difference in means is not equal to 0
95 percent confidence interval:

-5.96977 -3.65195

sample estimates:

<table>
<thead>
<tr>
<th>mean of x</th>
<th>mean of y</th>
</tr>
</thead>
<tbody>
<tr>
<td>-3.449966</td>
<td>1.360895</td>
</tr>
</tbody>
</table>
Wilcoxon rank sum test (with continuity correction)

W = 258, p-value = 3.839e-15
alternative hypothesis: true location shift is not equal to 0

B2

Welch Two Sample t-test

t = -8.2664, df = 57.07, p-value = 2.464e-11
alternative hypothesis: true difference in means is not equal to 0
95 percent confidence interval:
-9.200633  -5.612399
sample estimates:
mean of x mean of y
-4.231969   3.174547

Wilcoxon rank sum test

W = 62, p-value = 6.274e-13
alternative hypothesis: true location shift is not equal to 0
Percentile analysis statistical results

The percentile analysis was calculated using CRAN R statistical package software, version 3.2.3. The below results are direct outputs from R, cleaned up to remove arbitrary data names and fields. There are two results for each field site; the parametric one-way analysis of variance (ANOVA) model and the non-parametric Kruskal-Wallis rank sum test. Tukey’s test was used along with the former to make a piecewise determination of means. Output parameters are as follows: Df = degrees of freedom; Sum Sq = sum of squares; Mean Sq = mean square; Fvalue = F test statistic value; Pr(>F) = the significance probability value associated with the F value.

A1

ANOVA

<table>
<thead>
<tr>
<th>Df</th>
<th>Sum Sq</th>
<th>Mean Sq</th>
<th>Fvalue</th>
<th>Pr(&gt;F)</th>
</tr>
</thead>
<tbody>
<tr>
<td>SDP_TEST</td>
<td>2</td>
<td>14.06</td>
<td>7.029</td>
<td>0.917</td>
</tr>
<tr>
<td>Residuals</td>
<td>24</td>
<td>183.99</td>
<td>7.666</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Mean</th>
<th>sd</th>
<th>data:n</th>
</tr>
</thead>
<tbody>
<tr>
<td>SDP1</td>
<td>0.2621562</td>
<td>3.9498153</td>
</tr>
<tr>
<td>SDP2</td>
<td>0.9534151</td>
<td>2.0213318</td>
</tr>
<tr>
<td>SDP3</td>
<td>2.7591284</td>
<td>0.9952302</td>
</tr>
</tbody>
</table>

Tukey's test

Simultaneous Tests for General Linear Hypotheses

Multiple Comparisons of Means: Tukey Contrasts

Linear Hypotheses:

| Estimate | Std. Error | t value | Pr(>|t|) |
|----------|------------|---------|---------|
| b - a = 0 | 0.6913 | 1.1674 | 0.592 | 0.822 |
| c - a = 0 | 2.4970 | 1.8459 | 1.353 | 0.374 |
| c - b = 0 | 1.8057 | 1.7511 | 1.031 | 0.558 |

(Adjusted p values reported -- single-step method)
Simultaneous Confidence Intervals

Multiple Comparisons of Means: Tukey Contrasts

Quantile = 2.4799

95% family-wise confidence level

Linear Hypotheses:

<table>
<thead>
<tr>
<th>estimate</th>
<th>lower</th>
<th>upper</th>
</tr>
</thead>
<tbody>
<tr>
<td>b - a = 0</td>
<td>0.6913</td>
<td>-2.2038</td>
</tr>
<tr>
<td>c - a = 0</td>
<td>2.4970</td>
<td>-2.0806</td>
</tr>
<tr>
<td>c - b = 0</td>
<td>1.8057</td>
<td>-2.5369</td>
</tr>
</tbody>
</table>

Figure 36. A1 field site general linear hypotheses for piecewise 95% confidence interval comparing SPI groups to SPI values
**Kruskal-Wallis rank sum test**

Kruskal-Wallis chi-squared = 3.4399, df = 2, p-value = 0.1791

**ANOVA**

<table>
<thead>
<tr>
<th></th>
<th>Df</th>
<th>Sum Sq</th>
<th>Mean Sq</th>
<th>F value</th>
<th>Pr(&gt;F)</th>
</tr>
</thead>
<tbody>
<tr>
<td>SDP_group</td>
<td>2</td>
<td>7.42</td>
<td>3.710</td>
<td>0.654</td>
<td>0.524</td>
</tr>
<tr>
<td>Residuals</td>
<td>55</td>
<td>312.08</td>
<td>5.674</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Tukey's test**

Simultaneous Tests for General Linear Hypotheses

Multiple Comparisons of Means: Tukey Contrasts

Linear Hypotheses:

|              | Estimate | Std. Error | t value | Pr(>|t|) |
|--------------|----------|------------|---------|---------|
| b - a = = 0  | 0.5823   | 0.7629     | 0.763   | 0.721   |
| c - a = = 0  | 1.0200   | 1.0446     | 0.976   | 0.587   |
| c - b = = 0  | 0.4377   | 1.1757     | 0.372   | 0.925   |

(Adjusted p values reported -- single-step method)

Multiple Comparisons of Means: Tukey Contrasts

Quantile = 2.3916
95% family-wise confidence level

Linear Hypotheses:

<table>
<thead>
<tr>
<th></th>
<th>Estimate</th>
<th>lower</th>
<th>upper</th>
</tr>
</thead>
<tbody>
<tr>
<td>b - a = = 0</td>
<td>0.5823</td>
<td>-1.2422</td>
<td>2.4067</td>
</tr>
<tr>
<td>c - a = = 0</td>
<td>1.0200</td>
<td>-1.4782</td>
<td>3.5182</td>
</tr>
<tr>
<td>c - b = = 0</td>
<td>0.4377</td>
<td>-2.3739</td>
<td>3.2494</td>
</tr>
</tbody>
</table>

"a" "a" "a"
Figure 37. A2 field site general linear hypotheses for piecewise 95% confidence interval comparing SPI groups to SPI values

**Kruskal-Wallis rank sum test**

Kruskal-Wallis chi-squared = 1.5751, df = 2, p-value = 0.455
**B2**

**ANOVA**

<table>
<thead>
<tr>
<th></th>
<th>Df</th>
<th>Sum Sq</th>
<th>Mean Sq</th>
<th>F value</th>
<th>Pr(&gt;F)</th>
</tr>
</thead>
<tbody>
<tr>
<td>SDP_group</td>
<td>2</td>
<td>32.42</td>
<td>16.210</td>
<td>2.096</td>
<td>0.14</td>
</tr>
<tr>
<td>Residuals</td>
<td>31</td>
<td>239.79</td>
<td>7.735</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

mean       sd      data:n
SDP1       3.808202 2.04223 13
SDP2       2.346137 3.28957 18
SDP3       5.399168 1.693118 3

**Tukey's test**

Simultaneous Tests for General Linear Hypotheses

Multiple Comparisons of Means: Tukey Contrasts

Linear Hypotheses:

| Estimate   | Std. Error | t value | Pr(>|t|) |
|------------|------------|---------|---------|
| b - a = = 0| -1.462     | 1.012   | -1.444  | 0.322   |
| c - a = = 0| 1.591      | 1.781   | 0.893   | 0.640   |
| c - b = = 0| 3.053      | 1.734   | 1.760   | 0.192   |

(Adjusted p values reported -- single-step method)

Simultaneous Confidence Intervals

Multiple Comparisons of Means: Tukey Contrasts

Quantile = 2.4373
95% family-wise confidence level

Linear Hypotheses:

<table>
<thead>
<tr>
<th>Estimate</th>
<th>lower</th>
<th>upper</th>
</tr>
</thead>
<tbody>
<tr>
<td>b - a = = 0</td>
<td>-1.4621</td>
<td>-3.9294</td>
</tr>
<tr>
<td>c - a = = 0</td>
<td>1.5910</td>
<td>-2.7509</td>
</tr>
<tr>
<td>c - b = = 0</td>
<td>3.0530</td>
<td>-1.1742</td>
</tr>
</tbody>
</table>

a   b   c
"a"  "a"  "a"
Figure 38. B2 field site general linear hypotheses for piecewise 95% confidence interval comparing SPI groups to SPI values

*Kruskal-Wallis rank sum test*

Kruskal-Wallis chi-squared = 4.91, df = 2, \( p\)-value = 0.08586